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1. Цели и  задачи учебной дисциплины «Информатика», ее место в 

учебном процессе. 

1.1. Цели преподавания учебной дисциплины «Информатика»: 

− формирование личности студента, развитие его интеллекта и способностей к 

логическому мышлению;  

− обучение основным приемам работы на ЭВМ. 

1.2. Задачи изучения дисциплины: 

− выработать умения анализировать полученные результаты, привить навыки 

самостоятельного изучения литературы по информатике; 

− научить студентов приемам работы с программными средствами реализации 

информационных процессов. 

1.3. После изучения дисциплины студент должен знать и уметь ис-

пользовать:  

− понятие информации, способы ее хранения и обработки;  

− структуру, принципы работы и основные возможности ЭВМ; 

− основные типы алгоритмов;  

− языки программирования и стандартные программные обеспечения своей 

профессиональной деятельности;  

− возможности локальных и глобальных сетей ЭВМ. 

2. Содержание учебной дисциплины «Информатика». 

2.1. Согласно государственному стандарту математических и естест-

венных дисциплин студент должен изучить: 

− понятие информации, общая характеристика процессов сбора, передачи, об-

работки и накопления информации; 

− технические и программные средства реализации информационных процес-

сов; 

− модели решения функциональных и вычислительных задач; 

− алгоритмизация и программирование; 

− языки программирования высокого уровня; 



 5

− базы данных; 

− программное обеспечение и технологии программирования; 

− локальные и глобальные сети ЭВМ; 

− методы защиты информации; 

− компьютерный практикум. 

2. 2. Темы дисциплины и их содержание. 

Тема 1. Информатика как наука. Информация. Современное пред-

ставление информации. 

Лекция: 

Информатика – это наука, изучающая все аспекты получения, хранения, пе-

реработки, передачи и использования информации. 

Слово «Информатика» образовалось из 2-х французских слов INFORmation 

(информация) autoMATIQUE (автоматика). Первоначально в научный обиход оно 

вошло во  Франции в 60-е годы для обозначения автоматической переработки ин-

формации в широкой области научной и производственной деятельности человека. 

В качестве источников информатики обычно называют документалистику (изуче-

ние рациональных средств и методов повышения эффективности документооборо-

та) и кибернетику. 

Задачи информатики 

1. Исследование информационных процессов любой природы. 
2. Разработка информационной техники и создание новейшей технологии перера-
ботки информации на базе полученных результатов исследования информацион-
ных процессов. 
3. Решение научных и инженерных проблем создания, внедрения и обеспечения 
эффективного использования компьютерной техники и технологии во всех сферах 
общественной жизни. 

Основные направления информатики: 
1. Теоретическая информатика. 
2. Кибернетика. 
3. Программирование. 
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4. Информационные системы.  

5. Вычислительная техника. 

6. Информатика в обществе. 

7. Информатика в природе. 

Этапы развития информатики: 

1. Ручной. 

2. Механический. 

3. Электромеханический. 

4. Электронный. 

Классификация ЭВМ: 
1. По истории создания:  

I поколение: элементарная база — лампы, оперативная память на электрон-
но-лучевых трубках и ферритовых сердечниках, быстродействие до 20000 оп/сек., 
охлаждение, однопрограммность. 

II поколение: элементарная база — полупроводниковые транзисторы, быст-
родействие 104–105 оп/сек. Объем памяти — до 150 слов при длине слова до 50 
двоичных разрядов. Программирование велось на  алгоритмических языках Фор-
тран, Алгол, Кобол. 

III поколение:  элементарная база — интегральные схемы (ИС), быстродей-
ствие 106–107 оп/сек. Резко снижены габариты и энергопотребление ЭВМ. Опера-
тивная память строилась на ИС и достигала объема 105–106 байт. Унифицирова-
лись периферийные устройства. Появился широкий выбор языков программиро-
вания.  

IV поколение: элементарная база — большие и сверхбольшие ИС (БИС и 
СБИС). Быстродействие 107–108 оп/сек. Формируются два направления — много-
процессорные и персональные ЭВМ.  
2. По размерам: суперЭВМ, большие ЭВМ, малые ЭВМ, микроЭВМ 

Параметры СуперЭВМ  Большие ЭВМ Малые ЭВМ МикроЭВМ 
Производитель-
ность, MIPS 1000-100000 10-1000 1- 100 1- 100 

Емкость ОЗУ 2000-10000 64-10000 4-512 4-256 
Емкость винчесте-
ра, Гбайт 500 - 5000 50 - 1000 2- 100 0,5 - 10 

Разрядность, бит 64-128 32-64 16-64 16-64 
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Классификация РС: 

1. Стационарные. 

2. Переносные: портативные, блокноты, электронные словари, органайзеры 

(электронные записные книжки). 

Информационное общество – это общество, в котором большинство ра-

ботающих занято производством, хранением, переработкой или реализацией 

информации, особенно высшей ее формой – знаний.  

В период перехода к информационному обществу необходимо подгото-

вить человека к быстрому восприятию и обработке больших объемов информа-

ции, овладению  им современными средствами, методами и технологией рабо-

ты. Поэтому современный человек должен иметь определенный уровень ин-

формационной культуры. 

Информационное общество характеризуется – 50% людей занято в сфе-

ре информационных услуг. 

Информационная система – взаимосвязанная совокупность средств, ме-

тодов и персонала, используемых для хранения, обработки и выдачи информа-

ции в интересах достижения поставленной цели. 

Информационная технология – процесс, использующий совокупность 

средств и методов отбора, обработки и передачи данных для получения инфор-

мации нового качества. 

Сигнал – физический процесс, имеющий информационное значение, ус-

тановленное принятым соглашением. В обычной жизни под сигналом понима-

ют физический процесс, который человек воспринимает как звук, свет и т. д. 

Данные – зарегистрированные сигналы. Данные могут рассматриваться как 

признаки или записанные наблюдения, которые по каким-то причинам не ис-

пользуются, только хранятся. Если появляется возможность использовать эти 

данные для уменьшения неопределенности в чем-либо, то данные превращают-

ся в информацию. 

Информация – сведения об объектах и явлениях окружающей среды, их 

параметрах, свойствах и состоянии, которые уменьшают имеющуюся о них 

степень неопределенности, неполноты знаний. 
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Одной из важнейших разновидностей информации является информация 

экономическая. Экономическая информация – совокупность сведений, отра-

жающих социально-экономические процессы и служащих для управления эти-

ми процессами и коллективами людей в производственной и непроизводствен-

ной сфере. 

Свойства информации: 

1. Объективность. 

2. Достаточность (полнота) 

3. Достоверность. 

4. Доступность. 

5. Актуальность. 

6. Адекватность. 

7. Своевременность. 

8. Полнота. 

9. Энтропия информации. 

Классификация информации по разным признакам: 

1. По месту возникновения: входная, выходная, внутренняя, внешняя. 

2. По стабильности: переменная, постоянная. 

3. По стадии обработки: первичная, вторичная, промежуточная, результатная. 

4. По способу отображения: текстовая, графическая. 

Информация всегда связана с материальным носителем (диски, кассеты, 

бумажные носители, человек, негатив и т. д.), а ее передача с затратами энер-

гии. Закодированное сообщение приобретает вид сигналов - носителей инфор-

мации, которые текут по каналам связи. При выходе из канала связи сигналы 

должны обрести вновь общепонятный вид в декодирующем устройстве. (При-

меры: фонарик, телефон, живой нерв, компьютер).  

Однако, одну и ту же информацию можно хранить в различном матери-

альном виде (на бумаге, магнитной ленте, магнитном диске, оптическом диске) 

и передавать с различными энергетическими затратами (по телефону, по почте, 

с курьером).   

Различают две формы представления информации — непрерывную (анало-



 9

говую) и прерывистую (цифровую, дискретную).  

Непрерывная форма характеризует процесс, который не имеет перерывов и 

теоретически может изменяться в любой момент времени и на любую величину 

(например, речь человека, музыкальное произведение). Цифровой сигнал может 

изменяться лишь в определенные моменты времени и принимать лишь заранее 

обусловленные значения (например, только значения напряжений 0 и 3,5 В). Мо-

менты возможного изменения уровня цифрового сигнала задает тактовый генера-

тор конкретного цифрового устройства. 

Для преобразования аналогового сигнала в цифровой сигнал требуется про-

вести дискретизацию непрерывного сигнала во времени, квантование по уровню, а 

затем кодирование отобранных значений. 

Дискретизация – замена непрерывного (аналогового) сигнала по-

следовательностью отдельных во времени отсчетов этого сигнала. 

Количественное описание информации базируется на вероятностном подходе. 

За единицу информации принимается один бит. Это такое количество информа-

ции, получаем в результате  реализации одного из двух равновероятных событий, 

например, при бросании монеты. Термин «бит» произошел от выражения binary 

digit, что означает «двоичная цифра», т.е. принимающая значение 0 или 1. 

Более крупная единица информации — байт — равна 8 бит. Проверка при-

сутствия или отсутствия на лекции 24 студентов дает лектору три байта информа-

ции. Еще более крупная единица информации — 1 Кбайт — равна 1024 байтам. 

Далее— 1 Мбайт равен 1024 Кбайтам, 1 Гбайт равен 1024 Мбайтам, а 1 Тбайт ра-

вен 1024 Гбайтам. 

Задача 1. Решить систему уравнений (найти x, y). В ответе необходимо ука-

зать единицы измерения.  

⎩
⎨
⎧

=

=−

байт24
Кбайт725

14x
xy

. 

⎩
⎨
⎧

=
=

⇒

⇒
⎩
⎨
⎧

=
=−

⇒
⎩
⎨
⎧

=

=−
⇒

⎩
⎨
⎧

⋅=

=−
⇒

⎩
⎨
⎧

=

=−

Кбайт4
Кбайт3
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Кбайт725

Кбайт24
Кбайт725

байт224
Кбайт725
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x
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x
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x
xy

x
xy
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Задача 2. Одна страница книги содержит 25 строк по 80 символов. В книге 

300 страниц. Каков объем информации необходим для хранения книги? 

Задача 3. Один музыкальный файл занимает 6 Кб на диске. Сколько файлов 

можно записать на CD-диск объемом 600 Мб.  

Контрольные вопросы 

1. Что такое информатика? 
2. Задачи информатики. 
3. Основные направления информатики. 
4. Этапы развития информатики. 
5. Классификация ЭВМ. 
6. Понятие информации. 
7. Свойства информации. 
8. Классификация информации. 
9. Формы представления информации. 
10. Единицы измерения информации. 

Контрольная работа 

Вариант №0 

1. Какое количество страниц неформатированного текста можно поместить на 

дискету емкостью 1,44 Мбайт? 

2. В документе 60 строк по 60 символов. Каков размер данного текстового 

файла? 

3. Сколько «весит» фраза «Мороз и солнце – день чудесный», если сохранить 

ее в текстовом файле? 

4. Сколько составляет размер текстового файла, содержащего только слово 

«информатика»? 

5. Разрешающая способность дисплея равна 640×200 пикселей. Для размеще-

ния одного символа в текстовом режиме используется матрица 8×8 пиксе-

лей. Какое максимальное количество текстовых строк может быть размеще-

но на экране? 
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6. Решите систему уравнений (найти x, y). В ответе необходимо указать единицы 

измерения. 

⎩
⎨
⎧

=

=−

байт24
Кбайт725

14x
xy

. 

7. Одна страница книги содержит 25 строк по 80 символов. В книге 300 страниц. 

Каков объем информации необходим для хранения книги? 

8. Один музыкальный файл занимает 6 Кб на диске. Сколько файлов можно запи-

сать на CD-диск объемом 600 Мб.  

Тест самоконтроля знаний 

Вариант №0 

1. Данные – это: 

a) признаки или записанные наблюдения, которые по каким-то причинам не 
используются, а только хранятся; 

b) это выявленные закономерности в определенной предметной области; 
c) совокупность сведений, необходимых для организации хозяйственной дея-
тельности предприятия; 

2. По месту возникновения информация бывает: 

a) входная, выходная, внутренняя, внешняя; 

b) текстовая, графическая; 

c) учетная, статистическая; 

3. По признаку стабильности информация бывает: 

a) количественная, суммовая; 
b) обрабатываемая, необрабатываемая; 
c) постоянная и переменная; 

4. По функциям управления информация бывает: 

a) плановая, учетная, оперативная; 
b) промежуточная, результатная; 
c) первичная, вторичная; 

5. В 4 килобайтах: 
a) 4000 бит; 
b) 4096 байт; 
c) 4096 бит; 
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6. Минимальная единица измерения информации: 

a) байт; 

b) символ; 

c) бит; 

7. Информация в ЭВМ кодируется: 

a) в двоичной системе счисления; 

b) в десятичной системе счисления; 

c) в символах; 

8. Один бит содержит: 

a) 0 или 1; 

b) одну цифру; 

c) один символ; 

9. Один байт содержит: 

a) 2 бита; 

b) 8 бит; 

c) 16 бит; 

10. В 1 килобайте 

a) 1012 байт; 

b) 1024 байт; 

c) 1000 бит. 

Тема 2. Системы счисления. 

Лекция:  

Под системой счисления понимается способ изображения чисел с помощью 

символов совместно с правилами выполнения действий над этими числами. 

Классификация систем счисления 

Все системы делятся на позиционные и непозиционные. 

В непозиционных системах каждая цифра имеет свой вес и ее значение не 

зависит от положения в числе – от позиции. Пример – римская система. Число 

76 в этой системе выглядит так: LXXVI, где L=50, X=10, V=5, I=1. Как видно 
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цифрами здесь служат латинские символы. 

В позиционных системах значения цифр зависят от их положения (позиции) в 

числе. Так, например, человек привык пользоваться десятичной позиционной сис-

темой – числа записываются с помощью 10 цифр. Самая правая цифра обозначает 

единицы, левее – десятки, ещё левее – сотни и т.д. 

В любой позиционной системе число может быть представлено в виде много-

члена. 

Покажем, как представляют в виде многочлена десятичное число. 

0123 10710610510476050040004567 ⋅+⋅+⋅+⋅=+++= , 

а теперь с дробью 

3

2101

107
106105104103007,006,05,0430567,34

−

−−

⋅+

+⋅+⋅+⋅+⋅=++++=
 

Обобщим это представление на случай использования другого набора 

цифр. 

∑
−=

−
−

−
−

−
−

−
−−−−− =++++++++=

n

mj

j
j

m
m

n
n

n
nmnn papapapaapapapaaaaaaaa .........,... 2

2
1

101
1

121011 . 

Основанием системы счисления называется количество цифр и символов, 

применяющихся для изображения числа, например р=10. 

База системы — это последовательность цифр, используемых для записи 

числа. Ни в одной системе нет цифры, равной основанию системы. 

В настоящее время арифметические действия выполняются в десятичной 

системе, где р=10. База этой системы 0,1,2,3,4,5,6,7,8,9.  

Двоичная система счисления 

Представление информации с помощью двоичного кодирования наиболее оп-

тимально для ЭВМ, так как данные в ЭВМ передаются по проводам с помощью 

двух сигналов «есть напряжение» и «нет напряжения».  Поскольку все данные в 

ЭВМ кодируются числами, то для передачи их по  проводам необходимо приме-

нять двоичную систему. 

Двоичная система имеет основание р=2 и базу 0 и 1. То есть, для изобра-

жения  числа используются только два знака.  
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Правила перевода из десятичной в двоичную СС 

Для перевода десятичного числа в двоичную систему отдельно переводят 

дробную и целую части. 

Чтобы перевести целое число из 10-ой в 2-ую систему нужно выполнять по-

следовательное деление числа на 2 до тех пор, пока результат не станет меньше 2. 

Последний результат и остатки от деления, взятые в обратном порядке дают дво-

ичное число. 

Пример. Перевести число 164 из 10-ой СС в 2-ую. 

164 2       

164 82 2      

0 82 41 2     

 0 40 20 2    

    1 20 10 2   

     0 10 5 2  

      0 4 2 2 

     1 2 1 

      0  

В результате 16510=101001002. 

Для перевода правильной дроби из 10-системы счисления в 2-ю СС нужно ум-

ножить исходную дробь и дробные части получающихся произведений на основа-

ние 2, представленное в старой 10-системе. Целые части получающихся произведе-

ний дают последовательность цифр, которая является представлением дроби в 2-ой 

системе счисления. 

Правила перевода из двоичной в десятичную СС 

Для перевода необходимо разложить число по основанию системы счисления 

и посчитать результат. 

Пример. 

1011012=1·25+0·54+1·23+1·22+0·51+1·20=32+8+4+1=4510 

+⋅+⋅+⋅+⋅+⋅+⋅+⋅+⋅+⋅= −101234567
2 212020212020212021101,10100100  

10
3175232 625,164128324212121222120 =++=⋅+⋅+⋅++==⋅+⋅+ −−−−  
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Существенным недостатком двоичной системы счисления является громозд-

кая запись чисел. Для упрощения записи двоичных чисел могут быть использова-

ны восьмеричная и шестнадцатеричная системы счисления. 

Система называется родственной двоичной, если ее основание является сте-

пенью числа 2. К таким системам относятся четверичная, восьмеричная и шестна-

дцатеричная. Мы рассмотрим восьмеричную и шестнадцатиричную системы.  

Восьмеричная система 

Основание р=8. База — цифры от 0 до 7. 

Для перевода целого десятичного числа в восьмеричную СС необходимо вы-

полнить последовательное деление на 8 до тех пор, пока результат не станет 

меньше 8. Последний результат и остатки, взятые в обратном порядке дадут вось-

меричное число. 

Для перевода правильной дроби из 10-ой СС в 8-ю нужно умножить исходную 

дробь и дробные части получающихся произведений на основание 8. Целые части 

получающихся произведений дают последовательность цифр, которая является 

представлением дроби в 8-ой СС. 

Для перевода восьмеричного числа в десятичную систему необходимо разло-

жить его по степеням основания системы 8 и выполнить сложение.  

Шестнадцатеричная  система 

Основание р=16. База — цифры от 0 до 9 и буквы A, B, C, D, E, F (A – 10, B – 

11, C – 12, D – 13, E – 14, F – 15.) 

Для перевода целого десятичного числа в шестнадцатеричную систему необ-

ходимо выполнить последовательное деление на 16 до тех пор, пока результат не 

станет меньше 16. Последний результат и остатки, взятые в обратном порядке да-

дут шестнадцатеричное число. 

Для перевода правильной дроби из 10-системы счисления в 16-ю СС нужно ум-

ножить исходную дробь и дробные части получающихся произведений на основа-

ние 16. Целые части получающихся произведений дают последовательность цифр, 

которая является представлением дроби в 16-ой системе счисления. 
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Для перевода шестнадцатеричного числа в десятичную систему необходимо 

разложить его по степеням основания системы 16 и выполнить сложение.  

Вообще, для того чтобы перевести целое число из одной системы счисле-

ния в другую необходимо выполнить следующие действия: 

1) поделить данное число на основание новой системы счисления; 

2) перевести остаток от деления в новую систему счисления; получается 

младший разряд нового числа; 

3) если частное от деления больше основания новой системы, продолжать 

деление, как указано в п.1; новый остаток, переведенный в новую систему 

счисления, дает второй разряд числа 

Контрольные вопросы 

1. Что такое система счисления? 
2. Какие системы счисления вы знаете? 
3. Правила перевода из десятичной системы счисления в двоичную, восьме-

ричную, шестнадцатеричную системы счисления. 
4. Арифметические действия в двоичной, восьмеричной, шестнадцатеричной 

системах счисления. 

Контрольная работа 

1) Перевести двоичное число вовсе известные вам системы счисления: 
а) 1001011101 
б) 10110001111 
в) 1111011010 
г) 1111100001 
д) 100011100011 

е) 10001101001 
ж) 111100000111111 
з)10101100110101 
и) 1111000111110101 
к) 10101101011010101 

2) Перевести восьмеричное число вовсе известные вам системы счисления: 
а) 526 
б) 457 
в) 562 
г) 125 
д) 443 

е) 361 
ж) 777 
з) 1267 
и) 6375 
к) 774527 
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3) Перевести десятичное число вовсе известные вам системы счисления: 
а) 58 
б) 96 
в) 129 
г) 345 
д) 789 

е) 953 
ж) 1283 
з)  1892 
и) 5638 
к) 105896 

4) Перевести шестнадцатеричное число вовсе известные вам системы счисле-
ния: 

а) 1А 
б) 26 
в) 3AF 
г) C45 
д) D56 

е) AFD 
ж) 4A5F 
з)  9E6CA 
и) ABC5F 
к) 48FF56A 

Тест самоконтроля знаний 

Вариант №0 

1. Система счисления - это:  

a) способ наименования и записи чисел; 

b) представление букв с помощью цифр; 

c) способ представления одних чисел с помощью других; 

2. В двоичной системе используются цифры:  

a) 1 и 2; 

b) 0 и 1; 

c) 0 и 2; 

3. Бит – это:  

a) цифры 0 и 1; 

b) наименьшая единица памяти ЭВМ; 

c) 8 нулей и единиц; 

4. Позиционная система счисления – это:  

a) римская; 

b) десятичная; 
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c) все ответы верны;  

5. В двоичной системе основанием является:  

a) 0  

b) 2  

c) 8  

6. Двоичному числу 1000 соответствует десятичное число:  

a) 2;  

b) 8; 

c) 10;  

7. Системы счисления делятся на: 

a) позиционные и непозиционные; 

b) римские и десятичные; 

c) двоичные и десятичные; 

8. Результатом сложения двоичных чисел 1010 и 111 будет:  
a) 11010; 
b) 10110; 
c) 10100; 

9. Десятичному числу 122 соответствует двоичное число:  
a) 1111010; 
b) 1001010; 
c) 1010101; 

10. При переводе числа 425,7 из восьмеричной системы счисления в десятич-
ную, получится число: 
a) 277,875; 
b) 256,5; 
c) 377,95. 

Тема 3. Аппаратное обеспечение персонального компьютера. Техниче-
ские средства реализации информационных процессов. 

Лекция:  

Современный компьютер состоит из двух взаимосвязанных частей – ап-

паратного (Hardware)  и программного  (Software) обеспечения. К аппаратному 



 19

обеспечению относится все то, что можно потрогать руками (микросхемы, дис-

ки, платы).  

Архитектура компьютера определяется совокупностью ее свойств, суще-

ственных для пользователя. Основное внимание при этом уделяется структуре 

и функциональным возможностям машины, которые можно разделить на ос-

новные и дополнительные. 

Персональный компьютер — это настольная или переносная ЭВМ, удов-

летворяющая требованиям общедоступности и универсальности применения.  

Основные блоки ПК и их назначение 

Персональный компьютер — универсальная техническая система. Суще-

ствует понятие базовой конфигурации, которую считают типовой. Понятие ба-

зовой конфигурации может меняться. В настоящее время в базовой конфигура-

ции рассматривают четыре устройства: системный блок, монитор, клавиатуру, 

мышь. 

Системный блок представляет собой основной узел, внутри которого ус-

тановлены наиболее важные компоненты. Устройства, находящиеся внутри 

системного блока, называют внутренними, а устройства, подключаемые к нему 

снаружи, называют внешними. Внешние дополнительные устройства, предна-

значенные для ввода, вывода и длительного хранения данных, также называют 

периферийными. 

Системный блок обычно включает в себя системную плату, блок питания, 

накопители на дисках, разъемы для дополнительных устройств и платы расши-

рения с контроллерами – адаптеры внешних устройств. 

 На системной плате (Mother Board) размещаются самые главные детали:  

1. Микропроцессор (МП) - это центральный блок ПК, предназначенный 

для управления работой всех блоков машины. В его состав входят: 

− устройство управления (УУ) — формирует и подает во все блоки машины в 

нужные моменты времени определенные сигналы управления (управляющие 

импульсы); формирует адреса ячеек памяти, используемых выполняемой опе-

рацией, и передает эти адреса в соответствующие блоки ЭВМ; опорную после-
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довательность импульсов устройство управления получает от генератора такто-

вых импульсов. В УУ входят регистр команд – запоминающий регистр, в кото-

ром хранится код команды, дешифратор операций и т.д.; 

− арифметико-логическое устройство (АЛУ) - предназначено для выполнения 

всех арифметических и логических операций над числовой и символьной ин-

формацией; 

− математический сопроцессор - используется для ускоренного выполнения 

операций числами, для вычисления некоторых трансцендентных, в том числе 

тригонометрических, функций. Математический сопроцессор имеет свою сис-

тему команд и работает параллельно (совмещение во времени) с основным МП, 

но под управлением последнего; 

− микропроцессорная память (МПП) - служит для кратковременного хранения, 

записи и выдачи информации, непосредственно используемой в вычислениях в 

ближайшие такты работы машины; 

− регистры - быстродействующие ячейки памяти различной длины;  

− интерфейсная система микропроцессора - реализует сопряжение и связь с 

другими устройствами ПК;  

2. Генератор тактовых импульсов - он генерирует последовательность 

электрических импульсов; частота генерируемых импульсов определяет такто-

вую частоту машины. 

Основными характеристиками процессоров являются разрядность и быст-

родействие. Разрядность — это число одновременно обрабатываемых бит. Бы-

стродействие — число выполняемых команд в секунду. Быстродействие связа-

но с  тактовой частотой, на которой работает процессор. Чем выше тактовая 

частота, тем выше и быстродействие. 

3. Источник питания - это блок, содержащий системы автономного и сете-

вого энергопитания ПК. 

4. Таймер  - это внутримашинные электронные часы, обеспечивающие при 

необходимости автоматический съем текущего момента времени (год, месяц, 

часы, минуты, секунды и доли секунд).  
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5. Системная шина - это основная интерфейсная система компьютера, 

обеспечивающая сопряжение и связь всех его устройств между собой. Систем-

ная шина обеспечивает три направления передачи информации: 

1) между микропроцессором и основной памятью; 

2) между микропроцессором и портами ввода-вывода внешних устройств; 

3) между основной памятью и портами ввода-вывода внешних устройств. 

Запоминающие устройства ПК 

Регистровая КЭШ-памятъ — высокоскоростная память сравнительно 

большой емкости, являющаяся буфером между ОП и МП. Используется для ус-

корения выполнения операций за счет запоминания на некоторое время полу-

ченных ранее данных, которые будут использоваться процессором в ближай-

шее время..  

Основная память делится на оперативное (RAM — Random Access Mem-

ory — память вольным доступом) и постоянное (ROM — Read-Only Memory) 

запоминающие устройство. 

Оперативное запоминающее устройство предназначено для хранения ин-

формации (программ и данных), непосредственно участвующей в вычисли-

тельном процессе на текущем этапе функционирования ПК. ОЗУ — энергоза-

висимая память: при отключении напряжения питания информация, хранящая-

ся в ней, теряется.  

Постоянное запоминающее устройство используется для хранения неиз-

меняемой информации: загрузочных программ операционной системы, про-

грамм тестирования устройств компьютера и некоторых драйверов базовой 

системы ввода-вывода (BIOS — Base Input-Output System) и др. Из ПЗУ можно 

только считывать информацию, запись информации в ПЗУ выполняется вне 

ЭВМ в лабораторных условиях. ПЗУ — энергонезависимое запоминающее уст-

ройство. 

Внешние запоминающие устройства 

Внешние запоминающие устройства (ВЗУ) предназначены для долговре-

менного хранения программ и данных. Устройства выполняют в виде накопи-
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телей, носителями информации в которых могут служить диски и ленты. Нако-

пители могут быть со сменными  носителями и со стационарными носителями 

информации. 

По способу доступа ВЗУ делятся на устройства прямого доступа и устрой-

ства последовательного доступа. Накопители на дисках — устройства прямого 

доступа, так как позволяют обратиться непосредственно к любому месту дис-

кового пространства. Накопители на магнитных лентах — устройства последо-

вательного доступа, так как доступ к нужной информации требует предвари-

тельного просмотра всей предыдущей.  

Основные характеристики ВЗУ— информационная емкость и время досту-

па. 

Диски относятся к машинным носителям с прямым доступом, это означа-

ет, что ПК может «обратиться» к дорожке, начинается участок с искомой ин-

формацией или куда нужно записать нужную информацию, где бы ни находи-

лась головка записи/чтения накопителя.   

Магнитные диски (МД) относятся к магнитным машинным носителям 

информации. В качестве запоминающей среды у них используются магнитные 

материалы со специальными свойствами (с прямоугольной петлей гистерезиса), 

позволяющими фиксировать два магнитных состояния — два направления на-

магниченности. Каждому из этих состояний ставятся в соответствие двоичные 

цифры: 0 и 1. Диски бывают жесткими и гибкими, сменными и встроенными в 

ПК. Устройство для чтения и записи информации на магнитном диске называ-

ется дисководом. 

Все диски характеризуются своим диаметром или, иначе, формфактором. 

Информация на МД записывается и считывается магнитными головками 

вдоль концентрических окружностей — дорожек. Количество дорожек на МД и 

их информационная емкость зависят от типа МД, конструкции накопителя на 

МД, качества магнитных головок и магнитного покрытия. 

Каждая дорожка МД разбита на сектора. В одном секторе дорожки может 

быть помещено 128, 256, 512 или 1024 байт, но обычно 512 байт данных. Обмен 
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данными между НМД и ОП осуществляется последовательно целым числом 

секторов. Кластер — это минимальная единица размещения информации на 

диске, состоящая из одного или нескольких смежных секторов дорожки. 

При записи и чтении информации МД вращается вокруг своей оси, а меха-

низм управления магнитной головкой подводит ее к дорожке, выбранной для 

записи или чтения информации. 

Накопители на дисках очень разнообразны.  

Накопители на гибких магнитных дисках (НГМД) 

Носители информации — гибкие диски — круглый диск из полиэфирной 

подложки с нанесенным магнитным покрытием. Диск помещают в плотный 

конверт (корпус), на внутреннюю поверхность которого нанесено очищающее 

покрытие.  

Получили распространение диски диаметром 5,25 дюйма (133мм) и 3,5 

дюйма (89 мм). Информация записывается с двух сторон (DS) по концентриче-

ским дорожкам, которые радиальным разбиением разделены на секторы. Ем-

кость сектора фиксирована 512 байт. Количество секторов — 9 или 15 на 5,25, 9 

или 18 на 3,5. Количество дорожек бывает 40 (DD) и 80 (QD, HD). Тогда  

Емкость = количество секторов * количество дорожек *количество сторон *512. 

Двусторонние дискеты маркируют DS 2S или просто 2. 40-дорожечные — 

DD, 80-дорожечные — QD или HD. 

В последние годы появились дискеты с тефлоновым покрытием (напри-

мер, Verbutim Data Life Plus), которое предохраняет магнитное покрытие и за-

писанную на нем информацию от грязи, пыли, воды, жира, отпечатков пальцев 

и даже от растворителей типа ацетона.  

Каждую новую дискету в начале работы с ней следует отформатировать. 

Форматирование –  это создание структуры записи информации на ее поверх-

ности: разметка дорожек, секторов, записи маркеров и другой служебной ин-

формации. 

Накопители на жестких магнитных дисках (НЖМД) 

В качестве накопителей на жестких магнитных дисках широкое распро-
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странение в ПК получили накопители типа "винчестер". Этот термин возник из 

жаргонного названия первой модели жесткого диска емкостью 16 Кбайт (IВМ, 

1973 г.), имевшего 30 дорожек по 30 секторов, что случайно совпало с калиб-

ром "30/30" известного охотничьего ружья "Винчестер". В этих накопителях 

один или несколько жестких дисков, изготовленных из сплавов алюминия или 

из керамики и покрытых ферролаком, вместе с блоком магнитных головок счи-

тывания/записи помещены в герметически закрытый корпус. Емкость этих на-

копителей благодаря чрезвычайно плотной записи, получаемой в таких несъем-

ных конструкциях, достигает нескольких тысяч мегабайт. Винчестер содержит 

диск или несколько дисков, расположенных в виде стопки один над другим, как 

блины. Причина, по которой жесткий диск является "жестким", заключается в 

том, что он вращается с очень большой скоростью - обычно 3600 об/мин, что в 

10 раз больше скорости вращения гибкого диска. Именно благодаря высокой 

скорости вращения диска считывание и запись информации осуществляются 

так быстро. Жесткие диски стационарны, вы не можете их снимать или хранить 

так же легко, как гибкие диски. В настоящее время созданы съемные жесткие 

диски. 

Накопители на оптических дисках 

В последние годы все большее распространение получают накопители на 

оптических дисках (НОД). Благодаря маленьким размерам (используются ком-

пакт-диски диаметром 3,5" и 5,25"), большой емкости и надежности эти нако-

пители становятся все более популярными. 

Неперезаписываемые лазерно-оптические диски обычно называют ком-

пакт-дисками ПЗУ — Сотрасt disk CD-ROM. Эти диски поставляются фирмой-

изготовителем с уже записанной на них информацией (в частности, с про-

граммным обеспечением). Запись информации на них возможна только вне ПК, 

в лабораторных условиях, лазерным лучом большой мощности, который остав-

ляет на активном слое след — дорожку с микроскопическими впадинами. В оп-

тическом дисководе ПК эта дорожка читается лазерным лучом существенно 

меньшей мощности. 
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Перезаписываемые лазерно-оптические диски с однократной  и много-

кратной  записью. На этих СD – ReWritable (CD-RW) лазерный луч непосредст-

венно в дисководе компьютера при записи прожигает микроскопические углуб-

ления на поверхности диска под защитным слоем; чтение записи выполняется 

лазерным лучом так же, как и у  CD-ROM. Информацию на них можно переза-

писывать до 1 000 раз и надежно хранить по крайней мере в течении сорока лет.  

ВНЕШНИЕ УСТРОЙСТВА 

Внешние устройства ПК обеспечивают взаимодействие машины с окру-

жающей средой: пользователями, объектами управления и другими ЭВМ. ВУ 

весьма разнообразны и могут быть классифицированы по ряду признаков.  

1. Устройствам ввода информации. 

1) Клавиатура — устройство для ручного ввода числовой, текстовой и 

управляющей информации в ПК. С помощью клавиатуры управляют компью-

терной системой. 

2) Графические планшеты (диджитайзеры) - для ручного ввода графи-

ческой информации, изображений путем перемещения по планшету специаль-

ного указателя (пера).  

3) Сканеры (читающие автоматы) — для автоматического считывания с 

бумажных носителей и ввода в ПК машинописных текстов, графиков, рисун-

ков, чертежей.   

4) Цифровые фотокамеры. Как и сканеры, эти устройства воспринимают 

графические данные с помощью приборов с зарядовой связью, объединенных в 

прямоугольную матрицу.  

5) Манипуляторы (устройства указания) Они предназначены для ввода 

графической информации на экран дисплея путем управления движением кур-

сора по экрану с последующим кодированием координат курсора и вводом их в 

ПК: 

− джойстик—рычаг; 

−  мышь, самый распространенный манипулятор. 
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− трекбол — шар в оправе, в отличие от мыши он устанавливается стационар-

но, и его шарик приводится в движение ладонью руки. 

− световое перо;  

− инфракрасная мышь отличается от обычной наличием устройства беспро-

водной связи с системным блоком и т.д. 

2. Устройства вывода информации. 

1. Принтеры — печатающие устройства для регистрации информации на 

бумажный носитель. Они являются наиболее развитой группой ВУ ПК и насчи-

тывают до 1000 разных модификаций. 

 1) Матричные принтеры.  

 Принцип печати этих принтеров состоит в том, что печатающая головка 

принтера, содержащая вертикальный ряд тонких металлических стержней (иго-

лок), движется вдоль печатаемой строки, а стержни в нужный момент ударяют 

по бумаге через красящую ленту, что обеспечивает формирование на бумаге 

символов и изображений. 

 2) Лазерные принтеры. 

 В лазерном принтере изображение создается лазерным лучом. Им управляет 

сложная электроника, которая позиционирует луч с высокой точностью. Луч рису-

ет изображение на барабане внутри лазерного принтера. Там, где луч касается ба-

рабана, возникает электрический заряд. Барабан вращается над картриджем с то-

нером, собирая тонер на электрически заряженные участки. Когда барабан входит 

в контакт с бумагой, тонерное изображение переводится на бумагу. Чтобы закре-

пить тонер на бумаге, используется тепло. Качество печати приближается к типо-

графскому.  

 3) Струйные принтеры. 

В этих принтерах изображение формируемся микрокаплями специальных 

чернил, выдуваемых на бумагу с помощью сопел. Этот способ печати обеспечива-

ет более высокое качество печати по сравнению с матричными принтерами, он по-

зволяет получить на специальной бумаге высококачественное цветное изображе-

ние. Однако струйные принтеры дороже матричных и требуют более тщательного 
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ухода и обслуживания. Скорость печати струйных принтеров примерно от 10 до 

60 с на страницу.  

2. Графопостроители (плоттеры) — для вывода графической информации 

(графиков, чертежей, рисунков) из ПК на бумажный носитель. 

 3. Монитор - это устройство визуального представления данных. Его ос-

новными потребительскими параметрами являются: размер, шаг маски экрана, 

максимальная частота регенерации изображения, класс защиты. 

3. Средства связи и телекоммуникации 

1. Модем - коммуникационное устройство, позволяющее передавать цифро-

вые данные по аналоговой телефонной линии. Он осуществляет преобразование 

данных с компьютера в последовательность дискретных (разнотипных) сигналов и 

их отправку по аналоговой телефонной линии. На другом конце они расшифровы-

ваются принимающим модемом путем аналого-цифрового преобразования.  

 2. Факс-модем - это устройство, сочетающее возможности модема и средст-

ва для обмена факсимильными изображениями с другими факс-модемами и обыч-

ными телефаксными аппаратами.  

4. Устройства речевого ввода-вывода. 

Эти устройства относятся к быстроразвивающимся средствам мультимедиа. 

Устройства речевого ввода — это различные микрофонные акустические системы, 

"звуковые мыши", например, со сложным программным обеспечением, по-

зволяющим распознавать произносимые человеком буквы и слова, идентифициро-

вать их и закодировать. 

Устройства речевого вывода — это различные синтезаторы звука, выпол-

няющие преобразование цифровых кодов в буквы и слова, воспроизводимые 

через громкоговорители (динамики) или звуковые колонки, подсоединенные к 

компьютеру. 

 Средства мультимедиа (multimedia — многосредовость) — это комплект ап-

паратных и программных средств, позволяющих человеку общаться с компьюте-

ром, используя самые разные, естественные для себя среды: звук, видео, графику, 

тексты, анимацию и др. К средствам мультимедиа относятся устройства речевого 

ввода и вывода информации; высококачественные видео- (video-) и, звуковые 
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(sound-) платы, платы видеозахвата (videograbber), снимающие изображение с ви-

деомагнитофона или видеокамеры и вводящие его в ПК; высококачественные аку-

стические и видеовоспроизводящие системы с усилителями, звуковыми колонка-

ми, большими видеоэкранами, а так же внешние запоминающие устройства боль-

шой емкости на оптических дисках, часто используемые для записи звуковой и 

видеоинформации. 

Контрольные вопросы 

1. Какие блоки входят в состав ПК? 

2. Что такое микропроцессор и какие функции он выполняет? 

3. Что такое математический сопроцессор и каково назначение ? 

4. Каковы структура и назначение арифметико-логического устройства? 

5. Каковы назначение и основные характеристики оперативной, постоянной и 

внешней памяти? 

6. Перечислите и охарактеризуйте основные виды внешней памяти ПК? 

7. Что такое средства мультимедиа? 

8. Перечислите основные устройства ввода-вывода информации и их назначение. 

9. Какие типы принтеров вы знаете? 

10. Что такое сканер и каково его назначение?  

Тест самоконтроля знаний 

Вариант №0 

1. Структура компьютера — это: 

a) комплекс электронных устройств, осуществляющих обработку информа-

ции; 

b) некоторая модель, устанавливающая состав, порядок и принципы взаимо-

действия входящих в нее компонентов; 

c) комплекс программных и аппаратных средств. 

2. Основная функция ЭВМ: 

a) общение человека и машины; 

b) разработка задач; 
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c) принцип программного управления. 

3. Микропроцессор предназначен для: 

a) управления работой компьютера и обработки данных; 

b) ввода информации в ЭВМ и вывода ее на принтер; 

c) обработки текстовых данных. 

4. Разрядность микропроцессора — это: 

a) наибольшая единица информации; 

b) количество битов, которое воспринимается микропроцессором как 

единое целое; 

c) наименьшая единица информации. 

5. Постоянная память предназначена для: 

a) длительного хранения информации; 

b) хранения неизменяемой информации; 

c) кратковременного хранения информации в текущий момент времени. 

6. Принтер предназначен для: 

a) ввода алфавитно-цифровых данных, управления работой ПК; 

b) вывода информации на бумагу; 

c) вывода на экран текстовой и графической информации. 

7. Монитор предназначен для: 

a) ввода алфавитно-цифровых данных, управления работой ПК; 

b) вывода информации на бумагу; 

c) вывода на экран текстовой и графической информации. 

8. Клавиатура предназначена для: 

a) ввода алфавитно-цифровых данных, управления работой ПК; 

b) вывода информации на бумагу; 

c) вывода на экран текстовой и графической информации. 

 

9. Функции системной шины состоят в: 

a) постоянном хранении самозагружаемой части операционной системы; 

b) передаче информации между микропроцессором и устройствами ПК; 
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c) архивном копировании больших объемов данных. 

10. Для печати изготовленного на ПК текста используется  

a) принтер; 

b) винчестер; 

c) сканер. 

Тема 4. Программное обеспечение персонального компьютера. 

Лекция: 

Программное обеспечение – совокупность программ обработки данных. 

Программа – упорядоченная последовательность команд (инструкций) 

компьютера для решения задачи. 

Программный продукт - комплекс взаимосвязанных программ для решения 

определенной задачи массового спроса, подготовленный к реализации как любой 

вид промышленной продукции. 

 Интегрированное программное обеспечение — набор нескольких программ-

ных продуктов, функционально дополняющих друг друга, поддерживающих еди-

ные информационные технологии, реализованные на общей вычислительной и 

операционной платформе. 

Программное обеспечение можно классифицировать по разным признакам. 

Рассмотрим классификацию по сфере (области) использования программного 

обеспечения: 

 

 
Системное программное обеспечение 

Системное программное обеспечение - совокупность программ и про-

граммных комплексов для обеспечения работы компьютера и компьютерных 

сетей. 

Программное обеспечение (ПО) 

Системное ПО Прикладное ПО Инструментарий технологий про-
граммирования 
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Базовое программное обеспечение 

Базовое программное обеспечение - минимальный набор программных 

средств, обеспечивающих работу компьютера. 

1. Операционная система - совокупность программ, предназначенных для 

управления ресурсами ЭВМ, организации диалога пользователя с ЭВМ, испол-

нения программ пользователя. 

Основная функция всех операционных систем - посредническая. Она за-

ключается в обеспечении нескольких видов взаимодействия (интерфейса): 

− интерфейс пользователя (взаимодействие между пользователем и программ-

но-аппаратными средствами компьютера); 

− аппаратно-программный интерфейс (взаимодействие между программным и 

аппаратным обеспечением); 

− программный интерфейс (взаимодействие между разными видами про-

граммного обеспечения). 

Программы, работающие под управлением операционной системы, назы-

вают приложениями.  

Операционные системы для персональных компьютеров можно классифи-

цировать по нескольким признакам: 

Системное программное обеспечение 

Базовое программное обеспечение Сервисное программное обеспечение 

Операционная система 

Операционная оболочка 

Сетевая операционная система 

Программы диагностики работо-
способности компьютера 

Антивирусные программы 

Программы обслуживания 
 дисков 

Программы архивирования данных 

Программы обслуживания сети 
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1) По реализации интерфейса. 

Различают неграфические (текстовые) и графические операционные сис-

темы. Неграфические операционные системы (MS DOS) реализуют интерфейс 

командной строки. Основным устройством управления в данном случае являет-

ся клавиатура. 

Работа в графической ОС основана на взаимодействии активных и пассив-

ных экранных элементов управления. В качестве активного элемента управле-

ния выступает указатель мыши, в качестве пассивных элементов управления 

выступают экранные кнопки, значки, переключатели, флажки, списки,  меню и 

многое другое. 

2) Поддержка многозадачности. 

Однозадачные операционные системы (Ms-Dos) передают все ресурсы вы-

числительной системы одному исполняемому приложению. 

 Многозадачность допускает параллельное выполнение нескольких при-

ложений. Различают вытесняющую и невытесняющую многозадачность. 

При невытесняющей многозадачности (NetWare) активный процесс вы-

полняется до тех пор, пока он сам по собственной инициативе, не отдаст управ-

ление операционной системе для того, чтобы та выбрала из очереди другой го-

товый к выполнению процесс. При вытесняющей многозадачности (Windows 

95/98/2000, Windows NT, OS/2, Unix) решение о переключении процесса с од-

ного на другой принимается операционной системой, а не самим активным 

процессом. 

3) Поддержка многопользовательского режима. 

В зависимости от числа пользователей, одновременно работающих с ОС, 

ОС делятся на однопользовательские (Ms DOS, ранние версии OS/2) и много-

пользовательские (Unix, Windows NT). Многопользовательские ОС позволяют 

нескольким пользователям разделять вычислительные ресурсы одного компью-

тера.  

4) Поддержка переносимости (непереносимые и переносимые на другие 

типы компьютеров); 
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5) Поддержка работы в сетях (несетевые и сетевые). 

2. Операционные оболочки - специальные программы, предназначенные 

для облегчения общения пользователя с командами операционной системы.  

3. Сетевые операционные системы – комплекс программ, обеспечивающий 

обработку, передачу и хранение данных в сетях. 

Сервисное программное обеспечение 

Сервисное программное обеспечение (программы-утилиты) — програм-

мы и программные комплексы, которые расширяют возможности базового про-

граммного обеспечения и организуют более удобную среду работы пользовате-

ля. 

1. Программы диагностики работоспособности компьютера и обслужива-

ния дисков (служебные программы). 

1) Форматирование диска (Format) – разбиение диска на дорожки и секто-

ра. 

2) Дефрагментация диска (Disk Defragments) – процедура по переносу ин-

формации из одних кластеров в другие, в результате которой доступ к любой 

информации будет более быстрым. 

3) Проверка диска (Scandisk) – программа обнаружения ошибок, связанных 

со сбоями в процессе записи на диск. 

4) Корзина - восстановление удаленных файлов. 

5) Очистка диска – программа освобождает место на диске путем удаления 

временных файлов (в корзине, из Интернета, для быстрого просмотра). 

6) Сведения о ресурсах (Sistem Information) – параметры аппаратного 

обеспечения; программная среда; программа отображает неполадки компьюте-

ра, но не устраняет их. 

2. Программы архивирования данных. 

Архивный файл – это специальным образом организованный файл, со-

держащий в себе один или несколько файлов в сжатом или несжатом виде и 

служебную информацию об именах файлов, дате и времени их создания или 

модификации, размерах и т. п. 
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Архивация (упаковка) – помещение (загрузка) исходных файлов в архив-

ный файл в сжатом или несжатом виде. 

Цели сжатия файлов: 

− обеспечение более компактного размещения информации на диске; 

− сокращение времени и стоимости передачи информации по каналам связи в 

сетях; 

− упрощение переноса файлов с одного диска на другой; 

− защита информации от несанкционированного доступа; 

− защита от заражения вирусами. 

Степень сжатия информации характеризуется коэффициентом сжатия: 

%100
0

⋅=
V
V

K c
c , где Vс – объем сжатого файла, V0 – объем исходного файла. 

Хорошо сжимаются графические и текстовые файлы. Слабо сжимаются 

файлы исполняемых программ. 

Разархивация (распаковка) – процесс восстановления файлов из архива 

точно в таком виде, какой они имели до загрузки в архив. При распаковке фай-

лы извлекаются из архива и помещаются на диск или в оперативную память.  

Наиболее распространенные программы – архиваторы: WinRAR и Win-

ZIP. 

3. Антивирусные программы. 

Компьютерным вирусом называется специально написанная программа, 

способная самопроизвольно присоединяться к другим программам, создавая 

свои копии и внедряя их в файлы, системные области компьютера и в вычисли-

тельные сети с целью нарушения работы программ, порчи файлов и каталогов, 

создания всевозможных помех в работе на компьютере. 

Признаки появления вирусов: 

− прекращение работы или неправильная работа программы; 

− невозможность загрузки операционной системы; 

− увеличение размера файлов; 

− исчезновение файлов и каталогов или искажение их содержимого; 
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− увеличение размера свободной памяти; 

− подача непредусмотренных звуковых сигналов. 

Классификация вирусов 

1. По среде обитания: сетевые, файловые, загрузочные, файлово-

загрузочные. 

2. По способу заражения: резидентные, нерезидентные. 

3. По степени воздействия: неопасные, опасные, очень опасные. 

4. По особенности алгоритмов: паразитические, репликаторы, невидимки, 

мутанты, троянские. 

 Антивирусная программа – это программа, предназначенная для обнаруже-

ния, удаления и защиты от компьютерных вирусов. 

Классификация антивирусных программ 

1. Детекторы - осуществляют поиск характерной для конкретного вируса 

последовательности байтов в оперативной памяти и в файлах и при обнаружении 

выдают соответствующее сообщение. 

2. Доктора - находят зараженные вирусами файлы и «лечат» их, т. е. удаля-

ют из файла тело программы вируса, возвращая файлы в исходное состояние. 

3. Ревизоры – запоминают исходное состояние программ, каталогов и сис-

темных областей диска до заражения вирусом, а затем периодически или по жела-

нию пользователя сравнивают текущее состояние и исходным 

4. Фильтры - предназначены для обнаружения подозрительных действий 

при работе компьютера. 

5. Вакцины – резидентные программы, предотвращающие заражение фай-

лов. 

Прикладное программное обеспечение 

1. Текстовые редакторы. 

Основные функции текстовых редакторов заключаются в автоматизации 

ввода и редактирования текстовых данных. 

В отличие от текстовых редакторов, текстовые процессоры позволяют не 

только вводить и редактировать текст, но и форматировать его, т.е. оформлять. 

Соответственно, к основным средствам текстовых процессоров относятся сред-
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ства обеспечения взаимодействия текста, графики, таблиц и других объектов. 

Назначение настольных издательских систем состоит в автоматизации 

процесса верстки полиграфических изданий. 

2. Графические редакторы. 

3. Системы управления базами данных (СУБД).  

4. Электронные таблицы. 

5. Системы автоматического проектирования. 

Программы этого класса предназначены для автоматизации проектно-

конструкторских работ, связанных с разработкой чертежей, схем, диаграмм, гра-

фическим моделированием и конструированием, созданием библиотеки стандарт-

ных элементов чертежей и их многократным использованием, созданием демонст-

рационных иллюстраций и мультфильмов. 

6. Системы автоматизированного управления. 

Системы автоматизированного управления - самый представительный 

класс программных продуктов, включающий в себя программные продукты: 

- автоматизированного бухгалтерского учета; 

- управления финансовой деятельности; 

- управления персоналом (кадровый учет); 

- управления материальными запасами; 

- управления производством; 

- банковские информационные системы и т.п. 

7. Офисные приложения. 

Данный класс программных продуктов охватывает программы, обеспечи-

вающие организационное управление деятельностью офиса: элементарные тек-

стовые редакторы;  органайзеры; автоматизированный перевод документов; 

средства проверки орфографии и распознавания текста; электронная почта.  

8. Экспертные системы. 

 Предназначены для анализа данных, содержащихся в банках знаний, и 

выдачи рекомендаций по запросу пользователя. такие системы применяют в тех 

случаях, когда исходные данные хорошо формализуются, но для принятия ре-
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шения требуются обширные специальные знания. Характерными областями 

использования экспертных систем являются юриспруденция, медицина, фарма-

кология, химия.  

9. Редакторы HTML (Web- редакторы). 

Это особый класс редакторов, объединяющий в себе свойства текстовых и 

графических редакторов. Они предназначены для создания и редактирования 

так называемых Web- документов (Web- страниц Интернета). Программы этого 

класса эффективно используют для подготовки электронных документов и 

мультимедийных изданий. 

10. Геоинформационные системы (ГИС) 

ГИС предназначены для автоматизации картографических и геодезических 

работ на основе информации, полученной топографическими или аэрокосмиче-

скими методами. 

11. Автоматизация научно-исследовательских работ. 

Программы, автоматизирующие научно-исследовательские работы, ис-

пользуют вычислительную мощь компьютера для решения расчетных задач.  

12. Программные средства мультимедиа. 

Этот класс программных продуктов является относительно новым. Основ-

ное назначение программных продуктов мультимедиа - создание и использова-

ние аудио- и видеоинформации для расширения информационного пространст-

ва пользователя.  

13. Системы видеомонтажа. 

Системы видеомонтажа предназначены для цифровой обработки видеома-

териалов, их монтажа, создания видеоэффектов, устранения дефектов, наложе-

ния звука, титров и субтитров. 

14. Компьютерная обработка звука. Музыкальные редакторы. 

Компьютерная обработка звука ориентирована на систему цифровой запи-

си. Музыкальные редакторы позволяют обрабатывать звук, записанный на зву-

ковой носитель; реставрировать старые записи с помощью встраиваемых при-

ложений; осуществлять нотную запись; создавать многоканальную запись; под-
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готавливать звуковые файлы к публикации в Интернет. 

15. Обучающие программы. 

Обучающие программы  предназначены для самостоятельного изучения 

данной темы, широко используются в заочном или дистанционном образова-

нии.  

Инструментарий технологии программирования 

 Это совокупность программ и программных комплексов, обеспечивающих 

технологию разработки, отладки и внедрения создаваемых программных про-

дуктов. 

Инструментарий технологии программирования обеспечивает процесс 

разработки программ и включает специализированные программные продукты, 

которые являются инструментальными средствами разработчика. Программные 

продукты данного класса поддерживают все технологические этапы процесса 

проектирования, программирования (кодирования), отладки и тестирования 

создаваемых программ. Пользователями технологии программирования явля-

ются системные и прикладные программисты. 

Инструментарий технологии программирования включают в себя следую-

щие классы: 

− средства для создания приложений (языки и системы программирования); 

− средства для создания информационных систем (CASE - технологии). 

Языки программирования - формальный язык для описания алгоритма ре-

шения задачи на компьютере.  

Системы программирования - хорошо интегрированная система, вклю-

чающая в себя как минимум: 

− специализированный текстовый редактор;  

− компилятор для перевода текста программы в машинный код; 

− библиотека функций; 

− редактор связей для связывания модулей (файлов с исходными текстами) и 

стандартных функций, находящихся в библиотеках; 
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− исполнимый код - это законченная программа с расширением .COM или 

.EXE, которую можно запустить  на любом компьютере, где установлена 

операционная система, для которой эта программа  создавалась; 

− справочную систему; 

− отладчик, который позволяет анализировать работу программы во время ее 

выполнения по шагам. 

CASE-технологии - программный комплекс, автоматизирующий весь тех-

нологический процесс анализа, проектирования, разработки и сопровождения 

сложных программных систем. 

Контрольные вопросы 

1. Что такое программное обеспечение, виды программного обеспечения? 

2. Что входит в системное программное обеспечение? 

3. Приведите характеристику основных видов базового программного обеспече-

ния? 

4. Дайте определение программ утилит. Приведите примеры. 

5. Назначение операционной системы.  

6. Какие принципы классификации операционных систем вы знаете? 

7. Что такое вытесняющая многозадачность? В чем ее отличие от невытесняющей? 

Приведите примеры. 

8. Перечислите известные вам операционные системы. Какие из них являются се-

тевыми? Назовите неграфические операционные системы, однопользователь-

ские операционные системы.  

9. Дайте понятия и укажите виды инструментария технологии программирования.   

10. Что входит в систему программирования? 

11. Укажите виды прикладного программного обеспечения. 

12. Какое прикладное программное обеспечение можно считать офисным? 

Тест самоконтроля знаний 

1. К операционным системам относятся: 

a) MS-Office, Clipper; 

b) MS-Word, Word Pad, PowerPoint; 
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c) MS-DOS, Unix, Windows Nt; 

2. Сетевые операционные системы — это: 

a) комплекс программ для одновременной работы группы пользователей; 

b) комплекс программ, переносимых в сети с одного компьютера на другой; 

c) комплекс программ, обеспечивающих обработку, передачу и хранение 

данных в сети; 

3. К программам-архиваторам относятся программы: 

a) Raj.ехе; 

b) Arj.ехе; 

c) Ajr.ехе; 

4. Системное программное обеспечение (System Software) — это: 

a) комплекс программ для решения задач определенного класса в конкрет-

ной предметной области; 

b) совокупность программ и программных комплексов для обеспечения ра-

боты компьютера и сетей ЭВМ; 

c) комплекс программ для тестирования компьютера; 

5. Отличительной особенностью операционной системы MS-DOS является: 

a) система ориентирована на эффективную поддержку процесса разработки 

программного обеспечения; 

b) система характеризуется развитыми средствами доступа ко всем аппарат-

ным средствам, гибкой файловой системой; 

c) наиболее простая операционная система; 

6. Системное программное обеспечение включает: 

a) базовое и сервисное программное обеспечение; 

b) операционную систему и антивирусные программы; 

c) операционные системы и операционные оболочки; 

7.Чем программное обеспечение отличается от аппаратного? 

a) аппаратное обеспечение – это все устройства, входящие в компьютер, а про-

граммное – это невидимая неотъемлемая часть, без которой не будет функ-

ционировать аппаратное обеспечение; 
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b) аппаратное обеспечение – это все, что можно потрогать и увидеть (систем-

ный блок, кабель), а программное обеспечение – это все компоненты, нахо-

дящиеся внутри (микросхемы и т.д.); 

c) принципиально не отличаются; 

8. Для чего нужны прикладные программы? 

a) для перевода программ в машинные коды; 

b) для управления процессом обработки информации; 

c) для решения задач пользователей; 

9. Утилита – это: 

a) программа; 

b) микросхема; 

c) устройство ввода информации; 

10.Выберите категорию, к которой относятся следующие программы: Scandisk, 

Winrar,  Drweb, Format: 

a) системные; 

b) сервисные; 

c) прикладные. 

Тема 5. Компьютерная графика. 

Лекция: 

Компьютерная графика – раздел информатики, предметом которого явля-

ется работа на компьютере с графическими изображениями (рисунками, черте-

жами, фотографиями и т. д ). 

Графический редактор – прикладная программа, предназначена для соз-

дания и обработки графических изображений на компьютере. 

Типы компьютерной графики 

1. Растровая графика – графика, состоящая из прямоугольной сетки точек, 

называемой растром. 

Каждая точка растра (пиксель) представлена единственным параметром – 

цветом. Пиксель - это цветное пятно, которое может принимать различные от-

тенки. Любое изображение вне зависимости от его сложности - это всего лишь 
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совокупность пикселей. Редактирование растровых изображений – изменение 

цветов их отдельных пикселей. 

Характеристики растровых изображений 

− Получаются с помощью сканеров из фотографических изображений, с по-

мощью цифровых камер. 

− Обеспечивают максимальную реалистичность изображения. 

− Занимают много памяти. 

− Качество зависит от размера. 

Основные параметры растровых изображений: 

− Количество цветов 

− Разрешение – количество пикселей на единицу длины (как правило на дюйм) 

2. Векторная графика состоит из  контуров. Контуры представляют собой 

кривые, имеющие точное математическое описание. 

Характеристики векторного изображения 

− Векторные изображения требуют ручного ввода (построения и рисования). 

Могут быть получены из растровых с помощью программ трассировки. 

− Не обеспечивают близкую к оригиналу реалистичность. 

− Компактны, так как хранят только математическое описание объектов. 

− Качество изображения не зависит от размера. 

− Легко редактировать. 

3. Фрактальная графика – предназначена для автоматической генерации 

изображений путем математических расчетов. Создание фрактальной художе-

ственной композиции состоит не в рисовании или оформлении, а в программи-

ровании. Изображение строится по уравнению. 

Простейшим фрактальным объектом является фрактальный треугольник. 

Данный вид графики часто используют в развлекательных программах. 

Теория цвета 

Основные - это три цвета, смешением которых в разных пропорциях можно 

получить любой цвет.  

Дополнительные цвета при смешении дают в глазу ощущение белого цвета, 
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например сине-зеленый и красный, оранжевый и синий, зелено-желтый и фиоле-

товый цвета. 

Для описания цвета используются математические модели, работа которых 

основана на смешения основных цветов для получения всех других цветов: 

− RGB (Red-красный, Green-зеленый, Blue -синий). В этой модели отображает 

экран монитора, кодирует изображение сканер. 

− CMYK (Cyan-голубой, Magenta-пурпурный, Yellow-желтый, BlacK). Ис-

пользуется для создания изображений, предназначенных для печати. 

Лабораторные работы: 

Тема №1: Создание простейших изображений в графическом редакторе 

CorelDraw. 

Цель работы: В результате выполнения лабораторной работы вы:  

 познакомитесь с основными возможностями CorelDraw; 

 научитесь создавать простейшие изображения. 

Методические указания и задания к лабораторной работе: 

В качестве отчетной работы требуется создать визитку с учетом основных 

правил подготовки изображений к печати в типографии и вывести на лист А4 

при помощи автоматического расположения на листе. 

1. Создание визитки 

− Устанавливаем размер листа под размер визитки (90х50) 

− Заполняем документ содержимым (в данном случае это несколько надписей 

и растровая картинка) 

− Важно! Видимую рамку к визитке делать нельзя, т.к. из-за погрешностей при 

обрезке рамка будет иметь неодинаковую толщину или с каких-то сторон ее 

не будет вообще. 

− Сохраняем документ. 

 

В результате получаем: 
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2. Подготовка к печати 

− Входим в «print preview» 

− В режиме «Imposition layout tool» выбираем нужное число копий по верти-

кали и горизонтали. 

 
− В режиме «Marks placement tool» устанавливаем метки для обрезки 
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− Теперь, если нужно, такой стиль оформления можно сохранить (file => save 

frint style as…). Документ готов к печати. 

Тема №2: Создание простейших изображений в графическом редакторе Pho-

toShop. 

Цель работы:   

 познакомиться с программой PhotoShop; 

 научиться создавать контурный и обведенный текст. 

Методические указания и задания к лабораторной работе: 

1. Создание контурного и обведенного текста. 

Инструмент Type (Текст) обладает незначительными возможностями соз-

дания контуров. Невозможно задать толщину обводки, нельзя выбрать режим 

наложения или установить величину непрозрачности. Обычно для ввода и об-

водки текста перед импортом в Photoshop используют программу типа 

Illustrator. Если это невозможно, то для создания контуров воспользуйтесь ко-

мандой Stroke (Выполнить обводку) меню Edit (Редактирование). 

Прозрачный текст с цветным контуром можно создать, выполнив следую-

щие действия: 
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1. Выберите инструмент Type Mask (Текст-маска) и щелкните на открытом 

изображении или на новом слое, в котором хотите поместить текст. 

2. Введите текст. Оставьте выделенную область ак-

тивной для выполнения последующих действий. 

3. Задайте желаемый цвет контура. 

4. В меню Edit (Редактирование) выберите команду 

Stroke (Выполнить обводку) и введите необходимые зна-

чения. 

Для создания окрашенного текста, контур которого имеет другой цвет, вы-

полните следующие действия: 

1. Задайте основной цвет, соответствующий цвету текста. 

2. Выберите инструмент Type (Текст), щелкните на 

новом слое и введите требуемый текст. 

3. Выполните Select → Load Selection, чтобы выделить текст по контуру и 

склейте слои (Ctrl + E). 

4. Задайте основной цвет, соответствующий цвету обводки. 

5. В меню Edit (Редактирование) выберите команду 

Stroke (Выполнить обводку) и введите необходимые значе-

ния. 

2. Пламя. 

Нам потребуется однослойное изображение - белая надпись на черном фо-

не. Удобнее всего использовать режим серых полутонов. 

Эффект пламени более выразителен на широком светлом 

шрифте без засечек. Можно применить и массивный шрифт, обведя буквы по 

контуру. 

Первый этап состоит в применении фильтра Wind, вызываемого через ме-

ню Filter → Stylize. Перед вызовом эффекта ветра надо повернуть изображение 

на 90o по часовой стрелке (команда Image → Rotate Canvas → 90o CW), по-

скольку в фильтре Wind нет вертикального направления ветра. Мы включим 

направление From the right, а силу ветра оставим минимальную - Wind. Чтобы 
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следы ветра получились более мощными, можно применить фильтр несколько 

раз подряд, нажав клавиши Crtl + F. После чего возвраща-

ем изображение в нормальное положение командой меню 

Image → Rotate Canvas → 90o CCW. 

Придадим надписи и языкам ветра рваную форму, более соответствующую 

пламени. Для этого воспользуемся фильтром Diffuse, вызвав его через то же 

меню Filter → Stylize и установив режим Normal. 

Далее применим фильтр Gaussian Blur при небольшом радиусе. В данном 

случае он составил 1.3 пиксела. Усилим дрожание с по-

мощью фильтра Ripple (рябь), который вызывается через 

меню Filter → Distort. Зададим амплитуду (Amount) по-

рядка 80 - 100, да и длина волны пусть будет небольшой, выберем Small или 

Medium. 

На последнем этапе надо перевести изображение из черно-белого полуто-

нового в индексированный цвет Image → Mode → Indexed Color. Изменить па-

литру изображения с индексированным цветом можно с 

помощью команды меню Image → Mode → Color Table. 

Редактор Photoshop предлагает несколько заранее подго-

товленных палитр, из которых выберем Black Body. 

3. Лед. 

Создадим новое изображение и напишем на нем текст черным цветом. Затем 

выполним Select → Load Selection и Layer → Flatten Image. 

Выполним команду Select → Inverse, и применим фильтр Filter → Pixelate → 

Crystallize с коэффициентом кристаллизации равным 8. 

Опять выполняем команду Select → Inverse, и применяем 

фильтр Filter → Noise → Add Noise с коэффициентом шума 

около 70 (включите Distribution: Gaussian). 
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Размываем избражение фильтром Filter → Blur → Gaussian Blur с коэффи-

циентом размывки около 2. Затем отменяем выделение Select → None и исполь-

зуем фильтр Filter → Blur → Blur. 

Выполняем команду Image → Adjust → Invert (Ctrl + I). 

Повернем изображение Image → Rotate Canvas → 90 

CW. Затем применяем фильтр Filter → Stylize → Wind (Method: Wind, Direction: 

From the left) и возвращаем картинку в горизонтальное положение Image → Ro-

tate Canvas → 90 CCW. 

Придадим изображению цвет льда с помощью команды Image → Adjust → 

HueSaturation (Включите Colorize, установите параметр Hue в положение - 181, 

а Saturation - 80). 

Добавим искрящиеся блики с помощью дополнительных кистей. В меню 

Brushes (Кисти) выберите команду Load Brushes (Загрузить 

Кисти) и откройте файл assorted.abr из подкаталога Brushes. 

Установите текущим белый цвет и нанесите искорки на не-

которые выступающие льдинки. 

4. Золотая надпись. 

Создаем новый белый лист. Переходим в палитру каналов и, нажав на кнопку 

внизу этой палитры, создаем канал #4. Его фон должен быть черным, а текст бе-

лым. Пишем текст. Этот эффект наиболее выразителен при использовании круп-

ных символов. 

Активизируем единственный слой Background он должен быть белым. Маску 

из канала #4 загружаем в окно редактора комбинацией клавиш [Ctrl]+[Alt]+[4]. За-

крашиваем ее черным. Залить маску основным цветом можно клавишами 

[Alt]+[Del]. Выключаем маску, нажав [Ctrl]+[D]. 

Надпись на слое Background надо растушевать с помо-

щью гауссового фильтра (Filters → Blur → Gaussian Blur). Ра-

диус в 3 пиксела. 

Переименуем этот слой. Щелкните дважды мышкой по пиктограмме слоя 

Background в палитре слоев. Затем необходимо продублировать слой. Для этого 
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перетащите мышкой в палитре слоев дублируемый слой на кнопку создания ново-

го. 

Слои надо сдвинуть друг относительно друга (Filter → Other → Offset). 

Для одного из слоев набираем два положительных смещения на 4 пиксела, а 

для другого - два отрицательных по 4 пиксела. 

Для верхнего из слоев (Layer 0 copy) режим наложе-

ния заменяем с Normal на Difference (разница). Теперь 

слои объединяем в один [Ctrl]+[Е].  

Нажав комбинацию клавиш [Ctrl]+[М], Вам надо по-

пытаться воспроизвести кривую, подобную той, что на ил-

люстрации. 

Загружаем маску #4 командой меню Select → Load 

Selection, затем маску инвертируем [Ctrl]+[Shift]+[I]. Убедившись, что маска 

включает в себя не надпись, а фон вокруг нее (об этом свидетельствует бегущая 

штриховая линия по краю окна редактора), нажмите клавишу [Del]. 

Нажимаем [Ctrl]+[D] и [Ctrl]+[I] - инвертирование. 

Создаем новый слой (цветной) Слой1. Подбираем ему из 

каталога золотистый цвет. Делаем заливку [Ctrl]+[Del]. Де-

лаем для Слой0 цветность. 

Надо объединить слои в срезаемую группу. Получаем ее, щелкнув мышкой 

при нажатой клавише [Alt] по линии, разделяющей слои в палитре Layers. 

Создаем новый слой Слой2, делаем его цветным. В ката-

логе выбираем черный цвет и нажав [Ctrl]+[Del] заливаем. 

Расположите слои в такой последовательности: слой1, слой2, слой0. 

5. Эффект «X-Files». 

Создайте новое изображение RGB с чёрным фоном. Напишите ваш текст. 

Далее необходимо объединить слои (Ctrl + E). Теперь, откройте палитру Кана-

лы (Window → Show Channels); переместите любой из каналов к значку новый 

канал. Это создаст новый канал. Откройте двойным щелчком мыши свойства 

этого канала и переименуйте его в «оригинал». 
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Перетащите канал «оригинал» к значку нового канала и сделайте дубликат. 

Дважды щелкните на новом канале, и переименуйте его в «белый». Затем нажав 

Ctrl + щелчок мыши на канале, загрузите его в выделение. Те-

перь мы немного расширим его. Используйте Select → Modify 

→ Expand со значением 1 пиксела. Далее выполните Edit → Fill 

use: white. Снимите выделение Select → Deselect и выполните размывку Filter 

→ Blur → Gaussian Blur с радиусом равным 2. 

Перетащите канал «белый» к значку новый канал, чтобы у нас получился 

ещё один канал. Дважды щёлкните на образовавшемся канале, и 

переименуйте его в «жёлтый». Ctrl + щелчок, чтобы загрузить в 

выделение. Опять, Select → Modify → Expand со значением 2. За-

полните белым цветом, снимите выделение и примените фильтр Filter → Blur 

→ Gaussian Blur с радиусом 3. 

Последний канал мы получим следующим образом - перетащите канал 

«желтый» к значку новый канал. Переименуйте его в «зелёный», 

Ctrl + щелчок; расширьте на 4. Заполните белым, снимите выде-

ление, размойте с радиусом 7 пикселов. 

Переключитесь на канал RGB. Выполните Select → Load Selection и выбе-

рите там канал «зелёный». Теперь выберите подходящий зеленый 

цвет, например R:0 G:255 B:0. И выполните заливку Edit → Fill 

use: Foreground Color. 

Сделайте тоже самое для канала «жёлтый», но с использованием цвета 

R:128 G:255 B:0. Теперь тоже самое сделайте для канала «бе-

лый», используя белый цвет. Загрузите «оригинал», выполните 

Select → Modify → Contract установка - 1 пиксел и залейте чер-

ным Edit → Fill use: black. 

Контрольные вопросы 

1. Какие существуют виды компьютерной графики? 
2. В каких единицах измеряют размеры экранных и печатных изображений? 
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3. Назовите наименьший элемент растрового изображения. 
4. Назовите наименьший элемент векторного изображения. 
5. Почему цветовую модель RGB называют аддитивной? 
6. Почему цветовую модель CMYK называют субтрактивной? 
7. Какие графические редакторы вы знаете? 

Контрольная работа 

Создать иллюстрированный материал по одной из тем: 

− рекламный проспект; 

− билет в театр (цирк, кинотеатр, музей); 

− визитная карточка некоторой организации. 

Тест самоконтроля знаний 

1. Пикселизация изображений при увеличении масштаба – один из недостатков: 
a) растровой графики; 
b) векторной графики; 
c) трехмерной графики; 

2. Большой размер файла – один из недостатков: 
a) растровой графики; 
b) векторной графики; 
c) трехмерной графики;  

3. Физический размер изображения может измеряться в:  
a) точках на дюйм (dpi) 
b) мм, см, дюймах или пикселах;  
c) пикселах; 

4. Растровый графический редактор предназначен для: 
a) построения диаграмм; 
b) создания чертежей; 
c) создания и редактирования рисунков; 

5. В модели CMYK в качестве компонентов применяются основные цвета ...  
a) красный, зеленый, синий, черный; 
b) голубой, пурпурный, желтый, черный; 
c) красный, голубой, желтый, синий; 
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6. В модели RGB в качестве компонентов применяются основные цвета: 

a) красный, зеленый, синий; 

b) голубой, пурпурный, желтый; 

c) красный, голубой, желтый; 

7. Какой из графических редакторов является растровым: 

a) Adobe Illustrator; 

b) Paint; 

c) CorelDraw; 

8. Разрешение изображения измеряется в: 

a) пикселах; 

b) точках на дюйм (dpi); 

c) мм, см, дюймах; 

 9. Paint – это: 

a) векторный графический редактор; 

b) растровый графический редактор; 

c) редактор сочетающий растровую и векторную графику; 

10. Графический редактор – это 

a) прикладная программа, предназначена для создания и обработки графиче-

ских изображений на компьютере; 

b) сервисная программа, предназначена для создания и обработки графических 

изображений на компьютере; 

c) прикладная программа, предназначена для обработки графических изобра-

жений на компьютере. 

Тема 6. Файловая система. Norton-подобные оболочки. 

Лекция: 

Файловая система 

Файловая система (ФС) является важной частью любой операционной 

системы, которая отвечает за организацию хранения и доступа к информации 

на каких-либо носителях. 

ФС - это совокупность именованных наборов данных и программ на 
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внешних  носителях,   структуру  и   организацию   которых  поддерживает опе-

рационная система. 

В широком смысле понятие ФС включает: 

− совокупность всех файлов на диске,  

− наборы служебных структур данных, используемых для управления файла-

ми, такие как, например, каталоги файлов, дескрипторы файлов, таблицы 

распределения свободного и занятого пространства на диске,  

− комплекс системных программных средств, реализующих управление фай-

лами, в частности операции по созданию, уничтожению, чтению, записи, 

именованию файлов, установке атрибутов и уровней доступа, поиску и т.д.  

Различие между файловыми системами заключается, в основном, в спосо-

бах распределения пространства между файлами на диске и организации на 

диске служебных областей. 

Файл - это поименованная совокупность  элементов  информации храня-

щаяся на магнитных носителях - дисках, лентах.  

Имена файлов записываются следующим образом:  ИМЯ . ТИП,  где 

ИМЯ набор символов (короткое не более 8 символов, длинное – 256 ) латинско-

го алфавита,  цифр и специальных символов ~ & @ ( ) %  { } _ #  $,  а ТИП или 

РАСШИРЕНИЕ файла состоит  из не более чем 3 символов.  В отличие от име-

ни тип может отсутствовать в спецификации файла. 

Тип файла  используется для классификации,  определения принадлежно-

сти к какой-то группе с общими свойствами.  
Тип Назначение 
ARJ Архивный файл  
BAT Командный файл 
СOM Командный системный файл, исполняемый файл 
DAT Файл данных 
DOC Файл документов (текстовый) 
EXE Исполняемый файл 
PAS Программа на языке Паскаль 
SYS Файлы, расширяющие возможности операционной системы 
TXT Текстовый файл 

При использовании имен файлов в качестве параметров команд ОС необ-

ходимо указывать адрес или путь к файлу. Путем к  файлу называется цепочка 
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символов,  начиная с имени дисковода,  корневого каталога и последующих 

подкаталогов  вплоть до каталога, содержащего необходимый файл. 

Имя дисковода - это одна из букв латинского алфавита. Персональный 

компьютер  имеет несколько накопителей на магнитных носителях, исходя из 

этого,  принято обозначать A: и B: - гибкие диски, C: D: и т.д. - жесткие диски. 

Каталог - это справочник файлов и библиотек со  ссылками  на их распо-

ложение, содержащее информацию о файлах (имя, тип, размеры в байтах, дата 

и время создания, атрибуты) и других каталогах, называемых подкаталогами,  

используется операционной системой для определения местоположения файла. 

 На каждом  диске  имеется один главный или корневой каталог. Каталоги, 

входящие в корневой  каталог  называются  подкаталогами 1-го уровня.  Ката-

логи, входящие в состав подкаталога 1-го уровня называются подкаталогами 2-

го уровня и т.д. Каждый подкаталог является оглавлением,  содержащим пере-

чень имен файлов и подкаталогов, возможны варианты, когда в оглавлении  

имеются  только  имена файлов.  

Организация файловой системы 

Принцип организации файловой системы — табличный. Поверхность же-

сткого диска рассматривается как трехмерная матрица, измерениями которой 

являются номера поверхности, цилиндра и сектора. Под цилиндром понимается 

совокупность всех дорожек, принадлежащих разным поверхностям и находя-

щихся на равном удалении от оси вращения. Данные о том, в каком месте диска 

записан тот или иной файл, хранятся в системной области диска в специальных 

таблицах размещения файлов (FAT-таблицах). К FAT-таблицае предъявляются 

особые требования надежности, и она существует в двух экземплярах, идентич-

ность которых регулярно контролируется средствами операционной системы. 

 Наименьшей физической единицей хранения данных является сектор. 

Размер сектора равен 512 байт. Поскольку размер FAT- таблицы ограничен, то 

для дисков, размер которых превышает 32 Мбайт, обеспечить адресацию к ка-

ждому отдельному сектору не представляется возможным. В связи с этим груп-

пы секторов условно объединяются в кластеры. Кластер является наименьшей 
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единицей адресации к данным. Размер кластера, в отличие от размера сектора, 

не фиксирован и зависит от емкости диска. 

Операционные системы MS-DOS, OS/2, Windows 95, Windows NT реали-

зуют 16-разрядные поля в таблицах размещения файлов. Такая ФС называется 

FAT 16. Она позволяет разместить в FAT-таблицах не более 65 536 записей (216) 

о местоположении единиц хранения данных и, соответственно, для дисков объ-

емом от 1 до 2 Гбайт длина кластера составляет 32 Кбайт (64 сектора).  

Высокопроизводительная ФС HPFS (High Performance File System) позво-

ляет использовать жесткие диски объемом до 2 Терабайт. Кроме того, она под-

держивает разделы диска размером до 512 Гб и позволяет использовать имена 

файлов длиной до 255 символов. В HPFS по сравнению с FAT уменьшено вре-

мя доступа к файлам в больших каталогах.  

ФС VFAT (Virtual FAT), реализованная в Windows NT 3.5, Windows 95 

(DOS 7.0) - это файловая система FAT, включающая поддержку длинных имен 

файлов. VFAT использует ту же самую схему распределения дискового про-

странства, что и файловая система FAT. 

ФС FAT32 - усовершенствованная версия файловой системы VFAT, под-

держивающая жесткие диски объемом до 2 терабайт. Главные отличия от пре-

дыдущих версий FAT состоят в следующем. Блок начальной загрузки на разде-

лах с FAT32 был увеличен до 2 секторов и включает в себя резервную копию 

загрузочного сектора, что позволяет системе быть более устойчивой к возмож-

ным сбоям на диске. Объем, занимаемый таблицей размещения файлов, увели-

чился, поскольку теперь каждая запись в ней занимает 32 байта, и общее число 

кластеров на разделе FAT32 больше, чем на разделах FAT. Соответственно, вы-

росло и количество зарезервированных секторов. 

ФС NTFS (New Technology File System) - наиболее предпочтительная фай-

ловая система при работе с ОС Windows NT (Windows 2000 и XP также являют-

ся NT системами), поскольку она была специально разработана для данной сис-

темы. В NTFS значительно расширены возможности по управлению доступом к 

отдельным файлам и каталогам, введено большое число атрибутов, реализована 
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отказоустойчивость, средства динамического сжатия файлов. NTFS позволяет 

использовать имена файлов длиной до 255 символов, при этом она использует 

тот же алгоритм для генерации короткого имени, что и VFAT. NTFS обладает 

возможностью самостоятельного восстановления в случае сбоя ОС или обору-

дования, так что дисковый том остается доступным, а структура каталогов не 

нарушается. NTFS позволяет хранить файлы размером до 16 эксабайт (264 байт) 

и располагает встроенным средством уплотнения файлов в реальном времени.  

Операционная система Microsoft DOS. 

1. Начальные сведения о DOS. 

DOS является основной частью программного обеспечения. DOS означает 

Disk Operating System (дисковая операционная система), которая необходима 

для запуска и работы компьютера. 

DOS   является  однопользовательской  и  однозадачной  ОС.  Диалог поль-

зователя с DOS осуществляется в форме команд, которые записываются в ко-

мандной строке,  начинающейся с приглашения DOS.  Командная строка обыч-

но имеет следующий вид: C:\>_ 

2. Составные части DOS 

 1. Базовая система ввода/вывода (BIOS), находящаяся в постоянной памя-

ти (постоянном запоминающем устройстве, ПЗУ) компьютера.  

2. Загрузчик ОС (ядро DOS) - это очень короткая программа,  находящаяся 

в  первом секторе каждой дискеты с ОС DOS.   

3. Дисковые файлы Io.sys и Msdos.sys.   

4. Командный  процессор находится в файле Command.com на диске, с кото-

рого загружается ОС.   

5. Драйверы устройств - это специальные программы, которые дополняют 

систему ввод/вывода DOS и обеспечивают  обслуживание  новых  или нестандарт-

ное использование имеющихся устройств.   

Операционные оболочки. 

Программа-оболочка – это программа, один из модулей которой, называемый 

резидентным, постоянно находится в оперативной памяти компьютера. 
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Оболочки позволяет эффективно работать с файловой системой  дисков, а 

также запускать программы на исполнение. 

Элементы экрана Windows Commander. 

Главное меню расположено в верхней строке окна и заключает в себе все 

возможности программы, рассортированные по более или менее однотипным ко-

мандам.  

Панели – две равноправные таблицы, занимающие основную часть окна. 

Внутри панелей может отображаться различная информация. Одна из панелей яв-

ляется активной (на ней находится курсор и заголовок панели подсвечен), другая 

панель – пассивная. Смена активное панели достигается нажатием  Tab или щелч-

ком мыши в любой части панели. При этом курсор перемещается с одной панели 

на другую. Панели предназначены для представления различной информации на 

экране. С панелями связаны пункт меню Вид, который имеет три основных разде-

ла. Первый раздел меню Вид содержит команды, управляющие тем, что выводится 

в панелях, второй раздел – как выводится, третий раздел — режимы сортировки. 

Командная строка располагается под панелями и служит для выполнения ко-

манд MS-DOS.   

Меню функциональных клавиш расположено в самой нижней строке экрана. 

Оно имеет вид подсказок к функциональным клавишам. 

Вид информации в окне 

Для выбора внешнего вида информации, выводимой в рабочей области окна 

необходимо выполнить команду главного меню Вид и установить флажки возле 

команд, которые должны выполняться. Изменения произойдут только в текущей 

панели. 

Сочетание 
клавиш 

Команда Назначение 

Ctrl+F1 Краткий  Краткая информация о файле (только имя) 
Ctrl+F2 Подробный Полная информация о файле (имя, расширение, размер, 

дата, атрибуты) 

Ctrl+F8 Дерево В панели выводится дерево каталогов текущего диска. 
При перемещении по дереву в противоположной панели 
отображается содержимое открываемого каталога 

Ctrl+Q Быстрый про-
смотр 

Если установить курсор на какой-либо файл текущей па-
нели, то в противоположной панели появится его содер-
жимое. Если установить курсор на каталог, то появиться 
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информация о нем (общий размер, количество файлов) 
 Одна панель 

под другой 
Панели размещаются в окне горизонтально, одна под дру-
гой 

Работа с папками и файлами 

1. Смена оглавление диска в панели. 

Сменить оглавление диска в текущей панели можно несколькими способами: 

1. Щелкнуть по кнопке с названием диска. 

2. Обратиться к окну выбора диска (рис.2.7) и выбрав нужный диск из списка, 

щелкнуть по нему левой кнопкой мыши. 

3. Воспользоваться комбинацией клавиш Alt+F1 для левой панели или Alt+F2 

– для правой. Результатом нажатия клавиш будет открытие окна выбора дисков. 

Перемещаясь по списку доступных дисков при помощи клавиш ↑ и ↓, установить 

курсор на имя нужного дика и нажать Enter. 

2. Переход из каталога в каталог. 

Войти в каталог можно: Выйти из каталога: 

1. Двойным щелчком мыши. 

2. Установить курсор на каталог и на-

жать клавишу Enter. 

 

1. Переместить курсор в крайнее 

верхнее положение (стрелка вверх и 

двоеточие) и дважды щелкнуть мыш-

кой. 

2. Переместить курсор в крайнее 

верхнее положение и нажать клавишу 

Enter. 

3. Выделение файлов и каталогов. 

Прежде чем выполнять какие либо действия с файлами и каталогами их 

необходимо выделить. Для этого существует множество способов. 

Чтобы выделить один файл или один каталог по нему можно просто щелк-

нуть мышкой или установить курсор. 

Для выделения группы файлов используется клавиша Insert. Выделенный 

файл становится красного цвета. Повторное нажатие клавиши Insert, снимает 

выделение. Тот же эффект достигается при щелчке по файлу правой кнопкой 

мыши.  
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Группу смежных файлов (подряд идущих) можно выделить при помощи 

клавиш перемещения курсора ↑, ↓, удерживая клавишу Shift. Группу несмеж-

ных файлов (располагающихся в списке не подряд) можно выделить при помо-

щи левой кнопки мыши удерживая при этом клавишу Ctrl. 

1. Просмотр файла.  

Для просмотра файл необходимо выделить. Затем нажать клавишу или 

кнопку F3. Откроется специальное окно программы просмотра. Текст в этом 

окне можно только просматривать. 

2. Редактирование файла. 

Для редактирования файла его необходимо выделить и нажать клавишу F4. 

Откроется окно стандартной программы Блокнот. Файл, который был выделен, 

автоматически загружается в это окно. Здесь, в отличие от программы про-

смотра, курсор активен, а это значит, что доступны элементарные приемы ре-

дактирования: можно набирать с клавиатуры текст, вносить в него изменения и 

удалять. 

3. Копирование файла или каталога.  

Для копирования файлов и каталогов служит клавиша F5. Технология ко-

пирования заключается в следующем. 

1) Раскрыть в одной панели тот каталог, в который копируем. 

2) В другой панели поставить курсор на тот файл или каталог, который ко-

пируем. 

3) Нажать F5. 

4) Нажать Enter. 

4. Перемещение файла или каталога. 

Процесс перемещения аналогичен процессу копирования, разница лишь в 

том, что объекты перемещаются из каталога в каталог, а не копируются. Для 

начала процесса перемещения нужно нажать кнопку F6. 

5. Переименование файлов и каталогов. 

Самый простой способ переименовать объект это выделить его щелчком 

левой кнопки мыши, а затем повторить щелчок. Текстовое поле, содержащее 
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имя объекта активизируется, в нем появится курсор. Старое имя можно удалить 

и ввести новое. 

9. Создание нового каталога. 

Для создания каталога необходимо перейти в каталог, внутри которого бу-

дет создаваться новый каталог и нажать F7. Появится диалоговое окно для вво-

да имени нового каталога. После нажатия Enter каталог будет создан. 

10. Удаление файлов и каталогов. 

Удаление происходит с помощью клавиши F8, после нажатия которой 

нужно необходимое количество раз подтвердить удаление. 

11. Быстрый поиск каталогов. 

При выполнении команды Команды→Дерево каталогов (ALT+F10 )выво-

дится окно, в котором помещено дерево каталогов диска, выведенного на теку-

щей панели. При помощи этого окна можно быстро перейти в нужный каталог. 

Для этого нужно установить на него курсор и либо нажать Enter, либо дважды 

щелкнуть мышкой, либо нажать кнопку Ок. Клавиша F2 позволяет обновить 

дерево каталогов. 

12. Поиск файлов. 

Осуществить поиск файлов можно при помощи команды Команды→Поиск 

файлов…(ALT+F7).  

13. Архивация файлов. 

Для того, чтобы поместить объекты в архив, их необходимо выделить. За-

тем выполнить команду Файл→Упаковать или нажать сочетание клавиш 

Alt+F5.  Появится окно Упаковка файла. В этом окне можно задать архиватор и 

тип архивации. В текстовое поле Упаковать файлы в архив необходимо ввести 

полное имя будущего архивного файла.  

Для того, чтобы извлечь объекты из архива, необходимо выделить архив-

ный файл и выполнить команду Файл→Распаковать или нажать сочетание кла-

виш Alt+F9. На экране появится окно Распаковка файлов. В текстовом поле 

Распаковать выбранные файлы из архива в: необходимо указать имя диска и ка-

талога в который будет извлечена информация из архива. 
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14. Создание файла. 

Для создания файла необходимо нажать сочетание клавиш Shift+F4. В поя-

вившемся окне Редактирование файла вводится имя создаваемого файла и на-

жимается клавиша Enter. 

Лабораторная работа: Операционная оболочка Total Commander. 

Цель работы:   

 узнать назначение операционной оболочки Total Commander; 

 научиться выполнять операции с объектами в Total Commander. 

Задания к лабораторной работе: 

1. На диске С: создать два каталога DOG и GRAND. 

2. В каталог DOG создайте файл dogovor.txt, содержащий текст: 

ДОГОВОР №1 

Данный договор составлен 10.10.2000 год. 

3. Скопируйте файл dogovor.txt в каталог GRAND. 

4. Переименовать в каталоге GRAND файл dogovor.txt на dogovor1.txt. 

5.  В файле dogovor1.txt исправить число 10.10.2000 на 10.12.2002. 

6. Перенести файл dogovor1.txt в каталог DOG с именем itog.txt. 

7. Просмотреть содержимое файла itog.txt. 

8. Переименовать каталог DOG в DATA. 

9. Показать преподавателю выполненную работу. 

10. Удалить каталоги GRAND и DATA. 

11. На правой  панели вызвать диск А:. 

12. В корневом каталоге диска А: создать каталог с именем BLANK. 

13. В каталоге BLANK создать файл tab1.txt, содержащий текст: 

 ____________________________________________________________________ 

      1                                                     2                                                           3 

 ____________________________________________________________________       

     N                                                  дата                                                количество 

14. Скопировать файл tab1.txt в файл tab2.txt каталога BLANK. 

15. Проверить, есть ли в файле tab2.txt текст (если нет, повторить 4-й пункт). 
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16. Переименовать в каталоге BLANK файл tab2.txt в файл otchet.txt. 

17. Привести файл otchet.txt к следующему виду: 

ОТЧЕТ 

За III-й квартал 2002 г. 

____________________________________________________________________ 

      1                                                     2                                                           3 

_____________________________________________________________________       

     N                                                  дата                                                количество 

 

18. Вывести дерево каталога для диска А:. 

19. Не выходя из дерева каталогов, в корневом каталоге диска А: создать ка-

талог KONTORA. 

20. «Выйти» из дерева каталогов. 

21. Перенести каталог BLANK в каталог KONTORA. 

22. Скопировать из корневого каталога диска С: все файлы с расширением 

.doc в подкаталог BLANK. 

23. В каталоге BLANK выделить все файлы при помощи клавиши INS. 

24. Посмотреть сколько места на диске занимает суммарная длина файлов. 

25. Поместить выделенные файлы в архивный файл paper.rar, который будет 

находиться в каталоге BLANK одновременно уничтожив исходные фай-

лы. 
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Контрольные вопросы 

1. Что такое файловая система? 

2. Организация файловой системы? 

3. Какие файловые системы вы знаете? 

4. Назначение и принцип действия программ-оболочек. 

5. Порядок действий  при создании файлов и папок средствами программ-

оболочек. 

6. Порядок действий при копировании, переименовании файлов и папок сред-

ствами программ-оболочек. 

7. Порядок действий при удалении файлов и папок средствами программ-

оболочек. 

8. Методика работы с группами файлов и папок. 

9. Методика поиска файлов по какому-либо критерию. 

Контрольная работа 

Вариант №0 

1. В корневом каталоге диска С: создать каталог ORBITA. 
2. В каталоге ORBITA создать каталог KOSMOS. 
3. В каталоге ORBITA создать текстовый файл paloma.txt. 
4. Скопировать в каталоге ORBITA файл paloma.txt в файл stih.txt. 
5. Файлы каталога ORBITA скопировать в каталог KOSMOS. 
6. На диске А: создать каталог NEBO. 
7. Скопировать каталог KOSMOS в каталог NEBO. 
8. Переименовать в каталоге NEBO каталог  KOSMOS на LUNA. 
9. Осуществить на диске С: поиск файлов, начинающихся на букву «t», имеющих 

в расширении два символа. 

Тест самоконтроля знаний 

Вариант №0 

1. Файл – это: 
a) часть диска; 
b) поименованная область на диске; 
c) последовательность операторов и команд; 
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2. Для своего размещения файл требует: 
a) непрерывного пространства на диске; 
b) свободных кластеров в различных частях диска; 
c) Fat-таблицы; 

3. Для обозначения файлов используют: 
a) имена и расширения; 
b) команды операционной системы; 
c) имена кластеров; 

4. Шаблон имени и расширения файла — это: 
a) специальная форма, в которой в полях имени и расширений типа файла 
используются символы «+» и «-.»; 

b) специальная форма, в которой в полях имени и расширений типа файла 
используются символы «*» и «?»; 

c) специальная форма, в которой в полях имени и расширений типа файла 
используются символы «-» и «?»; 

5. Каталог — это: 

a) постоянная память; 

b) место хранения имен файлов; 

c) внешняя память длительного хранения; 

6. Для отображения краткой информации в окне необходимо нажать: 

a) Ctrl+F2; 

b) Ctrl+F1; 

c) Ctrl+F8; 

7. Для быстрого просмотра файла необходимо нажать: 

a) Ctrl+O; 

b) Alt+O; 

c) Ctrl+Q; 

8. В окне просмотра файлов можно: 

a) редактировать текст; 

b) только просматривать текст; 

c) просматривать и редактировать текст; 
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9. Для редактирования файла необходимо нажать: 

a) F4; 

b) F5; 

c) F3; 

10. В окне редактирования файлов можно: 

a) редактировать текст; 

b) только просматривать текст; 

c) просматривать и редактировать текст. 

Тема 7. Windows: диалог «человек-компьютер». 

Лекция: 

Основные характеристики и история создания. 

Первая графическая многооконная операционная оболочка Windows фир-

мы Microsoft появилась в 1986 г. После своего возникновения  она пережила 

ряд модификаций, но не все из них были удачными. Однако в 1991 г. вышла 

версия операционной среды Windows 3.1 и несколько позже сетевой вариант 

Windows 3.11 For WorkGroups, завоевавшие широкое признание миллионов 

пользователей.  Дальнейший ряд Windows-продуктов продолжили высокопро-

изводительные многозадачные, полнофункциональные операционные системы 

с графическим интерфейсом Windows 95, Windows 98, Windows 2000 для ком-

пьютеров платформы IBM PC. 

Основными характеристическими чертами операционной системы 

Windows 95 являются: 

1. Единый графический пользовательский интерфейс, который составляют ра-

бочий стол, окна, панель задач и другие графические объекты (кнопки, пик-

тограммы, списки и т.п.). 

2. Интегрированная операционная система, ядро которой загружается в момент 

включения компьютера, активизирует графический интерфейс пользователя 

и обеспечивает полную совместимость с операционной системой MS-DOS. 

3. Объектно-ориентированная система. 
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4. Программная совместимость обеспечение полной независимости программ 

от аппаратной части компьютера. 

5. Вытесняющая многозадачность - свойство операционной системы самостоя-

тельно в зависимости от внутренней ситуации передавать или забирать 

управление у того или иного приложения, не позволяющее одному прило-

жению занять все аппаратные ресурсы. 

6. 32-разрядная операционная система, поддерживающая 16-разрядные прило-

жения без всякой их модификации. 

7. Многопоточность - свойство операционной системы выполнять операции 

одновременно над потоками нескольких 32-битовых приложений. Поток - 

это некоторая часть процесса, который может быть выделено процессорное 

время для одновременного выполнения наряду с другими потоками.  

8. Сетевые возможности. Хотя ОС Windows предназначена для управления ав-

тономным компьютером, но также содержит все необходимые средства для 

создания небольшой локальной одноранговой сети: совместное использова-

ние ресурсов файлового сервера, принтеров, факс-модемов. Windows 95 

имеет средства для интеграции компьютера во всемирную сеть: использова-

ние электронной почты и других средств коммуникации. 

9. Средства обмена данными между приложениями: буфер обмена (Clipboard), 

технологии DDE (Dynamic Data Exchange), OLE (Object Linking and 

Embedding).   

10. Интерфейс мультимедиа, включает в себя лазерный проигрыватель (CD-

плеер), обеспечивает поддержку видеодисков и видеомагнитофонов и т.п. 

11. Поддержка длинных имен файлов и папок (до 255 символов). 

12. Использование технологии Plug and Play ("включи и работай") позволяет 

осуществляет функции распознания новых устройств для их установки и 

настройки, при этом обеспечивает динамическое изменение конфигурации 

системы и автоматического уведомления об этом программных приложе-

ний.  
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13. Реализация принципа WYSIWYG -What You See Is What You Get ("что ви-

дишь, то и получаешь"). Принцип реализуется при выводе на печать ин-

формации, полностью соответствующей изображению на экране. 

14. Технология AutoPlay позволяет автоматически озвучивать работу с Windows 

при установленных средствах мультимедиа. 

15. Режим MouseKeys позволяет все действия с мышью выполнять через кла-

виатуру). 

По сравнению с Windows 95, Windows 98 включает средства, позволяющие 

компьютеру работать быстрее без добавления нового оборудования. В состав 

Windows 98 входит ряд программ, совместное применение которых повышает 

производительность компьютера: 

− Служебные программы позволяют быстрее выполнять программы, прове-

рять жесткий диск на наличие ошибок и освобождать место на диске, обес-

печивать бесперебойную работу системы. 

− Проверка диска запускается автоматически после неверного выключения 

ОС. 

− Новый Web-узел ресурсов Microsoft Windows Update автоматизирует про-

цесс обновления драйверов и системных файлов и обеспечивает новейшие 

возможности технической поддержки. 

− Обозреватель Интернета Internet Explorer делает ряд функций доступными с 

рабочего стола Windows: каналы Web - узлов на рабочем столе, возможно-

сти поиска в Интернет, панели обозревателя. Приложение Internet Explorer 

объединяет рабочий стол  с Web, благодаря чему рабочий стол и его папки 

будут выглядеть и действовать так же, как при работе с Web. Такой рабочий 

стол называется Active Desktop. 

Главными новыми технологическими решениями, реализованных в 

Windows 2000, являются расширение сетевых возможностей и усовершенство-

вание функций защиту информации в сетях. Windows 2000 оснащена целым ря-

дом свойств управления клиентами и серверами, позволяющих снизить общую 

стоимость эксплуатации операционной системы. 
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Основные элементы графического интерфейса Windows. 

Задача интерфейса - сделать компьютер доступнее, понятнее для пользова-

теля.  

По замыслу разработчиков, общий вид монитора ассоциируется с видом 

обычного рабочего стола, на котором располагаются документы (окна, подоб-

ные листам бумаги).    

Рабочий стол (DeskTop) - все  пространство экрана в среде Windows с рас-

положенными на нем графическими объектами. 

Вдоль одной из границ (чаще в нижней части) рабочего стола находится 

панель задач. Панель задач содержит: 

− кнопку ПУСК - главное системное меню; 

− доступ ко всем открытым приложениям. При открытии приложения на па-

нели задач появляется соответствующая открытому окну кнопка. Нажатие 

этой кнопки позволяет быстро перейти в выбранное окно.  

− пиктограммы специальных "фоновых" приложений: часы, индикатор теку-

щей раскладки клавиатуры и др. 

Главное системное меню предназначено для быстрого запуска программ, 

поиска файлов, обеспечения доступа к справке, вызов панели управления для 

настройки компьютера и др. Меню содержит в себе несколько пунктов, при 

подведении указателя мыши на одном из пунктов автоматически открывается 

подменю для выбора нужной операции. 

1. Пункт Программа позволяет запускать программы.  

2. Пункт Документы содержит ярлыки 15 последних открывавшихся докумен-

тов.  

3. Пункт Избранное характерен для ActiveDesktop и позволяют осуществлять 

доступ к средствам всемирной сети. 

4. Пункт Настройка позволяет настраивать: панель задач, в том числе пункты 

главного меню; панель управления, доступ к которой также можно получить 

через папку Мой Компьютер; свойства папки Принтеры и др. 
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5. Пункт Найти позволяет осуществлять поиск папок и файлов на дисках ком-

пьютера, в локальной сети, в Интернет. Поиск можно осуществлять, используя 

маску файлов, дату создания файла, по типу файла, его размеру, поиск по тек-

сту. 

6.  Пункт Справка выводит справку по работе с Windows. 

7. Пункт Выполнить позволяет запускать программы на исполнение, при этом 

необходимо указать путь и имя запускаемого файла. 

8. Пункт Завершение работы необходим для корректного завершения работы с 

Windows, перезагрузки компьютера, перезагрузки с выходом в режим MS-DOS.  

На рабочем столе размещено несколько графических объектов - ярлыков. 

Ярлык - маленький файл-указатель, с помощью которого можно быстро 

получить доступ к объекту (файлу, каталогу, диску, программе). 

Ярлык представлен в виде значка (пиктограммы) и названия. Двойной 

щелчок по ярлыку открывает объект, с которым он связан. 

Основными объектами файловой структуры Windows являются файл, ка-

талог, ярлык.  С этими объектами можно проделывать следующие операции: 

создавать, переименовывать, удалять, копировать, перемещать и другие. В 

Windows, по аналогии с обычными терминами, принято называть каталог - пап-

кой, файл - документом. 

Изначально на Рабочем столе расположены значки «Мой компьютер», 

«Сетевое окружение», «Корзина» и «Портфель».   

 Мой компьютер отражает содержание всего компьютера целиком. Папка 

позволяет просмотреть содержимое находящихся на компьютере дисков, дос-

туп к панели управления, сетевому окружению. 

Сетевое Окружение - обеспечивает доступ к ресурсам сети, если к ней 

подключен компьютер. 

В Портфель, как и в обычный дорожный портфель, в котором носят нуж-

ные документы, помещают файлы и папки, с которыми пользователь работает 

на нескольких компьютерах: дома и на работе, на настольном и переносном 
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компьютере в дороге. Портфель содержит базу данных, позволяющую сопоста-

вить несколько вариантов одного документа и выбрать оптимальный.  

Корзина  - специальная папка, предназначена для временного хранения уда-

ленных файлов, папок, ярлыков. Она позволяет восстановить объекты, удаленные 

по ошибке. Размер корзины устанавливает пользователь. По мере работы следует 

регулярно очищать корзину, особенно когда возникают проблемы со свободным 

дисковым пространством.  

Структура окна в Windows. 

Окно - прямоугольная область экрана, в которой может отображаться прило-

жение, документ или сообщение. 

Окно может быть представлено в виде: свернутое на панель задач (миними-

зировано), нормальное (окно с обрамление), полноэкранное окно (распахнутое на 

весь экран). 

Любое окно Windows имеет ряд стандартных элементов.  

Системное меню содержит команды для изменения размеров окна, его пере-

мещения, минимизации, закрытия. 

Заголовок окна является удобным управляющим элементом для перемещения 

окна. В заголовке окно отображается название приложения и документа (имя от-

крытого файла). 

Строка меню содержит пункты для открытия ниспадающего меню. 

Контекстное меню (всплывающее меню) появляется при нажатии правой 

кнопки мыши и содержит активные команды для данного объекта.  

Рабочее поле окна представляет собой область для размещения окна доку-

мента, и которая будет пустой, пока ни один документ не открыт. 

Рамка окна - двойная линия, обрамляющая нормальное окно. Она служит 

управляющим элементом для изменения размеров окна.  

Линейки (полосы) прокрутки окаймляют левую и нижнюю стороны окна и 

служат для перемещения (прокрутки) документа по вертикали и горизонтали. 

Панели инструментов представляют собой линейки командных кнопок, пред-

назначенных для быстрого вызова той или иной команды мышью. 

Строка состояния  находится у нижнего края окна и содержит информацию о 
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режимах работы приложения. 

Виды окон 

1. Окно приложения представляют собой интерфейсы работающих приложе-

ний. Главным свойством окон приложений  является то, что они могут перекры-

вать друг друга и являются независимыми, т.е. не подчинены никакому другому 

окну. 

2. Окно документа  всегда подчинены окнам своих приложений и не выходят 

за их пределы. 

3. Диалоговое окно служит для ввода дополнительных параметров, необхо-

димых для выполнения какой-либо команды. 

Активное окно - окно приложения, реагирующее в данный момент на дейст-

вия пользователя. Заголовок активного окна отличается по цвету и яркости от не-

активного. 

Обмен данными между приложениями 

Передача фрагмента данных от одного документа в другой представляет со-

бой простейший способ обмена данными между приложениями. Выполняется эта 

операция через буфер обмена.  

Буфер обмена (Clipboard) – это специальным образом организованное дина-

мическое пространство оперативной памяти для временного размещения данных и 

сведения, к какому программному приложению они относятся. 

Для занесения информации в буфер обмена и ее извлечения оттуда имеются 

команды копировать, вырезать, вставить. 

Технология  DDE - динамический обмен данными.  

Технология DDE  опирается на связь, установленную между фрагментами 

одного документа, а также между документами различных приложений. Наличие 

такого механизма связи позволяет автоматически актуализировать данные в доку-

менте-приемнике при изменениях в источнике данных. 

Например, в файле - источнике (графическом редакторе) открывают файл ри-

сунка, фрагмент которого выделяется и копируется в буфер обмена. Предполага-

ется вставка этого фрагмента в файл-приемник (текстовый документ) в качестве 

иллюстраций.  При последующей команде вставка → объект → из файла фрагмент 
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визуально отображается в текстовом документе, при этом создается ссылка на 

файл-источник. Все изменения рисунка автоматически отображаются и в докумен-

те-приемнике. 

Технология OLE -связывание и встраивание объектов. 

Технология OLE опирается на связь, установленную между документом и 

приложением, а также на механизм, разработанный для связи приложений. Нали-

чие такого механизма позволяет перенести в выходной документ (файл-приемник 

- OLE-клиент) фрагмент или файл другого приложения (файл-источник - OLE - 

клиент), при этом он приобретает свойства встроенного или связанного объекта. 

При этом при обращении к встроенным данным (например, щелчок мыши) проис-

ходит автоматический того приложения, к которому они относятся. 

Лабораторные занятия 

Тема №1: Рабочий стол Windows. Работа с окнами 

Цель работы:   

 познакомиться с Рабочим столом, манипулятором «мышь»; 

 изучить элементы окна; 

 научиться создавать ярлыки на Рабочем столе различными способами, на-

страивать параметры Windows, очищать список документов в Главном ме-

ню, добавлять и удалять пункты в Главном меню. 

Задания к лабораторной работе: 

1. Познакомьтесь с элементами Рабочего стола: значками объектов Win-
dows и Панелью задач. 

2. Отработка приемов работы с мышью: 

− Выделить значок Мой компьютер. 

− Переместить значок в новое место Рабочего стола (Если перетаскивание не уда-
ется, то вызвать контекстное меню Рабочего стола отменить режим «Упорядо-
чивать» – «Автоматически»). 

− Вернуть значок на место. 

− Снять выделение со значка Мой компьютер. 

− Открыть Главное меню кнопкой Пуск. 

− Определить текущую дату, применив прием зависания к индикатору часов на 
Панели задач. 
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− Определить установленную раскладку клавиатуры, вызвав контекстное меню 
индикатора языка на Панели задач и выбрав в меню пункт Свойства. 

3. На Рабочем столе создать с помощью мастера ярлыки для приложений MS 

Word и MS Excel.  

4. Знакомство с элементами окна: 

− Открыть окно папки «Мой компьютер» и познакомиться с элементами окна. 

− Развернуть окно на весь экран; восстановить размер окна; свернуть окно; 

развернуть окно; закрыть окно. 

− Открыть окна папок «Мой компьютер» и «Корзина». 

− Изменить размеры окон таким образом, чтобы они не перекрывали друг дру-

га. 

− Закрыть окна. 

5. Установить шлейф для мыши. 

6. Включить заставку: ОБЪЕМНЫЙ ТЕКСТ, текст «ТУРИСТ», параметры: 

стиль движения «Волны», шрифт – Arial. 

7. Просмотреть предлагаемые рисунки и узоры Рабочего стола и устано-

вить наиболее понравившийся. 

8.  Установить новые свойства у Панели задач: 

− раскрыть окно свойств Панели задач вызвав ее контекстное меню и выбрав в 

меню пункт Свойства; 

− снять флажок отображения часов; 

− установить флажок Автоматически убирать с экрана; 

− проверить установленные свойства; 

− восстановить прежнее значение измененных свойств. 

9. Изучить свойства клавиатуры: 

− в Панели управления открыть окно Клавиатура; 

− установить комбинацию клавиш Ctrl+Shift для переключения между рус-

ским и английским языками; 

− отключить индикатор раскладки клавиатуры; 

− проверить установленные свойства;  
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− восстановить прежние значения свойств. 

10.  Изучить свойства Корзины: 

− раскрыть окно Свойства корзины; 

− выбрать закладку Глобальные; 

− изменить значения свойства Уничтожать файлы  сразу, не помещая их в корзи-

ну; 

− изменить значения свойства Запрашивать подтверждение на удаления; 

− проверить установленные свойства; 

− восстановить прежнее значение измененных свойств. 

11. Очистить список документов в Главном меню. 

12. Создать в Главном меню новый пункт, запускающий программу Блок-

нот. 

13. Удалить из Главного меню пункт Блокнот. 

Тема №2: Стандартные программы. Работа с папками и файлами 

Цель работы:   

 узнать назначение стандартных программ Windows; 

 научиться создавать, копировать, переименовывать, перемещать, удалять 

и восстанавливать папки и файлы. 

Задания к лабораторной работе: 

1. Записать в тетради перечень стандартных программ Windows. 

2. Записать в тетради назначение программы «Блокнот». 

3. Запустить программу «Блокнот». 

4. Ввести текст: «Текст вводится с помощью буквенно-цифровых клавиш. 

Для ввода прописных букв используется  одновременное нажатие клавиши 

Shift для ввода длинной последовательности прописных букв клавиатуру мож-

но переключить с помощью клавиши Caps Lock. Для переключения между рус-

скими и английскими символами используется индикатор языка на Панели за-

дач, или специальная комбинация клавиш, установленная на Вашем компьюте-

ре. Обычно это комбинация клавиш Alt+Shift или Ctrl+Shift.» 

5. Свернуть окно программы «Блокнот» на Панель задач. 



 75

6. Записать в тетради назначение программы WordPad. 

7. Запустить программу WordPad. 

8. Ввести текст: «Для выделения фрагмента текста необходимо нажать ле-

вую кнопку мыши на начале фрагмента и, удерживая ее, переместить указатель 

мыши в конец выделяемого фрагмента. Необходимый фрагмент выделится 

черным цветом». 

9. С набранным текстом проделать следующую работу: 

− Вставить набранный текст в конец документа два раза; 

− Выделить первый абзац и задать для него следующие параметры: шрифт – 

Arial, размер шрифта – 16, цвет шрифта – зеленый, тип шрифта – полужир-

ный курсив; 

− Выровнять первый абзац по левому краю, второй абзац – по центру, третий 

абзац – по правому краю. 

10. Свернуть окно программы WordPad на Панель задач. 

11. Записать в тетради назначение программы Paint. 

12. Запустить программу Paint. 

13.  Нарисовать следующий рисунок 

 
14. Свернуть окно программы Paint на Панель задач. 

15. Открыть папку «Мой компьютер» и перечислить находящиеся в ней объ-

екты. 

16. Изменить несколько раз размеры и расположение значков файлов и папок. 

17. На диске С: создать папки Филолог, Литература,Все . 

18. В папке Филолог создать папки Повесть, Рассказ, Роман. 

19. Развернуть программу «Блокнот» и сохранить текст с именем Записки 

в папке Повесть. 

20. Развернуть программу «WordPad» и сохранить текст с именем Тезис в 

папке Рассказ. 
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21. Развернуть программу «Paint» и сохранить рисунок с именем Разбор в 

папке Роман. 

22. Скопировать папку Филолог в папку Литература. 

23. Скопировать папку Литература на диск А:. 

24. Переместить на диске С: папку Литература в папку Филолог. 

25.  Переименовать на диске С: папку Литература на Все. 

26.  Удалить папку Все. 

27.  Восстановить папку Все. 

28.  Выделить папку Все и посмотреть, сколько места на диске она занима-

ет. Заархивировать папку Все в архив Общие.rar. 

29.  Сравнить занимаемое место на диске архивом Общие.rar с первоначаль-

ным объемом папки Все. На сколько уменьшился объем занимаемого места на 

диске? 

30.  Разархивировать архив Общие.rar. 

Тема №3: Программа «Поиск». Программа «Проводник» 

Цель работы: В результате выполнения лабораторной работы вы:  

 узнать назначение программ «Проводник» и «Поиск»; 

 научиться осуществлять поиск объектов по различным параметрам, рабо-

тать с программой «Проводник». 

Задания к лабораторной работе: 

1. Организовать поиск файлов по Имени и размещению: 

− найти на диске С: все файлы с расширением .tmp (*.tmp); 

− найти на диске С: все файлы с расширением .bmp (*.bmp); 

− найти все файлы с однобуквенными именами и расширениями (?.?); 

2. Организовать поиск файлов по Дате изменения: 

− найти на диске С: файлы, созданные с 1.10.2000 по сегодняшний день; 

− найти на диске С: файлы, созданные с 1.10.2004 по 15.07.2005; 

− найти на диске С: файлы, созданные за последний месяц; за последние два 

месяца; за последний день; за последние три дня; 

3. Используя вкладку Дополнительно найти файлы типа Точечный рисунок 
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BMP. На каком диске вы провели поиск? Полученный список файлов предста-

вить в виде таблицы и отсортировать его по размеру. Просмотреть самый 

большой рисунок. 

4. Найти на диске С: все текстовые файлы, содержащие слово «Windows». 

5. Найти на диске С: все Текстовые документы, содержащие слово 

«windows», но не  «Windows». Для этого необходимо отменить режим Пара-

метры → С учетом регистра. Открыть один из найденных файлов и найти в 

нем указанное слово. 

6. Запустить программу «Проводник». 

7. Измените Вид правой панели с помощью меню. 

8. Свернуть все папки, щелкая по значкам « – » на дереве папок в левой 

панели программы. 

9. Показать в правой части содержимое диска С: и при помощи контекст-

ного меню создать на диске С: папку Европа. 

10. Развернуть в правой части диск С: чтобы увидеть созданную папку. 

11. Открыть папку Европа в правой части Проводника. 

12. Создать в папке Европа папку Россия. 

13. В папке Россия создать текстовый документ Записки1 и точечный ри-

сунок Записки2. 

14. Правой кнопкой мыши переместить их в папку Европа. 

15. Скопировать файл Записки2 в папку Россия. 

Контрольные вопросы 

1. Что такое Рабочий стол? Какие объекты на нем находятся? 
2. Что такое ярлык? Методы создания ярлыков. 
3. Что такое окно? Перечислить основные элементы окна. 
4. Что такое «мышь»? 
5. Что такое Панель управления? 
6. Что такое Главное меню? 
7. Как очистить список документов в Главном меню? 
8. Как добавить и удалить новый пункт в Главное меню? 
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9. Назначение стандартных программ Windows.  
10. Как посмотреть содержимое папки?  
11. Как переименовать папку/файл (несколько способов)?  
12. Как скопировать папку/файл (несколько способов)?  
13. Как удалить папку/файл (несколько способов)?  
14. Как восстановить удаленный файл?  
15. Как переместить папку/файл (несколько способов)?  
16. Как запустить программу «Поиск»?  
17. Перечислить характеристики, по которым можно осуществить поиск.  
18. Как запустить программу «Проводник»?  
19. Назначение программы «Проводник».  
20. Рассказать о панелях «Проводника». 
21. Что означают символы «+» и «–» около имен папок в левой области 

«Проводника»? 

Контрольная работа  

1.  На диске С: создайте текстовый файл Сервис, содержащий следующий текст: 

«Сжатие информации — это процесс преобразования информации, хранящейся 

в файле, к виду, при котором уменьшается избыточность в ее представлении и 

соответственно требуется меньший объем памяти для хранения». 

2.  На диске С: создайте папку ТУРИСТЫ. 

3.  В этой папке создайте текстовой файл Отдых, содержащий следующий текст: 

«Архивный файл — это специальным образом организованный файл, содержа-

щий в себе один или несколько файлов в сжатом или несжатом виде и служеб-

ную информацию об именах файлов, дате и времени их создания или модифи-

кации, размерах и т.п.» 

4. В папке ТУРИСТЫ создать папку ОТЕЛЬ. 

5. В папке ОТЕЛЬ создайте текстовый документ Люкс, содержащий следующий 

текст: «Архивация (упаковка) — помещение (загрузка) исходных файлов в ар-

хивный файл в сжатом или несжатом виде». 

6. Для папки ТУРИСТЫ создать ярлык на Рабочем столе. 
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7. Открыть документ Сервис и добавить в него следующий текст: «Разархивация 

(распаковка) — процесс восстановления файлов из архива точно в таком виде, 

какой они имели до загрузки в архив. При распаковке файлы извлекаются из ар-

хива и помещаются на диск или в  оперативную память». 

8. Скопируйте документ Сервис в папку ОТЕЛЬ и переименовать его в файл Рек-

лама. 

Тест для самоконтроля знаний 

Вариант № 0 

1. Windows – это 

a) оболочка операционной системы; 

b) драйвер; 

c) операционная система; 

2. Панелью инструментов называется: 

a) панель, содержащая значки и кнопки, предназначенные для открытия нис-

падающего меню; 

b) панель, содержащая значки и кнопки, предназначенные для быстрого досту-

па к наиболее часто используемым командам приложения; 

c) панель, содержащая значки и кнопки, предназначенные для использования 

команд отсутствующих во всех видах меню; 

3. Какой интерфейс использует Windows? 

a) текстовый; 

b) программный; 

c) графический; 

4. Что такое программа «Поиск»? 

a) программа осуществляет быстрый поиск папок и файлов на компьютере; 

b) программа осуществляет поиск и удаление файлов на компьютере; 

c) программа не осуществляет поиск на компьютере; 

5. Главное меню предназначено для … 

a) быстрого запуска программ, поиска файлов, обеспечения доступа к справке; 

b) просмотра структуры папок и файлов; 

c) создания и удаления папок и файлов; 
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6. Окно – это: 

a) прямоугольная область экрана, в которой выполняется программа или выво-

дится содержимое папки; 

b) все пространство Рабочего стола; 

c) часть экрана, в которой выводятся диски, папки, сети; 

7. Проводник – это: 

a) программное средство Windows, предназначенное для управления файло-

вой системой, обеспечивающее  доступ к локальным и сетевым ресурсам; 

b) программное средство Windows, предназначенное для просмотра файлов; 

c) программное средство Windows, предназначенное для управления при-

ложениями и документами; 

8. Рабочий стол – это … 

a) полоса внизу экрана; 

b) все пространство экрана в среде Windows с расположенными на ней гра-

фическими объектами; 

c) все пространство экрана в среде Windows с расположенными на ней гра-

фическими и цифровыми объектами; 

9. Как запустить программу «Поиск»? 

a) Пуск → Программы → Поиск; 

b) Пуск → Программы → Стандартные → Поиск; 

c) Пуск → Поиск; 

10. Системное меню содержит: 

a) содержит команды для сохранения и удаления объектов; 

b) содержит команды, присущие только для данного объекта; 

c) содержит команды для изменения размеров окна. 

Тема 8. Word: форматирование различных текстов. 

Лекция: 

Основные функции текстовых редакторов заключаются в автоматизации 

ввода и редактирования текстовых данных. 

В отличие от текстовых редакторов, текстовые процессоры позволяют не 
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только вводить и редактировать текст, но и форматировать его, т.е. оформлять. 

Соответственно, к основным средствам текстовых процессоров относятся сред-

ства обеспечения взаимодействия текста, графики, таблиц и других объектов. 

Назначение настольных издательских систем состоит в автоматизации 

процесса верстки полиграфических изданий. 

Рассмотрим один из текстовых процессоров – Ms Word, который явля-

ется приложением Windows. 

Структура окна Word типична для приложений Windows. После уста-

новки программы в ней по умолчанию присутствуют две панели инструментов 

– Стандартная и Форматирование. Если в ходе работы возникает необходи-

мость в других панелях инструментов, их можно открыть и расположить вдоль 

любой границы окна или отдельно. 

Основные приемы работы в Word: 

1. Форматирование страниц. 

При форматировании страниц задают отступы и ориентацию бумаги. Для 

этого необходимо выбрать Файл → Параметры страницы. В появившемся окне 

Параметры страницы задаются поля (отступы) страницы и ориентация (книжная 

или альбомная). 

Для введения нумерации страниц в создаваемом документе необходимо вы-

брать Вставка → Номера страниц. В появившемся окне Номера страниц задается 

формат номеров страниц. Номера страниц проставляются в колонтитулах. 

Колонтитулы представляют собой одну или несколько строк, помещаемых в 

начале или конце каждой страницы документа. Для расстановки колонтитулов не-

обходимо выбрать Вид → Колонтитулы.  

Можно установить колонтитулы для первой страницы, а так же для четных 

и нечетных страниц. Для этого необходимо выбрать Файл → Параметры страни-

цы. В появившемся окне выбрать вкладку Источник бумаги и задать расположение 

колонтитулов. 

2. Форматирование шрифта. 

Для форматирования шрифта необходимо выбрать Формат → Шрифт. 
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В появившемся окне Шрифт задаются: размер (14 пт – деловой документ, 
12 пт – документ Internet, 8 пт - газета); название; интервал между буквами (уп-
лотненный, обычный, разреженный); цвет; параметры (жирный, курсив, под-
черкнутый и др.); анимация для вводимого текста. 

3. Форматирование абзаца. 

Для форматирования шрифта необходимо выбрать Формат → Абзац. 

В появившемся окне Абзац задаются отступы слева, справа; отступ для 

первой строки; межстрочный интервал; выравнивание текста (по ширине, по 

центру, по краям). 

Лабораторные занятия. 

Тема №1: Создание текстового документа. 

Цель работы:  

 изучить структуру окна MS Word; 

 приобрести практический опыт создания и сохранения документа. 

Задания к лабораторной работе: 

1. Запустить текстовый процессор MS Word. 

2. Изучить структуру окна редактора и назначение его основных элементов 

(строка заголовка; кнопки управления окном Свернуть, Развер-

нуть/Восстановить, Закрыть; строка меню; панели инструментов; линейка; 

рабочая область; полосы прокрутки; строка состояния; рамка). 

3. Набрать следующий текст с соблюдением вышеуказанных правил: 

Морфема – это самая маленькая значимая часть слова. Самая главная морфема – 

это корень, несущий основной смысл слова. Остальные морфемы, несущие «смысли-

ночки», — приставка, суффикс, окончание – называются аффиксами. 

Слово морфема ввел в науку ученый-лингвист Бодуэн де Куртенэ. Вы, конечно, 

помните, что он же дал звуку-смыслоразличителю имя – фонема. 

От слова морфема образовалось слово морфология. Это раздел грамматики, изу-

чающий, как изменяется слово.  

В России каждый человек имеет имя, отчество и фамилию. А в других странах у 

людей нет отчества, зато иногда бывает по два имени (и даже больше). Например, ве-

ликого австрийского композитора Моцарта звали Вольфганг Амадей, а известного 
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комического актера кино Чаплина — Чарльзом Спенсером. 

А теперь вспомните сами, какие имена носил всеми любимый сказочник Андер-

сен (Ганс Христиан). Как у людей бывают вторые имена, так у некоторых морфем 

бывают вторые названия. 

4. Сохранить документ с именем «Морфема». 

5. Завершить работу с MS Word. 

Тема №2: Форматирование текстов. 

Цель работы: 

 отработать основные приемы ввода и редактирования текста; 

 научиться вставлять номера страниц и колонтитулы в документ; осущест-

влять поиск и замену, проверку орфографии. 

 приобрести навыки вставки рисунков и картинок; работы с объектами 

WordArt; 

 познакомиться с Буквицей и эффектами анимации. 

Задания к лабораторной работе: 

1. Загрузить MS Word. 

2. Установить поля станицы: верхнее – 2 см, нижнее – 2 см, левое – 3 см, 

правое – 1 см. 

3. Напечатать следующий текст без форматирования символов: 

Тема – объективная основа произведения 
В «бесконечном лабиринте сцеплений», в многоуровневом поэтическом космосе 

художественного целого все образующие его элементы подчинены друг другу, иерар-
хически упорядочены. Как и любая система, литературное произведение имеет свой 
центр (один или несколько) и свою периферию. Ядром художественной системы, ее 
признанным «руководящим центром» принято считать так называемое идейно-
тематическое содержание. Неразрывное единство темы и идеи составляет экстракт 
объекта и субъекта творчества, предмета искусства и его авторского осознания, рас-
пространяющий свое влияние на все остальные элементы системы. 

Художественный космос литературного произведения сродни государственному 
устройству. Он может напоминать и монархию (чаще всего), как абсолютную, так и 
конституционную, и олигархию, и демократию, и партократию, и охлократию, и фе-
дерацию, и конфедерацию… Наверное, только не анархию, ибо основным цементи-
рующим принципом построения произведения является принцип художественной це-
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лесообразности, т.е. строгий порядок. 
Обрусевшее древнегреческое слово thema обозначает буквально «то, что поло-

жено» (в основу чего-либо). Тема – объективная основа произведения, понятие, ука-
зывающее самых общих чертах на преимущественное внимание писателя к опреде-
ленной стороне действительности и отвечающее на вопрос «Что изображено?». 
Внешним образом тема – это то, о чем произведение, чему оно посвящено, что преж-
де всего бросается нам в глаза. 

Писатель не может и не должен замахиваться на отображение всей реальной 
действительности, которая его окружает. Он сосредоточивается на некой ее части, со-
вершив первый этап своего творческого акта – художественный отбор. Категория те-
мы, следовательно, помогает определить то, что непосредственно изображено в про-
изведении, сориентироваться в его содержании, очертить круг жизненных явлений, 
отобранных, отображенных и воспроизведенных автором. 

Иногда приходится сталкиваться с весьма распространенным отождествлением 
темы и проблемы, вернее – с подменой одного понятия другим. Именно так трактовал 
тему в своем популярном учебнике по введению в литературоведение Г.Л. Абрамо-
вич. Предложенное им определение «Тема – проблема, поставленная писателем в 
произведении» вызывает сомнение по крайней мере в двух аспектах. 

Во-первых, тема и проблема совпадают только частично. Понятие темы значи-
тельно шире понятия проблемы. Та или иная проблема (нравственная, социально-
политическая, философская, религиозная) может стать темой лишь в произведениях 
соответствующего масштаба и предназначения (в романах, повестях, трагедиях, ко-
медиях, драмах, поэмах). 

Во-вторых, понятие проблемы не должно подменять собой понятие темы, по-
скольку в нем нередко содержится, кроме объективной констатации того или иного 
жизненного факта, и субъективно, личностно окрашенное отношение к нему писате-
ля, т.е. некоторый отблеск идеи. 

Итак, тема есть проблема, явление или предмет, отобранный, осмысленный, до-
мысленный и воспроизведенный определенными художественными средствами; 
часть действительности или ее аналог, уже преображенные в перл создания. 

4. Отформатировать 1 абзац: шрифт – Arial, размер – 24, видоизменение слов 

«идейно-тематическое содержание» – К, интервал после – 16 пт, межстрочный ин-

тервал – одинарный, выравнивание – по центру, цвет шрифта – красный, перед аб-

зацем вставить символ - . 

5. Отформатировать 2 абзац: шрифт – Book Antiqua, размер – 15, видоизме-

нение слов «государственному устройству» – подчеркнутый, отступ слева – 1,5 см, 
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отступ справа – 1 см, отступ первой строки – 1,25 см, интервал перед – 3 пт, ин-

тервал после – 8 пт, межстрочный интервал – полуторный, выравнивание – по ле-

вому краю, цвет шрифта – зеленый. 

6. Отформатировать 3 абзац: шрифт – Monotype Corsiva, размер - 20, видоиз-

менение слов «thema», «то, что положено», «в основу чего-либо», «то, о чем», 

«чему оно посвящено» – К, отступ слева – 1 см, отступ справа – 1 см, отступ пер-

вой строки – 1,27 см, межстрочный интервал – двойной, выравнивание – по пра-

вому краю, цвет шрифта – синий, разбить на две колонки. 

7. Отформатировать 4 и 5 абзацы: видоизменение слов «тема и проблема 

совпадают только частично», «понятие проблемы не должно подменять собой по-

нятие темы» – К. 

8. Отформатировать 8 абзац: шрифт – Times New Roman, размер – 16, видо-

изменение слов «тема», «проблема», «явление», «предмет» – Ж, отступ слева – 0 

см, отступ справа – 0 см, отступ первой строки – 1,5 см, межстрочный интервал – 

двойной, выравнивание – по ширине, цвет шрифта – синий. 

9. Отформатировать заголовок документа: начертание – ЖК, отступ перед – 

Авто, отступ после – Авто, размер – 30, цвет – желтый. 

10. Скопировать первые два абзаца в конец документа и разбить скопирован-

ный текст следующим образом: одно предложение – один абзац. 

11. Автоматически пронумеровать страницы документа: номер на первой 

странице не ставить, выравнивание от центра, внизу. 

12. Вставить в документ колонтитул: верхний колонтитул – ФИО, выравнива-

ние – по правому краю, нижний – автоматическая вставка даты создания докумен-

та, выравнивание – по центру. 

13. Проверить документ на наличие орфографических ошибок. 

14. Установить автоматическую расстановку переносов. 

15. Вставить из Коллекции картинок любую из понравившихся. 

16. Изобразить следующий заголовок с помощью инструмента Word Art: 



 86

 
17. Изобразить следующую надпись к заголовку: 

 
18. Отредактировать рисунок следующим образом: 

 
19. Набрать следующий текст: 
Слово, как известно, является основной единицей языка, самым заметным эле-

ментом его художественных средств. И выразительность речи связана прежде всего 
со словом. Многие слова обладают способностью употребляться в нескольких значе-
ниях. Это их свойство называется многозначностью, или полисемией. Писатели нахо-
дят в многозначности источник яркой эмоциональности, живости речи. Например, в 
тексте может быть повторено многозначное слово, которое, однако, выступает в раз-
ных значениях: Поэт издалека заводит речь, поэта далеко заводит речь (М. Цветаева). 

20. Установить для первой буквы первого слова абзаца буквицу: шрифт – 
Arial, положение – в тексте, высота в строках – 5. 

21.  Вставить перед текстом (задание 7) заголовок «Лексические средства вы-
разительности речи» и установить для него эффект «Мигающий фон». 

 Заголовок текста 
изменен 

 

Заголовок текста 
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22. Сохранить документ с именем «Тема». 
Тема №3: Создание таблиц и схем. 
Цель работы:  
 приобрести навыки работы с табличной информацией в среде текстового 
процессора MS Word; 

 научиться проектировать, составлять и редактировать таблицы; 
 приобрести навыки создания и редактирования схем. 
Задания к лабораторной работе: 
1. Вставить таблицу любым из перечисленных способов, содержащую 10 

строк и 9 столбцов. 
2. Объединить ячейки следующим образом: 

 
3. Вставить перед таблицей заголовок «Согласные звуки русского языка»: 

шрифт – Monotype Corsiva, размер – 16, начертание - Полужирный курсив. 
4. Заполнить таблицу следующим образом. Обратите внимание на выравни-

вание текста в ячейках таблицы. 
Место образования 

губные переднеязычные средне-
язычные 

задненебные Способ образо-
вания губно-

губные 
губно-
зубные

зубные передне-
небные 

средне-
небные 

средне-
небные 

задне-
небные 

ф в 
Ф’ в’ 

c з 
с’ з’ 

ш ж 
ш’ ж’ 

 х’ у’ х у 
срединные 

   jָ j   

Щ
ел
ев
ы
е 

боковые 
лָ л 
лָ’ л’ 

 

носовые мָ м 
мָ’ м’ 

нָ н 
нָ’ н’ 

 нг 

дрожащие рָ р 
рָ’ р’  

 

взрывные п б 
п’ б’ 

т д 
т’ д’ 

 к’ г’ к г 

С
мы

чн
ы
е 

аффрикаты ц дз 
ц’ д’з’ 

ч дж 
ч’ д’ж’ 
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5. Оформить таблицу следующим образом. 

 
6. Изобразить следующий объект. Самостоятельно задать цветовую гамму 

его элементам. 

 

 

Тема №4: Списки, стили, оглавления. 

Цель работы:  

 научиться создавать и форматировать списки-перечисления; 

 приобрести навыки создания нового стиля; 

 научится вставлять в документ оглавление. 

Задания к лабораторной работе: 

1. Набрать следующий перечень (каждое слово на новой строке): сущест-

 

Зеленый 

Желтый 

Серый 
Оранжевый 

Цвет внутренней линии и рамки - синий 

Речь 

1 предложение 3 предложение 
2 предложение 

слово

слово

слово

слово слово

слово

слово

слово

слово
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вительное, прилагательное, наречие, глагол. Выделить текст и оформить его в 

виде Нумерованного списка с помощью кнопки . 

2. Набрать следующий перечень (каждое слово на новой строке): Пушкин, 

Лермонтов, Некрасов, Толстой. Выделить текст и оформите его в виде Марки-

рованного списка с помощью кнопки . 

3. Изменить нумерованный список: нумерация начинается с 5,  нумерация 

– один, два, ….  

4. Изменить маркированный список: знак маркера – . 

5. Набрать следующий текст без соблюдения начертания (каждая фраза с но-

вой строки): Введение в информатику, Краткая история развития информаци-

онных технологий, Введение, Информация, Понятие информации, Информаци-

онные системы, Системы счисления, Понятие системы счисления, Непозиционные 

системы счисления, Позиционные системы счисления, Представление информа-

ции в компьютере, Общие сведения, Формы и коды представления данных в па-

мяти ЭВМ, Технические средства информационных технологий, Компьютер, 

Базовая структура персонального компьютера, Устройства ввода-вывода, Про-

граммное обеспечение компьютера, Компьютерные сети, Локальные компью-

терные сети, Глобальные компьютерные сети. 

6. Создать следующий многоуровневый список: 

− Уровень 1: Формат номера – Глава, нумерация – 1, 2, 3 ..., начать с – 1; По-

ложение номера: Выравнивание – по левому краю; Отступ – 0,5 см; От но-

мера до текста – 0 см. Шрифт – Полужирный. 

− Уровень 2: Формат номера – 1.1., нумерация – 1, 2, 3 ..., начать с – 1; Поло-

жение номера: Выравнивание – по левому краю; Отступ – 1 см; Шрифт – 

Обычный. 

− Уровень 3: Формат номера – 1.1.1., нумерация – 1, 2, 3 ..., начать с – 1; По-

ложение номера: Выравнивание – по левому краю; Отступ – 1,5 см; Шрифт – 

Курсив.  

7. Применить к набранному тексту созданный список следующим образом: 

первая трока – заголовок текста (выравнивание – От центра, начертание – По-
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лужирный курсив); текст, выделенный жирным шрифтом – Уровень 1; под-

черкнутый текст – Уровень 2; текст, выделенный курсивом – Уровень 3.  

8. Набрать следующий текст: 

А. Пушкин  
Тиха украинская ночь. Прозрачно небо,  
Звезды блещут. 
Своей дремоты превозмочь 
Не хочет воздух. 
Я. Некрасов 
Быстро лечу я по рельсам чугунным, 
Думаю думу свою. 
Б. Пастернак 
Мело, мело по всей земле во все пределы. 
Свеча горела на столе, свеча горела. 
М. Лермонтов 
Горные вершины спят во тьме ночной. 
Тихие долины полны свежей мглой. 
С. Маршак 
Вокруг белеющих прудов 
Кусты в пушистых полушубках, 
И проволока проводов 
Таится в белоснежных трубках. 
9. Применить стиль Заголовок1 к фамилиям А. Пушкин, Я. Некрасов, Б. Пас-

тернак. 

10. Создать новый стиль: имя – Поэт, основа на стиле – Заголовок1, стиль 

следующего абзаца – обычный. Форматирование: шрифт – Monotype Corsiva, раз-

мер – 14, начертание - Полужирный курсив, выравнивание – От центра, межстроч-

ный интервал – двойной. 

11. Применить стиль Поэт к фамилиям М. Лермонтов, С. Маршак. 

12. Разбить текст на страницы таким образом, чтобы каждый автор начинался 

на новой странице. 

13. На последней странице вставить оглавление. 

14. Сохранить документ с именем «Стили». 

Тема №5: Язык и статистика: редактирование формул. 

Цель работы:  

 приобрести навыки работы с редактором формул Microsoft Equation. 
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Задания к лабораторной работе: 
1. Вставить в документ формулы согласно варианту, указанному преподава-

телем. 
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2. Отредактировать формулу. Изменить размер. 

3. Сохранить документ с именем «Формула». 

Контрольные вопросы 

1. Назначение текстового процессора MS Word. 
2. Структура окна MS Word и назначение его основных элементов. 
3. Создание, открытие, сохранение документа. 
4. Как установить поля страницы в документе? 

5. Каким образом вставить номера страниц в документ? 

6. Как расставить переносы в документе? 

7. Что такое колонтитул? Каким образом он устанавливается? 

8. Как разбить текст на колонки, страницы, раздел? 

9. Как осуществить поиск и замену в документе? 

10. Как осуществить проверку орфографии в документе? 

11. Как форматируется текст в колонтитулах? 

12. Как добавить в текст надпись? 

13. Что такое Буквица и как ее установить? 

14. Как вставить объект WordArt? 

15. Понятие таблицы. Ее структура. 

16. Способы создания таблиц. Редактирование структуры таблицы. 

17. Основные элементы форматирования таблицы. 

18. Какими способами можно создать список для выделенного текста? 

19. Понятие стиля. Как создать новый стиль? Изменение стилей. 
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20. Как вставить в документ оглавление? 

21. Запуск редактора формул. 

22. Выход из редактора формул и последующее редактирование формулы. 

23. Порядок создания математических формул. 

Контрольная  работа 

− Все задания делать на отдельной странице.  

− Каждая страница должна начинаться с заголовка «Задание № …», оформ-

ленного стилем Заголовок2. 

− Проставить номера страниц: вверху страницы, справа, номер на первой 

странице не ставить. Расставить колонтитулы: на первой странице – Кон-

трольная работа, на четной странице – ваша фамилия, на нечетной странице 

– «Документ Word».  

− В конце документа вставить оглавление. 

1. Напечатать приведенный ниже текст, выполняя задания: 

ЛЕКСИЧЕСКИЕ СРЕДСТВА ВЫРАЗИТЕЛЬНОСТИ РЕЧИ 
Лексика, несомненно, занимает центральное место в системе образных средств 

языка. 

Слово, как известно, является основной единицей языка, самым заметным эле-

ментом его художественных средств. Выразительность речи связана прежде всего со 

словом. Многие слова обладают способностью употребляться в нескольких значени-

ях. Это их свойство называется многозначностью, или полисемией. 

Писатели находят в многозначности источник яркой эмоциональности, живо-

сти речи. Например, в тексте может быть повторено многозначное слово, которое, 

однако, выступает в разных значениях: Поэт издалека заводит речь, поэта далеко за-

водит речь (М. Цветаева). 

Задание: 

 Заголовок выровнен по центру, шрифт – Monotype Corsiva, размер – 14, 

начертание – Полужирный. Все буквы прописные. 

 Основной текст выровнен по ширине, шрифт – Arial, размер – 12. 

 Разбить второй абзац на шесть колонок, а третий – на восемь. 
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2. Создать приведенный ниже многоуровневый список, соблюдая все элементы 

форматирования: 

Программирование на Visual Basic. 

Введение 

Урок 1. Основные элементы языка 

I.1.   Первая программа 

I.2.   Типы данных 

  ♥ Константы 

  ♥ Переменные величины 

I.3.   Операции и выражения 

  ♥ Оператор присваивания 

  ♥ Арифметические операции и выражения 

Урок 2. Управляющие операторы 

II.1.  Логические операторы 

II.2.  Операторы цикла 

 ♥ Оператор For…Next 

 ♥ Оператор While 

 ♥ Оператор Do 

Урок 3. Массивы и пользовательские типы данных 

3. Создать следующую таблицу, выполнить задания: 

Примерный план предмета «Логика» 

Количество учебных часов Код 
темы Наименование тем 

Всего Практических 
занятий 

1 2 3 4 
1 Предмет и назначение логики. Логика и язык 2 
2 Основные логические законы 2 нет 

3 Понятие. Логические операции с понятиями 6 2 
4 Суждение. Модальность суждений 4 нет 
5 Дедуктивные умозаключения 6 2 
6 Индуктивные умозаключения 2 
7 Аналогия и гипотеза 2 нет 

8 Логические основы аргументации 6 2 

Задание: 
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 Для заголовка таблицы создать стиль ЛОГИКА с параметрами: Имя – 

ЛОГИКА, Стиль – Абзаца, Основан на стиле – Обычный, Стиль следую-

щего абзаца – Обычный; Формат: Шрифт – Arial, курсив, размер – 14, 

цвет – зеленый, подчеркивание – пунктирное. Абзац: выравнивание по 

центру, выступ – 3 см, межстрочный интервал – одинарный, перед – 12, 

после – 12. 

 Текст таблицы – шрифт №16. 

 Заливка первой строки – серый 30%, второй – голубой. Цвет заливки яче-

ек с порядковыми номерами – желтый. 

4. Создать приведенные ниже формулы: 
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5. Создать следующую надпись, используя объекты рисования и WordArt: 

 

 

Внимание! 
 

Горящие путевки в дет-
ский оздоровительный ла-
герь «КОЛОСОК». 

Спешите, количество 
ограничено. 

 
 

Справки по тел. 
    123-45-67 

Внимание 
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Тест самоконтроля знаний 

Вариант №0 
1. Команды открытия и сохранения файла находятся в пункте меню: 

a) Файл; 
b) Правка; 
c) Формат; 

2. Колонтитул – это... 
a) граница текста; 
b) строки текста, печатаемые на всех полях страницы; 
c) строки текста, печатаемые на верхних и нижних полях страницы; 

3. Для организации таблицы следует выполнить команду ... и указать число 
строк, столбцов: 

a) Вставка → Таблица; 

b) Таблица → Нарисовать; 

c) Таблица → Добавить; 
4. Для обозначения конца абзаца используется клавиша: 

a) Enter 
b) Shift+Enter 
c) Ctrl+Enter 

5. Поместить в документ рисунок можно при помощи пункта меню: 
a)  Вид; 
b)  Сервис; 
c)  Вставка; 

6. Какая команда помещает выделенный фрагмент текста в буфер обмена без 
удаления: 

a) Копировать; 
b) Вырезать; 
c) Вставить; 

7. С помощью какого элемента можно вставить объект WordArt: 

a) 1; 
b) 2; 
c) 3; 
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8. Копирование выделенного абзаца выполняется так: 

a) Правка→ Копировать; 

b) Формат→Абзац→Копировать; 

c) Абзац→Копировать; 

9. Заменить одно слово на другое можно командой: 

a) Сервис → Правописание → Заменить; 

b) Правка → Правописание → Заменить; 

c) Правка → Заменить; 

10. Для ввода степени числа используют: 

a) шрифт маленького размера; 

b) вставку специального символа; 

c) верхний индекс. 

Тема 9. Excel: частотный и графический анализ данных. 

Лекция: 

Электронная таблица (ЭТ) – компьютерный эквивалент обычной табли-

цы, в клетках (ячейках) которой записаны данные различных типов: тексты, да-

ты, формулы, числа. 

Для управления ЭТ используется табличный процессор. 

Рабочая область ЭТ состоит из строк и столбцов, имеющих свои имена. 

Имена строк – это их номера. Нумерация строк начинается с 1 и заканчивается 

максимальным числом, установленным для данной программы. Имена столб-

цов – это буквы латинского алфавита сначала от А до Z, затем от АА до AZ, BA 

до BZ и т. д. 

Пересечение строки и столбца образует ячейку таблицы, имеющую свой 

уникальный адрес. Для указания адресов ячеек в формулах используются ссыл-

ки (например, А2 или С4). 

В ЭТ существует понятие блока (диапазона) ячеек. Блок ячеек – группа 

последовательных ячеек, может состоять из одной ячейки, строки (или ее час-

ти), столбца (или его части), а также последовательности строк или столбцов 

(или их частей). Адрес блока ячеек задается указанием ссылок первой и по-
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следней его ячеек, между которыми ставится разделительный символ – двоето-

чие <:> или две точки подряд <..>. 

Пример. G3, A1:H1, B1:B10, D4:F5. 

Каждая команда ЭТ требует указания блока (диапазона) ячеек, в отношении 

которых она должна быть выполнена. 

Блок используемых ячеек может быть указан двумя путями: либо непосред-

ственным набором с клавиатуры начального и конечного адресов ячеек, форми-

рующих диапазон, либо выделением соответствующей части таблицы при помощи 

клавиш управления курсором. Удобнее задавать диапазон выделением ячеек. 

Текущей (активной) называется ячейка ЭТ, в которой в данный момент на-

ходится курсор. Адрес и содержимое текущей ячейки выводятся в строке ввода 

ЭТ. 

Каждый документ представляет собой набор таблиц – рабочую книгу, кото-

рая состоит из одного или многих рабочих листов. 

В каждую ячейку ЭТ пользователь может ввести данные одного из следую-

щих типов: 

 
Формулы – это выражения, состоящие из числовых величин, адресов яче-

ек и функций, соединенных знаками арифметических операций. Написание 

формулы начинается со знака равенства (=). 

Пример. =(А1+В1)/С2. 

При копировании или перемещении формулы необходимо организовать 

управление формированием адресов исходных данных. Для этого при написа-

нии формул используются понятия относительной и абсолютной ссылок. 

Типы данных 

Символьные 
(текстовые) 
данные имеют 
описательный 
характер. Они 
могут включать 
в себя алфавит-
ные, числовые и 
специальные 
символы. 

Числовые данные 
не могут содер-
жать алфавитных и 
специальных сим-
волов, поскольку с 
ними производят 
математические 
операции 

Формулы – могут 
включать ряд 
арифметических, 
логических и про-
чих действий, про-
изводимых с дан-
ными из других 
ячеек. 

Даты Функции представляют 
собой программы с уни-
кальным именем (част-
ный случай формулы). 
Различают статистиче-
ские, логические, финан-
совые и др. функции. 
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Абсолютная ссылка – это не изменяющийся при копировании и переме-

щении формулы адрес ячейки, содержащий исходное данное.  

Для указания абсолютной адресации вводится символ $. Различают два типа 

абсолютной ссылки: полная и частичная. 

Полная абсолютная ссылка указывается, если при копировании или переме-

щении адрес клетки, содержащий исходное данное, не меняется. Для этого символ 

$ ставится перед наименованием столбца и номером строки. 

Пример. $B$5; $D$12 

Частичная абсолютная ссылка указывается, если при копировании или пе-

ремещении не меняется номер строки или наименование столбца. При этом сим-

вол $ ставится перед номером строки, а во втором случае – перед наименованием 

столбца. 

Пример. B$5; D$12; $B5; $D12 

При абсолютной адресации копируемая формула не изменяется. 

Относительная ссылка – это изменяющийся при копировании и перемеще-

нии формулы адрес ячейки, содержащий исходное данное. Изменение адреса про-

исходит по правилу относительной ориентации клетки с исходной формулой и 

клеток с данными. 

Пример: В ячейку С1 занесена формула =A$1+$B2. Перенести эту формулу 

в ячейки D2, E4. 

 
Функция представляет собой программу с уникальным именем, для кото-

рой пользователь должен задать конкретные значения аргументов, стоящих в 

скобках после ее имени. 

Функция имеет синтаксис написания: начинается с указания имени функ-

ции, затем вводится открывающаяся скобка, указываются аргументы, отде-

ляющиеся «;», а затем – закрывающаяся скобка. 

Рассмотрим синтаксис и примеры задания наиболее используемых функ-
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ций. 

6. Логические функции. 

Логические функции предназначены для проверки выполнения условия 

или для проверки нескольких условий. 

− ЕСЛИ используется для условной проверки значений и формул. Возвращает 

одно значение, если заданное условие при вычислении дает значение 

ИСТИНА, и другое значение, если ЛОЖЬ. 

Синтаксис: 

ЕСЛИ(лог_выражение;значение_если_истина;значение_если_ложь) 

Пример. ЕСЛИ(А10>В1;В5/В1;10) 

7. Статистические функции. 

Синтаксические функции позволяют выполнять статистический анализ диа-

пазонов данных. 

− СРЗНАЧ возвращает среднее арифметическое значение своих аргументов. 

Синтаксис: СРЗНАЧ(число1;число2;…), 

где число1, число2, … - это от 1 до 30 аргументов, для которых вычисляется 

среднее значение. 

Пример. Если ячейки А1:А5 содержат числа 10, 7, 9, 27 и 2, то 

СРЗНАЧ(А1:А5) равняется 11. 

− СЧЕТ подсчитывает количество чисел в списке аргументов, используется для 

получения количества числовых ячеек в интервалах или массивах ячеек. 

Синтаксис: СЧЕТ(значение1;значение2;…). 

Пример. Если ячейки А1:А7 содержат числа, то СЧЕТ(А1:А7) возвращает 

число 7. 

− МАКС возвращает наибольшее значение из набора значений. 

Синтаксис: МАКС(число1;число2;…). 

Пример. Если ячейки А1:А5 содержат числа 10, 7, 9, 27 и 2, то 

МАКС(А1:А5) равняется 27. 

− МИН возвращает наименьшее значение из набора значений. 

Синтаксис: МИН(число1;число2;…). 

Пример. Если ячейки А1:А5 содержат числа 10, 7, 9, 27 и 2, то МИН(А1:А5) 
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равняется 2. 

8. Арифметические и тригонометрические функции. 

Арифметические и тригонометрические функции позволяют производить 

простые и сложные математические вычисления. 

− СУММ суммирует все числа в интервале ячеек. 

Синтаксис: СУММ(число1;число2;…). 

Пример. Если ячейки А2:Е5 содержат числа 5, 15, 30, 40 и 50, то 

СУММ(А2:Е5) равняется 50. 

ЭТ располагает рядом команд для построения различных типов диа-

грамм: круговая диаграмма, линейный график и т. д. 

Лабораторные занятия: 

Тема №1: Знакомство с электронной таблицей   

Цель работы: 

 изучить структуру окна MS Excel; 

 приобрести практический опыт создания и сохранения таблицы. 

Задания к лабораторной работе: 

1. Запустить табличный процессор MS Excel.  

2. Выделить: 

− Строки 5, 6, 9, 13. Снять выделение. 

− Столбцы В, C, F, G, K. Снять выделение. 

− Совокупность строк 1, 3, 6, 7, 10, 11 и столбцов B, D, G, H, I.  Снять выделение.  

− Блок ячеек B5: F10. 

− Совокупность блоков A1:C4, B6:E12, G8:H10. 

3. Вставьте два новых листа перед рабочим листом Лист3, используя оба 

способа.  
4. Переименовать Лист1 в Глагол; Лист2 в Наречие. 

5. Поменять местами листы Глагол и Наречие.  

6. Создать копии рабочих листов Глагол и Наречие.  

7. Удалить копии листов Глагол и Наречие.  
8. Сохранить рабочую книгу с именем «Части речи». 
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Тема №2: Создание простейшей таблицы. Ввод и редактирование данных. 

Формат данных.  

Цель работы: 

 изучить особенности работы с данными в ячейках электронной таблицы; 

 приобрести навыки работы с диапазонами ячеек; 

 изучить форматы данных и их параметры. 

Задания к лабораторной работе: 

1. В ячейку А1 внести слово Литература. 

2. Создайте ниже приведенную таблицу. 

№ п/п ФИО Дата рождения Век 
 Пушкин А.С. 6.06.1799  
 Гоголь Н.Ф. 1.04.1809  
 Лермонтов М.Ю. 3.10.1814  
 Толстой Л.Н. 28.08.1828  
 Блок А.А. 28.11.1880  
 Маяковский В.В. 7.07.1893  
 Чернышевский Н.Г. 24.07.1829  
 Горький А.М.  16.03.1868  
 Достоевский Ф.М. 11.11.1821  

3. С помощью автозаполнения заполнить первый столбец таблицы таким об-

разом: 1 автор, 2 автор, 3 автор и т.д.  

4. Самостоятельно определить век, в котором родился каждый автор, и запол-

нить соответствующий столбец. 

5. Отредактировать в ячейке А1 слово Литература на Русская литература.  

6. После четвертой строки вставить пустую строку и заполнить ее таким об-

разом: ФИО – Цветаева М.И., Дата рождения – 26.09.1892. 

7. Вставить между столбцами ФИО и Год рождения новый столбец – Произ-

ведение и заполнить его самостоятельно. 

8. В столбце Дата рождения изменить формат представления информации на 

Дата, обозначение – 6 марта 1982 г (пример).  

9. Сохранить документ с именем «Таблица». 

Тема №3: Адресация. Вычисления в таблицах. 

Цель работы: 

 освоить построение формул с использованием абсолютного, относительного 

и смешанного стилей ссылок изучите; 
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 изучить возможности применения формул для выполнения расчетов при 

представлении данных в табличном виде; 

 приобрести опыт работы с мастером функций MS Excel. 

Задания к лабораторной работе: 

1. В одном из опытов изучались частоты частей речи в прозе К. Федина. Бы-

ло взято 10 выборок по 500 знаменательных слов каждая. В выборки включалась 

только авторская художественная речь. Были получены следующие выборочные 

частоты имен существительных и имен прилагательных: 

Проза К.Федина 

Частоты выборок (xi) 
Части речи 

1 2 3 4 5 6 7 8 9 10 

Ср. 
частота

Существительное 182 187 218 173 158 201 222 233 213 194  

Прилагательное 69 71 83 60 43 73 72 59 69 71  

Глагол 95 87 94 104 100 112 83 91 105 108  

− На Листе1 создать приведенную выше таблицу. 

− Переименовать Лист1 в Средняя. 

− Найти среднюю частоту выборки для каждой части речи по формуле 

n

x
x

n

i
i∑

== 1 , где n – количество выборок (наблюдений). Сделать вывод. 

2. Переименовать Лист2 в Отклонение. 

3. На листе Отклонение создать приведенную ниже таблицу и найти от-

клонение выборочных частот от средней частоты σ для каждой части речи по 

формуле 
n

a
n

i
i∑

== 1

2

σ , где xxa ii −= . 

Выборочные частоты, их отклонение от средней частоты и квадраты 
этих отклонений 

Существительное Прилагательное Глагол Выборки 

ix  ia  2
ia  ix  ia  2

ia  ix  ia  2
ia  

1-ая          
2-ая          
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…          
Сумма          
x     
σ    

4. Переименовать Лист3 в Предложения. 

5. На листе Предложения создать таблицу сравнения количества предложе-

ний текста некоторого объема у различных авторов.  

Автор Количество предложений Сравнение 
Толстой Л.Н. 358  
Чернышевский Н.Г. 226  
Макаренко А.С. 345  
Новиков Н.И. 289  
Одоевский В.Ф. 456  
Горький А.М. 384  
Достоевский Ф.М. 267  
Общее количество   
Среднее количество   
Максимальное количество   
Минимальное количество   

− Найти общее количество предложений. 

− Найти минимальное количество предложений по всем авторам. 

− Найти максимальное количество предложений по всем авторам. 

− Найти среднее количество предложений по всем авторам. 

− Используя функцию ЕСЛИ определить «выше» или «ниже» среднего находится 

количество предложений текста каждого автора. 

6. Сохранить документ с именем «Язык и статистика». 

Тема №4: Сортировка данных и форматирование таблиц.  

Цель работы: 

 освоить сортировку ячеек таблицы; 

 изучить возможности оформления таблиц; 

 научиться применять автоформатирование. 

Задания к лабораторной работе: 

1. Запустить MS Excel. 
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2. Открыть файл Язык и статистика.xls. 

3. К таблице на листе Средняя применить следующие атрибуты форматирования: 

− выравнивание; 

− шрифты; 

− цвет фона; 

− ширина столбцов и высота строк; 

− рамка. 

5. К таблице на листе Отклонение применить стиль автоформатирования – 

Классический 2. 

6. На листе Предложения создать три копии таблицы (на этом же листе). 

7. К каждой таблице на листе Предложения применить стили автоформатиро-

вания – Цветной 1, Цветной 2, Цветной 3. 

8. На листе Предложения отсортировать первую таблицу – столбцу Количест-

во предложений, вторую таблицу – по столбцу Автор. 

9. Сохранить рабочую книгу с именем «Язык и статистика (формат)». 

Тема №5: Графический анализ данных.  

Цель работы:  

 приобрести навыки создания и редактирования диаграмм средствами MS 

Excel. 

Задания к лабораторной работе: 

1. По имеющимся данным: «за» – 7 чел., «против» – 11 чел., «воздержа-

лось» – 2 чел., построить круговую объемную диаграмму, отражающую про-

центное соотношение результатов голосования. Цвета секторов – красный, си-

ний и зеленый соответственно.  

2. По данным таблицы построить различные типы диаграмм, отображаю-

щих: 

− долю каждого наименования в первом предложении; 

− динамику изменения количество подлежащих во всех предложениях; 

− сравнение общего числа наименований для всех предложений; 

− сравнение количества сказуемых в первом, третьем и пятом предложениях. 
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Наименование 
1 предложе-

ние 
2 предложе-

ние 
3 предложе-

ние 
4 предложе-

ние 
5 предложе-

ние 
6 предложе-

ние 
Подлежащее 11 12 12 15 17 19 
Сказуемое 15 21 20 20 17 19 
Деепричастие 23 29 32 34 30 33 
Итого       

3. Создать следующую таблицу и выполнить к ней задания. 

Факультет 
Группа 

1 курс 2 курс 3 курс 4 курс 5 курс Макс. 
кол-во 

Миним. 
кол-во 

Среднее 

ФПИ 75 68 68 62 56    
ФМО 60 58 55 57 49    
ФФ 100 91 92 85 69    

− вычислить максимальное, минимальное и среднее количество студентов по 

отдельным факультетам; 

− построить диаграмму, отображающую сравнение количества студентов на 

разных курсах по факультету ФФ (круговая или кольцевая); разместить диа-

грамму на текущем листе; на диаграмме должен быть отображен заголовок, 

подписи данных, легенда. 

Контрольные вопросы 

1. Способы запуска и завершения работы MS Excel. 

2. Структура рабочей книги. Структура окна MS Excel, окна рабочей книги. 

3. Определения понятий: «рабочая книга», «рабочий лист», «ячейка», «диапа-

зон ячеек». 

4. Как перейти от одного рабочего листа к другому?  

5. Как выделить диапазон ячеек?  

6. Как выделить строку, столбец? 

7. Как скопировать, переместить, удалить рабочий лист? 

8. Сохранение рабочей книги. Сохранение рабочей книги под другим именем. 

Открытие существующей рабочей книги. 

9. Как вводятся числа? Как вводится текст? 

10. Как по умолчанию располагаются в ячейке вводимые числовые данные? 

11. Как по умолчанию располагаются в ячейке вводимые текстовые  данные? 
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12. Как ввести число в текстовом формате? 

13. Как добавить новую строку или столбец? 

14. Как очистить содержимое ячейки? Как удалить ячейку? 

15. Как создать пользовательский список для автозаполнения? 

16. Редактирование ячеек. 

17. Форматы данных. 

18. Способы копирования и перемещения информации. 

19. Составные элементы формул. Правила записи формул. 

20. Наиболее распространенные коды ошибок и методы их устранения. 

21. Изменение ссылок в формулах при перемещении или копировании влияю-

щих ячеек, при перемещении или копировании самих формул. 

22. Вызов мастера функций. Вставка функции в формулу с использованием 

мастера функций. 

23. Абсолютная, относительная и смешанная адресация. Замена абсолютных 

ссылок на относительные и наоборот. 

24. Создание диаграмм (встроенных и на отдельных листах). 

25. Типы диаграмм MS Excel и возможные области их практического примене-

ния. 

26. Вставка в диаграмму легенды, меток значений данных, названий диаграммы 

и ее осей. Добавление новых рядов данных. 

Контрольная работа 

1. Переименовать Лист1 на Магазин. 

2. Создать ниже приведенную таблицу: 

Прейскурант цен на книги в книжном магазине 
№ Автор Название книги Цена за одну книгу Количество Общая сумма 
1      
2      
3      
…      
10      

Сумма     
Среднее    
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− Первый столбец заполнить с помощью автозаполнения. 

− Столбцы Автор, Наименование книги и Цена за одну книгу заполнить само-

стоятельно. 

− Посчитать общую стоимость покупки. 

− Найти сумму и среднее значение по каждому столбцу. 

− Применить к таблице следующее форматирование: цвет заголовков столбцов – 

красный; цвет заливки – серый; внешняя рамка – сплошная; внутренняя рамка – 

пунктирная. 

− Отсортировать таблицу по столбцу Автор. 

− Построить диаграмму, отражающую название книги и общую сумму за каждую 

книгу. Дать заглавие диаграмме (цвет шрифта названия диаграммы – синий). 

На диаграмме указать подписи данных. 

3. Переименовать Лист2 на Прейскурант. 

4. Создать ниже приведенную таблицу: 

Цена путевки  в долларах 
Курс доллара …  

   
Наименование санатория Цена в долларах Количество 

Моряк $390,00 2 
Амурский залив $350,00 3 
Шмаковка $600,00 2 
Белые горы $420,00 3 
Бузули $650,00 1 
Средняя цена   
Максимальная цена   
Минимальная цена   

− Ввести курс доллара. 

− Между столбцами Цена в долларах и Количество вставить столбец Цена в руб-

лях. Вычислить цену в рублях, используя введенный курс доллара. 

− Найти среднюю, максимальную и минимальную цену в рублях и долларах сре-

ди всех санаториев. 

− После столбца Количество добавить столбец Сравнение. 
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− Заполнить столбец Сравнение следующим образом: если цена путевки в сана-

торий в рублях больше средней цены, то вывести фразу «не покупать», иначе – 

вывести фразу «покупать». 

− Применить к таблице автоформатирование – Цветной 2. 

− Построить диаграмму, отражающую наименование санатория и цену  путевки в 

него в рублях. Дать заглавие диаграмме (цвет шрифта названия диаграммы – 

зеленый). На диаграмме указать подписи данных. 

Тест самоконтроля знаний 

Вариант №0 

1. Для задания диапазона ячеек Excel, два требуемых адреса необходимо разде-
лить: 
a) двоеточием; 
b) тире; 
c) точкой с запятой; 

2. Запись «B$1» означает, что при копировании ячейки Excel: 

a) изменится имя столбца; 

b) изменится номер строки; 

c) изменятся имя и номер ячейки; 

3. Изменяющийся при копировании и перемещении адрес ячеек Excel: 

a) ссылка; 

b) абсолютная ссылка; 

c) относительная ссылка; 

4. Содержимым отдельной ячейки может быть: 

a) график, диаграмма или рисунок; 

b) число, текст, или формула; 

c) команда, файл, каталог; 

5. Для задания диапазона ячеек нужно указать: 

a) его левый верхний и правый нижний адреса ячеек; 

b) адрес каждой ячейки диапазона; 

c) адреса двух ячеек с максимальным и минимальным элементами; 
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6. Укажите правильную запись формулы, вычисляющей произведение содер-

жимого ячеек А1 и В1: 

a) С1=А1*В1; 

b) А1*В1; 

c) = А1*В1; 

7. Если в клетках ЭТ содержится формула, то при обычном режиме в данной 

клетке отображается: 

a) содержимое данной клетки; 

b) математическая функции; 

c) вычисленное по этой формуле значение; 

8. Для указания абсолютного адреса используется знак: 

a) #; 

b) %; 

c) $; 

9. Файл, в котором хранится таблица Excel, имеет расширение: 

a) .doc; 

b) .exe; 

c) .xls; 

10. Результатом вычислений в ячейке С1 будет: 

 А В С 

1 5  = А1*2  =СУММ(А1:В1)  

a) 5; 

b) 10; 

c) 15. 

Тема 10. PowerPoint: презентация различных исследований. 

Лекция: 

Создание новой презентации 

При запуске MS PowerPoint появляется диалоговое окно, которое имеет 

четыре переключателя, позволяющих:  
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− Создать новую презентацию используя мастер автосодержания, шаблон пре-

зентации, пустую презентацию.  

− Открыть имеющуюся презентацию.  

Мастер автосодержания помогает выбрать один из нескольких шаблонов 

содержания и способы его оформления. Шаблон представляет собой презента-

цию с заранее установленными цветами слайда и текстовыми стилями. На каж-

дом шаге мастер автосодержания запрашивает определенную информацию о 

создаваемой презентации. По завершении работы мастера создается презента-

ция в режиме структуры с титульным слайдом и несколькими слайдами с заго-

ловками, в которые затем можно добавить собственный текст и рисунки.  

При выборе переключателя шаблон оформления открывается диалоговое 

окно Создать презентацию с шаблонами. В диалоговом окне имеются вкладки 

Презентации и Шаблоны оформления для создания презентаций по шаблонам. 

Шаблоны, расположенные на вкладке Презентации, охватывают широкий 

спектр тем и имеют некоторые элементы художественного оформления. Они 

совпадают с шаблонами, которые использует мастер автосодержания. Шабло-

ны, расположенные на вкладке Дизайны презентации, позволяют выбрать оп-

ределенный стиль оформления презентации. После двойного щелчка по шабло-

ну, появляется диалоговое окно, содержащее 24 макета разметки слайдов. 

После выбора переключателя Пустая презентация также открывается 

диалоговое окно с 24 макетами разметки слайдов. В новой презентации исполь-

зуются цветовая схема, стиль заголовка и стили текста презентации, принимае-

мые по умолчанию. 

Переключатель Открыть презентацию позволяет открыть существующую 

презентацию MS PowerPoint. 

Если MS PowerPoint уже запущен, то можно создать новую презентацию: 

− используя мастер автосодержания командой Файл → Создать, выбрать 

вкладку Общие, затем Мастер автосодержания; 

− по шаблону командой Файл → Создать, выбрать вкладку Презентации или 

Шаблоны оформления; 
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− без использования шаблона командой Файл → Создать, выбрать вкладку 

Общие, затем Новая презентация или использовать кнопку Создать на Стан-

дартной панели инструментов. 

СОЗДАНИЕ СЛАЙДОВ ПО РАЗМЕТКЕ 

При создании нового слайда можно выбрать один из макетов. 

Каждый из них предлагает свою композицию содержимого, соответст-

вующую определенному назначению слайда. Макет предусматривает, что в ка-

ждой зоне слайда будет располагаться определенный вид информации. Суще-

ствует макет, включающий рамки для заголовка, текста и диаграммы; в другом 

макете предусмотрены места для заголовка и картинки. Рамка с пунктирным 

контуром изображается на создаваемом слайде и обозначает место для разме-

щения таких объектов как заголовок слайда, текст, диаграмма и т.п. Например, 

диаграмма будет располагаться только справа, а текст только слева. Располо-

жение, размер и формат рамок допускается изменять. 

Чтобы изменить макет уже созданного слайда, нужно воспользоваться 

командой Формат → Разметка слайда… или нажать кнопку Разметка слайда на 

панели инструментов Стандартная, затем выбрать новую разметку. Отсутствие 

нужных рамок в новой разметке не приведет к потере данных. 

Режимы PowerPoint 

Режимами называются способы отображения и работы над презентацией. 

Кнопки в нижней части окна презентации позволяют переходить от одного ви-

да режима к другому. Также все эти режимы доступны из меню Вид. 

В Обычном режиме отображаются три области: область структуры, об-

ласть слайда и область заметок. Эти области позволяют одновременно работать 

над всеми аспектами презентации. Размеры областей можно изменять, перетас-

кивая их границы. 

Область структуры служит для организации и развертывания содержимо-

го презентации. В ней можно вводить текст презентации и упорядочивать пунк-

ты списка, абзацы и слайды. В области слайда отображается текст каждого 

слайда с учетом форматирования. На отдельные слайды можно добавлять ри-
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сунки, фильмы, звуки, анимацию и гиперссылки. Область заметок служит для 

добавления заметок докладчика или сведений для аудитории. 

В Режиме структуры презентация изображается в сокращенном виде: 

только заголовки слайдов и содержащийся в них текст. В верхнем правом углу 

находится окно для просмотра текущего слайда. Оно позволяет отслеживать 

ход заполнения слайда текстом, чтобы вовремя перейти на новый слайд. 

Перед заголовком каждого слайда стоит номер и значок. Основной текст, 

включающий до пяти уровней отступов, расположен после каждого заголовка. 

Работа со структурой является наилучшим вариантом организации и развития 

презентации, так как в процессе работы на экране отображаются все заголовки 

и основной текст. Можно поменять местами пункты на слайде, переместить 

слайд целиком с одной позиции в другую и изменить заголовки и основной 

текст. Например, чтобы упорядочить слайды или пункты маркированного спи-

ска, нужно выбрать значок слайда или маркер, соответствующий тексту, кото-

рый требуется переместить, и перетащить его в другую позицию. 

В Режиме слайдов создают и редактируют отдельные элементы слайдов: 

текст в метках-заполнителях, объекты (графику, звук и т.п.), дополнительные 

тексты, фигуры, собственные рисунки и т.д. С одного слайда на другой пере-

ключаются при помощи вертикальной полосы прокрутки, а также клавишами 

Page Up и Page Down. 

В Режиме сортировщика слайдов  на экране в миниатюре отображаются 

сразу все слайды презентации в том порядке, в каком их будут показывать во 

время выступления. Это упрощает добавление, удаление (клавиша Delete), ко-

пирование (клавиша Ctrl) и перемещение слайдов, задание времени показа 

слайдов и выбор способов их смены. Кроме того, можно просматривать анима-

цию на нескольких слайдах, выделив требуемые и выполнив команду Показ 

слайдов → Просмотр анимации. Чтобы поменять местами один или несколько 

слайдов, нужно выбрать их и перетащить в новое место. 

В Режиме показа слайдов представляют презентацию во время выступле-

ния. Чтобы выбрать какой-либо способ показа, нужно в Режиме слайдов вы-
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полнить команду Показ слайдов → Настройка презентации и установить в со-

ответствующее положение переключатель.  

Существует три разных способа показа слайдов: 

− управляемый докладчиком (полный экран). Это обычный способ проведения 

показа, управляемого докладчиком, когда слайды отображаются в полноэк-

ранном режиме. Ведущий получает полный контроль над презентацией. Он 

может проводить ее вручную (по щелчку мыши) или автоматически (через 

определенное время), останавливать ее для записи замечаний и даже запи-

сывать во время презентации речевое сопровождение; 

− управляемый пользователем (окно). В этом случае показ слайдов будет про-

водиться в стандартном окне со специальными меню и командами, обеспе-

чивающими возможность самостоятельного просмотра презентации пользо-

вателем; 

− автоматический (полный экран). В этом режиме презентация будет прово-

диться в автоматическом режиме, который возобновляется после 5 минут 

простоя. Это можно использовать на выставочном стенде или собрании. 

Зрители могут менять слайды, переходить по гиперссылкам, но не могут из-

менять презентацию. При выборе этого варианта автоматически устанавли-

вается флажок Непрерывный цикл до нажатия клавиши «Esc». 

Прервать показ слайдов можно, нажав клавишу Esc. 

Вставка слайдов в PowerPoint 

Вставить слайды можно следующими способами: 

1. При помощи команды Вставка → Новый слайд… или с помощью кноп-

ки Новый слайд на Стандартной панели инструментов. Будет создан новый, 

«чистый» слайд с разметкой, выбранной в открывшемся по этой команде диа-

логовом окне. 

2. Чтобы добавить новый слайд, который имеет ту же разметку, что и те-

кущий слайд, нужно щелкнуть на кнопке Новый слайд на Стандартной панели 

инструментов, удерживая клавишу Shift. 
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3. В режиме структуры. Для создания «чистого» слайда нужно поместить 

курсор в конец предыдущего слайда и нажать клавишу Enter. Если прототип 

слайда уже где-то существует (в другой презентации или в текстовом докумен-

те), то можно вставить его в нужное место презентации, используя буфер обме-

на. 

4. При помощи команды Вставка → Дублировать слайд. Для этого необ-

ходимо выделить уже имеющийся слайд презентации и выбрать эту команду. 

Копия слайда будет расположена сразу после его прототипа. 

5. При помощи команды Вставка → Слайды из файлов… Эта команда по-

зволяет копировать слайды из одной презентации в другую. Если воспользо-

ваться ею, откроется диалоговое окно Поиск слайдов. Щелчок по кнопке Обзор 

позволяет выбрать презентацию, в которой содержится нужный слайд. Чтобы 

найти слайд, нужно щелкнуть по кнопке Показать, затем отметить нужные 

слайды и щелкнуть по кнопке Вставить. Искать слайды в этом окне можно в 

двух режимах: с показом уменьшенных копий слайдов и с показом заголовков 

слайдов. Для переключения этих режимов используются кнопки в правой части 

окна. 

6. При помощи команды Вставка → Слайды из структуры… Под структу-

рой в данном случае подразумевается любой текстовый файл, абзацы которого 

MS PowerPoint преобразует в слайды презентации. 

Изменение цвета фона и способа заливки слайда 

Для выбора цвета, текстуры, узора или рисунка для фона слайда использует-

ся команда Формат → Фон… Появляется диалоговое окно Фон. В группе Заливка 

фона нужно щелкнуть по кнопке списка. Для изменения цвета, входящего в цвето-

вую схему, необходимо выбрать один из восьми цветов, а чтобы изменить цвет, не 

входящий в цветовую схему, нажать кнопку Другие цвета. На вкладке Обычные 

выбирается нужный цвет, на вкладке Спектр можно создать свой цвет. 

Объект можно заполнить сплошным цветом или переливающимся (с отте-

нением), а также узором, текстурой или рисунком. Для изменения заливки в диа-
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логовом окне Фон нужно щелкнуть по кнопке списка, затем выбрать  Способы за-

ливки, перейти на одну из вкладок Градиентная, Текстура, Узор или Рисунок. 

Для восстановления цвета фона и заливки, используемого по умолчанию, 

используется кнопка Авто. 

Применение внесенных изменений к текущему слайду выполняется щелч-

ком по кнопке Применить, а ко всем слайдам – по кнопке Применить ко всем. 

Также для изменения цвета фона и способа заливки слайда можно восполь-

зоваться кнопкой списка рядом с кнопкой Цвет заливки на панели инструментов 

Рисование. 

Ввод текста 

Самый простой способ добавления текста к слайду – ввести его непо-

средственно в рамку на слайде. Чтобы вставить текст в рамку, нужно щелкнуть 

внутри нее и набрать текст. Чтобы вставить текст вне рамки, можно воспользо-

ваться инструментом Надпись, расположенным на панели инструментов Рисо-

вание или командой Вставка → Надпись. 

Чтобы добавить текст в автофигуру, необходимо щелкнуть в ней и на-

брать текст. Этот текст закрепляется за фигурой и перемещается и вращается 

вместе с ней. Чтобы не присоединять текст, нужно вставить его с помощью ин-

струмента Надпись. Текст можно вставлять в любую автофигуру, кроме линии, 

произвольной фигуры и соединительной линии. Если фигура уже содержит 

текст, то новый текст будет добавлен в конец имеющегося. 

Для изменения внешнего вида шрифта используется команда Формат → 

Шрифт или кнопки на панели инструментов Форматирование. 

Способы вставки рисунков в презентацию 

В комплект MS PowerPoint входит стандартный набор рисунков в виде 

коллекции. Эта коллекция включает множество картинок, выполненных на 

профессиональном уровне и позволяющих придать презентации более красоч-

ный вид. Выбор рисунков самый широкий — карты, изображения людей, зда-

ний, пейзажей и т.д. 
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Для выбора рисунка нужно выполнить команду Вставка → Рисунок или 

нажать кнопку Добавить картинку на Стандартной панели инструментов  и пе-

рейти на вкладку Графика или Картинки. В коллекции предусмотрено удобное 

средство поиска, помогающее найти нужные изображения для презентации. 

Кроме того, здесь имеется своя система справки, где можно узнать, как встав-

лять в коллекцию свои рисунки, как обновлять и как настроить ее для своих це-

лей. 

Чтобы воспользоваться средством поиска или системой справки, необхо-

димо нажать кнопку Поиск или Справка соответственно. 

Для вставки рисунка необходимо сначала выбрать нужный раздел, затем 

подходящий рисунок и нажать кнопку Вставить или выполнить двойной щел-

чок по рисунку. 

В меню Сервис есть команда Автографика, просматривающая презента-

цию, определяющая круг используемых понятий и затем предлагающая изо-

бражения из коллекции, которые наиболее адекватны содержанию презентации. 

Чтобы вставить сканированную фотографию, нужно выполнить команду 

Вставка → Рисунок, затем выбрать Со сканера. Изображение откроется в при-

ложении MS Photo Editor, где его можно изменить. Можно создавать собствен-

ные рисунки, используя панель инструментов Рисование. 

Анимация и способы перехода слайдов 

Анимацией называется звуковое и визуальное оформление, которое мож-

но добавить к тексту или другому объекту, например, к диаграмме или рисунку. 

Переходом называется специальный эффект, используемый для отображения 

очередного слайда в ходе показа презентации. Например, можно обеспечить 

появление слайда из затемнения или наплывом. Также можно выбрать вид и 

скорость перехода. При создании слайдов презентации основное внимание не-

обходимо уделять их содержанию. Анимация, способы смены слайдов и другие 

средства используются для подчеркивания определенных аспектов сообщаемых 

сведений, а также делает презентацию более привлекательной. Для каждого 

объекта слайда также можно установить способ его появления на экране, на-
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пример, «влетание» с левой или с правой стороны, потускнение или изменение 

в цвете. 

Добавление переходов и условий переходов в показ слайдов 

1. В Режиме слайдов или Режиме сортировщика необходимо выделить 

слайды, для которых следует добавить переходы. 

2. В меню Показ слайдов выбрать команду Переход слайда… 

3. В появившемся диалоговом окне Переход слайда в списке Эффект вы-

брать нужный вариант эффекта перехода, скорость показа эффекта (медленно, 

средне, быстро) и условия перехода (по щелчку мыши или автоматически). Ес-

ли установлены оба флажка По щелчку мыши и Автоматически, то следующий 

слайд появляется по щелчку мыши или автоматически по истечении интервала, 

заданного в поле секунд (в зависимости от того, что произойдет раньше). Если 

сброшены оба флажка, то следующий слайд появляется только после выбора в 

контекстном меню команды Далее. 

4. Чтобы применить переход к выделенному слайду, нажать кнопку При-

менить. Чтобы применить переход ко всем слайдам, нажать кнопку Применить 

ко всем. 

В Режиме сортировщика под Стандартной панелью инструментов появ-

ляется панель Сортировщик слайдов. Кнопка Переход слайда позволяет от-

крыть диалоговое окно Переход слайда. Справа от кнопки Переход слайда на 

панели сортировщика расположены два раскрывающихся списка. Первый из 

них добавляет или изменяет эффекты при появлении слайдов во время их пока-

за. Второй список включает эффекты анимации при выводе текста. 

Для просмотра способа перехода каждого слайда можно воспользоваться 

пиктограммами, расположенными под слайдами. 

Выполнение анимации текста и объектов 

1. В Режиме слайдов отобразить слайд, для текста или объектов которого 

выполняется анимация. 

2. Выполнить команду Показ слайдов → Настройка анимации, затем пе-

рейти на вкладку Время. 
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3. В группе Объекты без анимации выделить текст или объект, подлежа-

щий анимации, затем выбрать переключатель Включить. 

4. Чтобы показ анимации начинался по щелчку в группе Продвижение 

нужно установить переключатель По щелчку мыши. Для автоматического за-

пуска показа анимации установить переключатель Автоматически и указать че-

рез сколько секунд после предыдущей анимации следует показывать данную. 

5. Выбрать вкладку Эффекты. В группе Выберите эффект и звук устано-

вить нужные настройки параметров. 

6. Можно проверить оформление слайдов в отдельном маленьком окне, 

которое открывается щелчком по кнопке Просмотр. 

 Самый быстрый способ создания простейшей анимации: выделить нуж-

ный объект (в Режиме слайдов), выполнить команду Показ слайдов →  Встро-

енная анимация и выбрать подходящий вариант. 

 Чтобы предварительно просмотреть анимацию в Режиме слайдов, необ-

ходимо выполнить команду Показ слайдов → Просмотр анимации. Анимация 

будет показана в миниатюрном слайде. Чтобы снова начать показ, нужно щелк-

нуть эту миниатюру слайда. 

Добавление управляющих кнопок в презентацию 

В MS PowerPoint включены некоторые готовые к использованию управ-

ляющие кнопки, которые можно добавить в презентацию, назначив соответст-

вующую гиперссылку. На управляющих кнопках изображены значки, которые 

служат для создания интуитивно понятных обозначений для перехода к сле-

дующему, предыдущему, первому и последнему слайдам. В MS PowerPoint 

также имеются управляющие кнопки для воспроизведения фильмов и звуков. 

Для добавления управляющих кнопок в слайд нужно выполнить команду  

Показ слайдов → Управляющие кнопки и выбрать требуемую кнопку. Напри-

мер, назад, далее, в начало или в конец. 

Чтобы изменить размер кнопки, необходимо перетащить указатель до 

требуемого размера. Для сохранения пропорций фигуры при перетаскивании 

удерживать нажатой клавишу Shift. 
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Когда появится окно Настройка действия, на вкладке По щелчку мыши 

или По наведении указателя мыши установить переключатель Перейти по ги-

перссылке, из списка выбрать нужный элемент, затем ОК. 

Запуск показа слайдов 

Для запуска презентации нужно выполнить любое из приведенных ниже 

действий: 

− Перейти в режим Показ слайдов. 

− Выполнить команду Показ слайдов → Показ. 

− Выполнить команду Вид → Показ слайдов. 

Форматы сохраненных файлов 

Презентацию (новую или сохранявшуюся ранее) можно сохранить в ходе 

работы над ней командой Файл → Сохранить или использовать кнопку Сохра-

нить на панели инструментов Стандартная. Также можно сохранить копию пре-

зентации под другим именем или в другом месте командой Файл → Сохранить 

как… Можно выбрать различные форматы сохраняемых файлов: 

− расширение файла обычной презентации ppt; 

− презентация, которая всегда будет открываться в режиме Показ слайдов, 

имеет расширение pps. Открыв такой файл (в MS PowerPoint или на основ-

ном экране), автоматически запустится показ слайдов. Если показ запускает-

ся из основного экрана, по его завершении MS PowerPoint закроется. Если 

показ слайдов запускается из MS PowerPoint, по его завершении презентация 

останется открытой и доступной для редактирования; 

− презентация, сохраненная в виде шаблона, имеет расширение pot. 

Лабораторные занятия: Создание презентаций. 

Цель работы:  

 узнать назначение программы MS PowerPoint; 

 научиться создавать и редактировать презентации в программе  MS 

PowerPoint. 

Задания к лабораторной работе: 

1. Вставить любым способом пять пустых слайдов. 
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2. Применить ко всем слайдам способ заливки – текстура (любую понра-

вившуюся). 

3. Для первого слайда выбрать автомакет – титульный слайд. Применить к 

нему следующее оформление: 

− Текст заголовка – РУССКИЙ ЯЗЫК, шрифт – Monotype 

Corsiva размер – 80, цвет – синий, начертание – жирный. 

− Текст подзаголовка – ИМЯ СУЩЕСТВИТЕЛЬ-НОЕ, 

шрифт – Arial, размер – 0, цвет – красный, начертание – 

полужирный курсив, тень. 

4. Для второго слайда выбрать автомакет – 

только заголовок и набрать приведенный текст (см. 

слайд). Применить к нему следующее оформление: 

шрифт – Arial. размер – 46, цвет: слово «существи-

тельное» – красный, остальной текст – черный; на-

чертание: слово «существительное» – жирный, остальной текст – обычный. Весь 

текст находится внутри рамки (см. слайд), цвет заливки рамки – светло голубой.  

5. Для третьего слайда автома-

кет – схема и оформить его следую-

щим образом (см. слайд). Цвет залив-

ки элементов схемы – светло зеленый, 

цвет шрифта для «имя существитель-

ное» - темно синий, остальной текст - 

черный. Обратите внимание на начер-

тание некоторых слов. 

6. Для четвертого слайда выбрать авто-

макет – заголовок и маркированный текст и на-

брать приведенный текст (см. слайд). Цвет за-

головка – синий, «ь» в заголовке и по тексту 

маркированного списка выделен красным цве-

том. Обратите внимание на начертание некоторых слов. 
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7. Для пятого слайда выбрать 

автомакет – заголовок и таблица и на-

брать приведенный текст (см. слайд). 

Цвет заголовка – красный. Обратите 

внимание на начертание некоторых 

слов. 

8. Вставить на первом слайде в верхний левый угол 

следующую картинку (если таковой не окажется в списке 

картинок, то можно вставить любую другую). 

9. Задать для созданных слайдов различную анимацию и смену слайдов. 

10. Установить для слайдов следующие управляющие кнопки: 

− первый слайд:  – далее и  – в конец; 

− последний слайд:  – в начало; 

− остальные слайды:  – далее. 

11. Осуществить показ созданной презентации. 

12. Сохранить презентацию с именем слайды.pps. 

 

Контрольные вопросы 

1. Для чего предназначено приложение MS PowerPoint?  

2. Что такое презентация? Что такое слайд?  

3. Назвать способы создания презентаций.  

4. Что такое шаблон? Какие существуют виды шаблонов в MS PowerPoint?  

5. Какое расширение имеет файл презентации, шаблон презентации?  

6. Объясните назначение Режима слайдов.  

7. Назвать основные характеристики Режима сортировщика слайдов.  

8. Как выполнить показ презентации? Способы показа презентации.  

9. Что такое анимация? 

10. Что такое переход слайдов? Примеры перехода слайдов. 
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Контрольная  работа 

1. Запустить программу MS PowerPoint. 

2. На первом слайде ввести произвольный заголовок. 

3. Вставить несколько слайдов разных типов и произвольно заполнить их тек-

стовой информацией и изображениями. 

4. Применить на выбор оформление слайдов. 

5. В одном из слайдов сменить фон на другой цвет и сменить способ заливки на 

градиентный (произвольно); в другом слайде в качестве способа заливки вы-

брать текстуру по выбору. 

6. Продублировать один из слайдов и изменить его содержание. 

7. Добавить слайд и вставить в него диаграмму. 

8. Добавить эффекты анимации в слайды. Для каждого слайда назначить смену 

слайда. 

9. Сделать настройку времени для презентации. 

Тест самоконтроля знаний 

Вариант №0 
1. В каком режиме просматривается данная 
презентация?  

a) обычный; 
b) страницы заметок; 
c) сортировщик слайдов; 

2. Как изменить междустрочный интервал в маркированном списке?  

a) Формат → Абзац; 

b) Формат → Список; 

c) Формат → Интервалы; 

3. На картинке изображен слайд с таблицей. Вставить по-

добную таблицу в слайд возможно с помощью 

a) Вставка → Таблица; 

b) Формат → Таблица; 

c) Вид → Таблица; 
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4. На рисунке изображена рамка с текстом, 

выровненным определенным образом. 

Укажите номер кнопки, соответствующей 

данному типу выравнивания: 

a) 1; 

b) 2; 

c) 3; 

5. В процессе демонстрации презентации доклад-

чик может использовать инструмент Карандаш. 
На рисунке представлен пример применения 
этого инструмента. Укажите пункт контекстно-
го меню, соответствующий выбору инструмен-
та Карандаш: 

a) записная книжка; 

b) заметки докладчика; 

c) указатель; 

6. На рисунках изображен слайд с одинаковым содержимым. Чем различаются 
эти слайды? 

   
a) шаблонами оформления; 
b) цветовыми схемами; 
c) эффектами анимации; 

 7. На рисунке представлена картинка из коллекции MS Office 

ClipArt. Укажите все способы вставки картинок из данной 
коллекции: 

a) Вставка → Рисунок → Картинки; 

b) Вставка → Рисунок → Автофигуры; 

c) Вид → Вставка → Вставка картинки;  
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8. На картинке изображено окно Настройки ани-

мации. Меню «Вход» (выделено красным) ус-

танавливает эффект анимации: 

a) Для всего слайда при смене слайдов;  

b) Для выделенного на слайде объекта; 

c) Для всех слайдов создаваемой презентации; 

9. На картинке изображен фрагмент слайда. Укажите 

тип выравнивания названий времен года: 

a) По центру; 

b) По правому краю; 

c) По левому краю. 

Тема 11. Базы данных.  

Лекция: 

База данных (БД) – это поименованная совокупность структурированных 

данных, относящихся к определенной предметной области (БД по металлургии, 

БД в деканате о студентах, БД в библиотеке по книгам). 

Система управления базами данных (СУБД)– это комплекс программных 

и языковых средств, необходимых для создания баз данных, поддержания их в 

актуальном состоянии и организации поиска в них необходимой информации. 

Основными функциями системы управления базами данных являются: 

- создание структуры базы данных; 

- предоставление средств для ее заполнения или импорта данных из другой 

базы; 

- обеспечение возможности доступа к данным; 

- предоставление средств поиска, фильтрации, запросов данных. 

Классификация БД: 
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Структурные элементы базы данных: 

1. Поле – элементарная единица логической организации данных, которая 

соответствует неделимой единице информации – реквизиту. Для описания поля 

используются следующие характеристики: 

a) Имя, например, Фамилия, Имя, отчество, Дата рождения; 

b) Тип, например, символьный, числовой, календарный; 

c) Размер – определяет предельную длину, например, 15 байт; 

d) Формат – определяет способ форматирования данных; 

e) Маска ввода – определяет форму, в которой вводятся данные в поле; 

f) Подпись – определяет заголовок столбца таблицы; 

g) Точность для числовых данных, например для десятичного знака для ото-

бражения дробной части числа. 

2. Запись – совокупность логически связанных полей. Экземпляр записи - 

отдельная реализация записи, содержащая конкретные значения ее полей. 

Запись содержит данные о конкретном экземпляре сущности. База, не 

имеющая записей, является пустой, но все равно полноценной. Простейший 

«некомпьютерный вариант» БД – ежедневник, в котором каждому календарно-

му дню выделено по странице. Даже если он пустой, он не перестает быть еже-

Базы данных 

По технологии обработки данных По способу доступа к данным 

Централизованная база данных хра-
нится в памяти одной вычислительной 
системы 

Распределенная база данных состоит из 
нескольких, возможно пересекающихся 
или даже дублирующих друг друга час-
тей, хранимых в различных ЭВМ вы-
числительной сети 

С локальным доступом 

С удаленным (сетевым) доступом 

Файл-сервер 

Клиент-сервер 
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дневником, поскольку имеет структуру. 

Файл (таблица) – совокупность экземпляров записей одной структуры. 

Типы данных 

1. Текстовый – используется для хранения обычного неформатированного тек-

ста ограниченного размера (до 255 символов). 

2. Поле Memo – для хранения больших текстов (до 64000 символов). 

3. Числовой. 

4. Дата и время. 

5. Денежный – для хранения денежных сумм. 

6. Счетчик – для уникальных (не повторяющихся) натуральных чисел с автома-

тическим наращиванием. Используется для порядковой нумерации записей. 

7. Логический – для хранения логических данных, которые могут принимать 

только два значения, например Да или Нет. 

Объекты базы данных 

1. Таблицы. 

2. Запросы. Служат для извлечения данных из таблицы и предоставления их 

пользователю в удобном виде. С помощью запроса выполняют отбор данных, их 

сортировку и фильтрацию, создают новые таблицы. 

3. Формы. Являются основным средством создания диалогового интерфейса 

приложения пользователя. Форма может создаваться для ввода и просмотра взаи-

мосвязанных данных базы на экране в удобном виде. 

4. Отчеты. Предназначены для формирования выходных документов вывода 

данных на принтер. В отчетах приняты меры для группирования выводимых дан-

ных и для вывода элементов оформления, характерных для печатных документов. 

В структуре записи файла указываются поля, значения которых являются 

ключами: первичными (ПК), которые идентифицируют экземпляр записи, и 

вторичными (ВК), которые выполняют роль поисковых или группировочных 

признаков (по значению вторичного ключа можно найти несколько записей). 

Виды моделей данных. 

Модель данных – совокупность структур данных и операций их обработки. 
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1. Иерархическая модель данных. 
Представляет собой совокупность элементов, связанных между собой по 

определенным правилам. Объекты, связанные иерархическими отношениями, 
образуют ориентированный граф (перевернутое дерево). 

 
К основным понятиям иерархической структуры относятся: уровень, эле-

мент (узел), связь. 
Узел – это совокупность атрибутов данных, описывающих некоторый объ-

ект (на схеме – вершины графа). Каждый узел на более низком уровне может быть 
связан  только с одним узлом, находящемся на более высоком уровне. 

Примером иерархической структуры БД являются сведения о студентах 
обучающихся в группе. Можно сказать, что каждый студент учится в определен-
ной (только одной) группе, которая относится к определенному (только одному) 
институту. 

2. Сетевая модель данных. 
Объекты в сетевой модели связаны разнородно, т. е. при тех же основных 

понятиях (уровень, узел, связь) каждый элемент может быть связан с любым дру-
гим элементом. 

 
Примером сетевой структуры БД может служить структура базы данных, 

содержащая сведения о студентах, участвующих в научно-исследовательских ра-
ботах (НИРС). Возможно участие одного студента в нескольких НИРС, а также 
участие нескольких студентов в разработке одной НИРС. 

3. Реляционная модель данных. 
Эта модель ориентированна на организацию данных в виде двумерных таб-

А В 

С D E 

H G L 

А 

В1 В2 В3 В4 В5 

Уровень 1 

Уровень 2 

С1 С2 С3 С4 С5 С6 С7 С8 Уровень 3 
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лиц. Каждая реляционная таблица представляет собой двумерный массив и обла-
дает следующими свойствами: 

− каждый элемент таблицы – один элемент данных; 

− все столбцы в таблице однородные, т. е. все элементы в столбце имеют одина-
ковый тип (числовой, символьный и т.д.) и длину; 

− каждый столбец имеет уникальное имя; 

− одинаковые строки в столбце отсутствуют; 

− порядок следования строк и столбцов может быть произвольным. 
Реляционной таблицей можно представить информацию о студентах, 

обучающихся в вузе. 
Поле, каждое значение которого однозначно определяет соответствую-

щую запись, называется простым ключом (ключевым полем). Если записи од-
нозначно определяются значениями нескольких полей, то такая таблица базы 
данных имеет составной ключ. В примере ключевым полем таблицы является 
«№ личного дела». 

Чтобы связать две реляционные таблицы, необходимо ключ первой таб-
лицы ввести в состав ключа второй таблицы (возможно совпадение ключей); в 
противном случае нужно ввести в структуру первой таблицы внешний ключ – 
ключ второй таблицы. 

 
 К реляционной модели данных относится Ms-Access.  

Лабораторные работы: 

Тема №1: Создание таблиц базы данных. 

Цель работы:   

Типы связей 

Один к одному (1:1) – пред-
полагает, что в каждый мо-
мент времени одному эк-
земпляру объекта А соот-
ветствует не более одного 
экземпляра объекта В и 
наоборот. 

А В 

Один ко многим (1:М)  - одно-
му экземпляру объекта А со-
ответствует 0, 1 или более 
экземпляров объекта В, но 
каждый экземпляр объекта В 
связан не более чем с 1 экзем-
пляром объекта А. 

 
А В 

Многие ко многим (М:М) -  пред-
полагает, что в каждый момент 
времени экземпляру объекта А 
соответствует 0, 1 или более 
экземпляров объекта В и наобо-
рот. 

А В 

Студент-преподаватель Покупатель - торговый агент Гражданин - паспорт 
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 научиться создавать таблицы базы данных, задавать их структуру, выби-

рать типы полей и управлять их свойствами; 

 освоить приемы заполнения таблиц конкретными данными; 

 познакомиться с возможностями редактирования данных. 

Методические указания и задания к лабораторной работе: 

1. Загрузите Access, в открывшемся окне Microsoft Access щелкните селектор-

ную кнопку Новая база данных, затем - кнопку OK. 

2. В открывшемся окне Файл новой базы данных в поле Имя файла: введи-

те имя Кафедра, в раскрывающемся списке поля Папка: выделите свою папку 

на диске С:, затем закройте окно, щелкнув кнопку Создать. Создаваемая база 

данных будет находиться в вашей папке на диска D:. 

3. В основном окне базы данных Кафедра: база данных выберите вкладку 

Таблицы и щелкните кнопку Создать. 

4. В открывшемся окне Новая таблица выберите пункт Конструктор и 

щелкните кнопку OK. В результате откроется окно Таблица1: таблица в ре-

жиме Конструктор, в котором определите поля таблицы согласно Таблице 3.  

Для этого: 

− введите в строку столбца Имя поля имя Код преподавателя, 

− поместите курсор в строку столбца Тип данных, раскройте список и выберите 

в нем слово Счетчик. В строку столбца Описание можно ничего не вводить, 

− аналогично определите другие имена и тип данных полей таблицы, 

− в нижней части таблицы Свойства поля во вкладке Общие установите ука-

занные в Таблице 1 размеры полей, предварительно поместив курсор на со-

ответствующую запись (строку) в верхней части таблицы. 

Таблица 1. Структура таблицы данных Преподаватели 

Имя поля Тип данных Размер поля 
Код преподавателя Счетчик  
Фамилия Текстовый 15 
Имя Текстовый 15 
Отчество Текстовый 15 
Должность Текстовый 9 
Дисциплина Текстовый 11 
Зарплата Денежный  
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5. Сохраните созданную таблицу под именем Преподаватели. 

6. На запрос о задании ключевых полей ответьте Нет. 

7. Вернемся к таблице Преподаватели в режиме Конструктор. Если ее нет на 

экране, то активизируйте вкладку Таблицы и откройте ее. 

8. В верхней части таблицы щелкните по записи Должность. 

9. В нижней части окна Свойства поля во вкладке Общие щелкните по строке 

параметра Условие на значение и установите ограничения на данные, которые 

будут вводиться в поле Должность: должны вводиться только слова Профес-

сор, Доцент или Ассистент. Для этого: 

− щелкните по кнопке , чтобы открыть окно Построитель выражений, 

− в открывшемся окне введите слово Профессор, щелкните по кнопке , до-

бавьте Доцент, снова щелкните по кнопке , затем добавьте Ассистент и 

закройте окно, щелкнув кнопку ОК. 

− в строке параметра Сообщение об ошибке введите сообщение: Такой долж-

ности нет, 

− в строке параметра Значение по умолчанию введите Доцент.  

10. Введите ограничения на данные в поле Код преподавателя. С одной сторо-

ны эти данные не должны повторяться, а с другой - должна быть обеспечена 

возможность их изменения. Поэтому в этом поле нельзя использовать тип дан-

ных Счетчик, т.к. значения таких полей обновлять нельзя. Для выполнения 

второго условия задайте тип данных Числовой. А для выполнения первого ус-

ловия выполните следующее: 

− щелкните по строке параметра Индексированное поле, 

− раскройте список и выберите пункт Да (совпадения не допускаются), 

− перейдите в режим Таблица, щелкнув кнопку  слева на панели инстру-

ментов и при запросе на сохранение щелкните кнопку Да. 

11. В режиме Таблица заполните таблицу данными о преподавателях в соответ-

ствии с Таблицей 2 и проверьте реакцию системы на ввод неправильных дан-

ных в поле Должность, введя, например, слово Лаборант. 
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Таблица 2. Таблица данных Преподаватели 

Код Фамилия Имя Отчество Должность Дисциплина Зарплата 
1 Куклев Федор Петрович Доцент Информатика 9800 р. 
2 Максимов Никита Юрьевич Профессор Экономика 14500 р. 
3 Андреев Борис Сергеевич Доцент Статистика 7600 р. 
4 Лидский Виктор Борисович Профессор Математика 12500 р. 
5 Колосов Алексей Ивановна Доцент Математика 8900 р. 
6 Беляев Виктор Павлович Ассистент Информатика 3900 р. 
7 Максимов Иван Николаевич Доцент Информатика 8900 р. 

12. Измените ширину поля Дисциплина в соответствии с шириной данных, 

предварительно переведя курсор в любую строку данного поля и используя ко-

манду Формат/Ширина столбца... - кнопка По ширине данных. 

13. Произведите поиск преподавателя Максимова, для чего поместите курсор в 

первую строку под именем поля Фамилия и выберите команду Прав-

ка/Найти.... 

14. В открывшемся диалоговом окне Поиск в поле: Фамилия в поле Образец: 

введите Максимов, в поле Просмотр: выберите Все, в поле Совпадения: выбе-

рите С любой частью поля, у опции Только в текущем поле установите фла-

жок и щелкните кнопку Найти. Чтобы найти следующую запись, щелкните 

кнопку Найти далее. Затем щелкните кнопку Закрыть. 

15. Измените заработную плату ассистенту Беляеву с 3900руб. на 4300руб., для 

чего поместите курсор в первую строку поля Зарплата и выберите команду 

Правка/Заменить.... 

16. В открывшемся диалоговом окне Замена в поле: Зарплата в поле Образец: 

введите 3 900р., в поле Заменить на: введите 4 300р., в поле Просмотр: выбе-

рите Все, у опции Только в текущем поле установите флажок и щелкните 

кнопку Найти далее. Когда запись будет найдена, щелкните кнопку Заменить. 

Затем щелкните кнопку Закрыть. 

17. Произведите сортировку данных в поле Зарплата по убыванию, используя 

команду Записи/Сортировка/Сортировка по убыванию (предварительно по-

местив курсор на любую запись данного поля). 

18. Произведите фильтрацию данных сначала по полю Должность (например, 

профессор), затем – Дисциплина (например, математика), используя команду 



 133

Записи/Фильтр/Фильтр по выделенному (предварительно поместив курсор 

на соответствующую запись данного поля). После выполнения окончательной 

фильтрации удалите фильтр командой Записи/Удалить фильтр. 

19. Просмотрите, как созданная таблица будет выглядеть на листе бумаги при 

печати, используя команду Файл/Предварительный просмотр. 

20. Закройте таблицу Преподаватели, щелкнув кнопку . 

21. Создайте в базе данных Кафедра таблицу Студенты. Для этого: 

− в окне базы данных выберите вкладку Таблицы и щелкните по кнопке Соз-

дать; 

− в открывшемся окне Новая таблица выберите пункт Конструктор и щелк-

ните по кнопке ОК; 

− создайте структуру таблицы Студенты: определите ее имена полей, тип 

данных и свойства полей в соответствии с Таблицей 3; 

− в качестве ключевого поля определите поле Код студента, для чего активи-

зируйте это поле и щелкните по кнопке ; 

− закройте таблицу, задав ей имя Студенты. 

Таблица 3. Структура таблицы данных Студенты 

Имя поля Тип данных Размер поля 
Код студента Числовой Целое 
Фамилия Текстовый 15 
Имя Текстовый 15 
Отчество Текстовый 15 
Номер группы Числовой Целое 
Телефон Текстовый 9 
Стипендия Логический Да/Нет 

22. Аналогично создайте структуру таблицы Дисциплины, определив ее имена 

полей, тип данных и свойства полей в соответствии с Таблицей 4, а ключевым 

выбрав поле Код дисциплины. 

Таблица 4. Структура таблицы данных Дисциплины 

Имя поля Тип данных Размер поля 
Код дисциплины Числовой Целое 
Название дисциплины Текстовый 30 
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23. Создайте в базе данных Кафедра структуру таблицы Оценки, определив ее 

имена полей, тип данных и свойства полей в соответствии с Таблицей 5. На во-

прос о создании ключевого поля ответьте Нет. 

Таблица 5. Структура таблицы Оценки 

Имя поля Тип данных Размер поля 
Код студента Числовой Целое 
Код дисциплины Числовой Целое 
Оценки Числовой Байт 

24. В базе данных Кафедра измените структуру таблицы Преподаватели, доба-

вив в нее поле Код дисциплины и определив его тип данных и размер в соот-

ветствии с данными Таблицей 4. 

25. Закройте таблицы Преподаватели, Дисциплины, Оценки и Студенты, если 

они открыты. 

26. Щелкните по кнопке  на панели инструментов (или выполните команду 

Сервис/Схема данных). На экране откроется окно Добавление таблицы. 

27. В открывшемся окне будет выделено название одной таблицы. Щелкните по 

кнопке Добавить. 

28. Переведите выделение на имя следующей таблицы и щелкните по кнопке 

Добавить. Аналогично добавьте оставшиеся две таблицы. 

29. Закройте окно, щелкнув по кнопке . 

30. Создайте связь между таблицами Дисциплины и Оценки. Для этого подведи-

те курсор мыши к полю Код дисциплины в таблице Дисциплины, щелкните ле-

вой кнопкой мыши и, не отпуская ее, перетащите курсор на поле Код дисцип-

лины в таблицу Оценки, а затем отпустите кнопку мыши. На экране откроется 

окно Связи. 

31. Установите флажок («галочку») в свойстве Обеспечение целостности дан-

ных, щелкнув по нему. 

32. Установите флажок в свойстве Каскадное обновление связанных полей и 

Каскадное удаление связанных полей. 

33. Щелкните по кнопке Создать. Связь будет создана. 

34. Аналогично создайте связи между полями Код дисциплины в таблице Дис-
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циплины и полем Код дисциплины в таблице Преподаватели, а также между 

полем Код студента в таблице Студенты и полем Код студента в таблице 

Оценки. 

35. Закройте окно схемы данных, ответив Да на вопрос о сохранении макета. 

Тема №2: Работа с формами. 

Цель работы:  

 познакомиться со способами создания формы; 

 научиться вводить, просматривать, редактировать данные посредством 

формы. 

Задания к лабораторной работе: 

1. В окне базы данных Кафедра: база данных активизируйте вкладку Формы 

и щелкните кнопку Создать. 

2. В открывшемся окне Новая форма выберите Мастер форм, а в нижней час-

ти окна раскройте список и выберите таблицу Преподаватели, затем нажми-

те кнопку OK. 

3. В открывшемся окне Создание форм из поля списка Доступные поля пере-

ведите в поле списка Выбранные поля те, которые будут присутствовать в 

форме. В данном случае это все поля, поэтому щелкните по кнопке  и 

нажмите кнопку Далее. 

4. В следующих окнах Мастера форм выберите соответственно внешний вид 

формы в один столбец, затем требуемый стиль оформления и далее задайте 

имя форме Состав преподавателей. 

5. После нажатия кнопки Готово откроется форма в один столбец. 

6. Найдите запись о доценте Максимове, для чего сначала переведите курсор в 

первую строку поля Фамилия, затем выполните команду Правка/Найти. 

7. Переведите курсор в первую строку поля Зарплата и, используя команду 

Правка/Заменить..., повысьте зарплату ассистенту с 4300руб. на 4500руб.  

8. Произведите сортировку поля Фамилия по убыванию командой Запись/ 

Сортировка/Сортировка по убыванию, предварительно поместив курсор в 

любую запись данного поля. 
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9. Поместив курсор на запись Доцент поля Должность командой Запись/ 

Фильтр/Фильтр по выделенному, оставьте в таблице только записи о пре-

подавателях - доцентах. 

10. Аналогичной процедурой оставьте в таблице только записи о преподавате-

лях – доцентах по дисциплине информатика. 

11. Удалите фильтр командой Записи/Удалить фильтр. 

12. Теперь измените название поля Дисциплина на Преподаваемая дисцип-

лина. Для этого: 

− перейдите в режим Конструктор, щелкнув кнопку  слева на панели ин-

струментов, 

− щелкните правой кнопкой мыши в поле Дисциплина (оно слева), 

− в контекстном меню выберите пункт Свойства, 

− в открывшемся окне свойств поля Дисциплина в строке Подпись вместо 

Дисциплина введите Преподаваемая дисциплина, 

− для просмотра результата перейдите в режим Форма. 

13. Просмотрите, как данная форма будет выглядеть на листе бумаги. 

14. Закройте форму Состав преподавателей, щелкнув кнопку . 

Тема №3: Формирование запросов и отчетов для отдельных таблиц базы 

данных. 

Цель работы:   

 научиться создавать запросы на выборку и запросы с «параметром» для от-

дельных таблиц; 

 научиться формировать структуру запроса путем выбора базовых таблиц и 

полей, а также формулировать условие отбора» 

 овладеть способами создания отчета. 

Методические указания и задания к лабораторной работе: 

1. На основе таблицы Преподаватели создайте простой запрос на выборку, в 

котором должны отображаться фамилии, имена, отчества преподавателей и их 

должность. Для этого: 
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− откройте вкладку Запросы и в открывшемся окне щелкните по кнопке Соз-

дать, 

− в окне Новый запрос выберите пункт Простой запрос и нажмите кнопку 

ОК, 

− в открывшемся окне Создание новых запросов в строке Таблицы/запросы 

выберите таблицу Преподаватели, а в поле списка Доступные поля выдели-

те слово Фамилии и щелкните по кнопке  для перевода его в поле Вы-

бранные поля, 

− аналогично переведите туда поля Имя, Отчество, Должность и щелкните 

по кнопке Далее, 

− в строке параметра Задайте имя запроса введите имя Должности препода-

вателей и щелкните по кнопке Готово. 

2. В открывшейся таблице с результатами запроса отсортируйте по убыванию 

данные по полю Должность. 

3. Сохраните запрос. 

4. Создайте новый запрос под именем Преподаваемые дисциплины на выборку 

с параметром, в котором должны отображаться фамилии, имена, отчества пре-

подавателей и преподаваемые ими дисциплины, а в качестве параметра задайте 

фамилию преподавателя и выполните этот запрос для преподавателя Лидского. 

Для этого: 

− создав аналогично предыдущему пункту запрос под именем Преподаваемые 

дисциплины, перейдите в режим Конструктор, 

− в строке параметра Условия отбора для поля Фамилия введите фразу: [Вве-

дите фамилию преподавателя], 

− выполните запрос командой Запрос/Запуск, 

− в открывшемся окне введите фамилию Лидский и щелкните по кнопке ОК. 

5. Сохраните запрос и закройте окно запроса. 

Контрольные вопросы 

1. Что такое база данных? 
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2. Что представляет собой система управления базой данных? 

3. Модели базы данных. 

4. Типы связей в базе данных. 

5. Типы данных. 

6. Назовите возможные объекты базы данных. 

7. Для чего нужны запросы? Какова их особенность? 

8. Для каких целей создаются формы? Каковы их преимущества? 

9. Для чего предназначены отчеты? В чем состоят их отличия от форм? 

Контрольная работа 

Выберете самостоятельно тему, соответствующую вашей специальности 

и создайте БД, выполнив следующие условия:  

1. Создайте таблицу. 

2. Внесите записи. 

3. Отсортируйте их. 

4. Создайте форму. 

5. Внесите еще 2 записи в форму. 

6. Организуйте поиск, задав критерий для поиска. 

7. Представить форму в режиме таблицы. 

8. Примените фильтр, задав условие отбора данных. 

9. Подготовьте отчет. 

Тест для самоконтроля знаний 

Вариант № 0 

1. Ключ в базе данных – это: 

a) простейший объект БД для хранения значений одного параметра реально-

го объекта или процесса; 

b) поле, по которому выполняется фильтрация данных в таблице парамет-

рам; 

c) поле или совокупность полей, однозначно определяющих записи табли-

цы; 
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2. Представлена база данных «Школа»: 

 Фамилия Год рождения Класс Оценка 
 Лыкова Ольга 1988 10 5 
 Семенов Олег 1987 11 4 
 Морозов Иван 1987 11 3 
 Рыков Роман 1988 10 5 
 Попов Сергей 1988 10 4 
 Зайцева Марина 1987 10 5 

Запрос для вывода списка: учеников 10 классов, 1988 года рождения, имеющих 
оценки не ниже 4 содержит выражение: 

a) Оценка>=4 и Год рождения = 1988 и Класс = 10 
b) Класс = 10 и Год рождения = 1988 и Оценка = 5 и Оценка = 4; 
c) Оценка >=4 или Год рождения = 1988 и Класс = 10; 

3. Установленные связи между таблицами реляционной базы данных помогают: 
a) избежать дублирования информации; 
b) определить местонахождение нужной таблицы; 
c) производить сортировку таблицы; 

4. Система управления базами данных – это: 
a) формальный аппарат ограничений на формирование таблиц, который позво-
ляет устранить дублирование; 

b) комплекс программных и языковых средств, предназначенных для создания, 
ведения и совместного применения баз данных многими пользователями; 

c) система, реализующая сбор, обработку и манипулирование данными и 
включающая технические средства, программное обеспечение и соответст-
вующий персонал; 

5. Тип поля (числовой, текстовой и др.) в базе данных определяется: 
a) названием поля; 
b) количеством строк; 
c) типом данных; 

6. Какую строку будет занимать запись Pentium II после проведения сортировки 
по возрастанию в поле Винчестер? 

 Компьютер Опер. память Винчестер 
1 Pentium 16 2Гб 
2 386DX 4 300Мб 
3 486DX 8 800Мб 
4 Pentium II 32 4Гб 

a) 1; 
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b) 2; 

c) 4; 

7. Запись в БД Access: 

a) столбцы реляционной таблицы; 

b) строки реляционной таблицы; 
c) одно или несколько полей, имеющих уникальное значение для реляционной 

таблицы; 

8. Поле какого типа не может быть ключевым: 

a) числовое; 

b) логическое; 

c) дата; 

9. В какой модели данных предполагается, что любой элемент может быть 

связан с любым количеством других элементов: 

a) реляционная; 

b) сетевая; 

c) иерархическая; 

10. База данных, в которой данные сгруппированы в двумерные таблицы, свя-

занные между собой, называется: 

a) иерархическая; 

b) сетевая; 

c) реляционная; 

11. Поисковая фраза в текстовых БД называется: 

a) вопросом; 

b) ответом; 

c) запросом. 

12. Представлена таблица базы данных «Кадры»: 
 Фамилия Год рождения Оклад 
 Иванов 1956 2400 
 Петров 1957 5300 
 Сидоров 1956 3600 
 Скворцов 1952 1200 
 Трофимов 1958 4500 
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При поиске по условию (ГОД РОЖДЕНИЯ>1956 и ОКЛАД<5000) будут 

найдены фамилии: называется: 

a) Иванов, Петров, Трофимов; 

b) Трофимов; 

c) Иванов, Петров, Трофимов, Скворцов. 

Тема 12. Локальные и глобальные сети ЭВМ. Методы защиты инфор-

мации. 

Лекция: 
 Компьютерная (вычислительная) сеть - совокупность компьютеров и 

терминалов, соединенных с помощью каналов связи в единую систему, удовле-

творяющую требованиям распределенной обработки данных. 

Устройства компьютерной сети 

Все устройства, подключаемые к сети, можно разделить на три функцио-

нальные группы: рабочие станции; серверы сети; коммуникационные узлы.  

 
Файловый сервер – компьютер, хранящий данные пользователей сети и 

обеспечивающий доступ пользователей к этим данным. Как правило, компью-

тер, выделенный под файловый сервер, имеет большой объем дискового про-

странства. Файловый сервер выполняет следующие функции: хранение данных, 

архивирование данных, согласование изменений данных, выполняемых разны-

ми пользователями.  

Сервер баз данных – компьютер, выполняющий функции хранения, обра-

ботки и управления файлами баз данных. Сервер баз данных выполняет сле-

дующие функции: хранение баз данных; прием и обработку запросов к базам 

данных, а так же пересылку результатов обработки на рабочую станцию; обес-

печение авторизированного доступа к базам данных, поддержку системы веде-

ния и учета пользователей, разграничение доступа пользователей; согласование 

Сервер - компьютер, подключенный к сети и обеспечивающий ее пользователей 
определенными услугами 

Файловый  
сервер 

Сервер резервного копирова-
ния данных 

Сервер баз данных Факс - сервер 
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изменений данных, выполняемых разными пользователями; поддержку распре-

деленных баз данных, взаимодействие с другими серверами баз данных, распо-

ложенных в другом месте.  

Факс-сервер – устройство или компьютер, который выполняет рассылку и 

прием факсимильных сообщений для пользователей локальной сети.  

Сервер резервного копирования данных – устройство или компьютер, ко-

торый решает задачи создания, хранения и восстановления копий данных с 

файлового сервера или рабочих станций.  

 
На рабочей станции с диском (жестким или гибким) операционная система 

загружается с этого локального диска. Каждая дисковая рабочая станция рабо-

тает со своими файлами на диске и использует свою операционную систему.  

Для бездисковой станции операционная система загружается с диска фай-

лового сервера. Без дисковая рабочая станция не имеет диска для хранения ин-

формации, поэтому обрабатывает файлы только с файлового сервера.  

Удаленная рабочая станция – это станция, которая подключается к локаль-

ной сети через телекоммуникационные каналы связи (например, с помощью те-

лефонной сети).  

К коммуникационным узлам относятся следующие устройства: повторите-

ли, коммутаторы (мосты), маршрутизаторы, шлюзы.  

Информация передается по сети порциями (пакетами). В сети при передаче 

отдельного пакета с помощью каналов связи происходит затухание сигнала. 

Поэтому сеть ограничивают участками (сегментами).  

По окончанию каждого участка имеется повторитель – устройство, усили-

вающее или регенерирующее пришедший на него сигнал. Повторитель, приняв 

пакет от одного сегмента, передает его дальше. Повторитель осуществляет свя-

Рабочая станция – персональный компьютер, подключенный к сети, через 
который пользователь получает доступ к ее ресурсам 

Дисковая – имеет винчестер 
для записи информации 

Бездисковая – информация запи-
сывается на главный компьютер 
сети 

Удаленная рабочая станция – 
удалена от центра сетевого 
управления 
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зывание сегментов.  

Коммутатор или мост – это устройство, которое, как и повторитель, вы-

полняет объединение нескольких сегментов. В отличие от повторителя, мост 

выполняет развязку присоединенных к нему сегментов.  

Маршрутизатор – устройство, соединяющее сети одного или разных типов 

по одному протоколу данных, анализирует адрес назначения и направляет дан-

ные по оптимально выбранному маршруту.  

 Шлюз – это устройство, позволяющее организовать обмен данными меж-

ду разными сетевыми объектами, использующими разные протоколы обмена 

данными.  

Основные показатели сети 

Производительность сети определяется количеством информации, пере-

данной через сеть или её сегмент в единицу времени.  

Надежность работы вычислительной сети определяется надежностью ра-

боты всех ее компонентов. Для обеспечения надежности, как правило, инфор-

мация в сети храниться в нескольких экземплярах (дублирование информации). 

При передаче информации возможны потери и искажения. Для оценки надеж-

ности исполнения этой функции используются показатели вероятности потери 

пакета при его передаче, либо вероятность доставки пакета.  

Безопасность – это способность сети обеспечить защиту информации от 

несанкционированного доступа. Задачи обеспечения безопасности решаются 

применением специального программного обеспечения, использование более 

безопасной передающей среды в сети.  

Управлением сетью занимается администратор сети, обычный пользова-

тель не имеет административных прав. Администратор сети должен иметь воз-

можность воздействовать на работу любого элемента сети. Управляемость се-

тью – возможность определения проблем в работе вычислительной сети  или 

отдельных ее сегментов, выработка управленческих действий для решения вы-

явленных проблем.  

Расширяемость определяется возможностью добавления новых элементов 
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сети (рабочих станций, служб).  

Масштабируемость сети определяет возможность расширения сети без 

существенного снижения ее производительности. Например, одноранговые се-

ти обладают хорошей расширяемостью, но плохой масштабируемостью.  

Интегрируемость означает возможность подключения к вычислительной 

сети разнообразного и разнотипного оборудования.  

Классификация вычислительных сетей: 

 
Типы передающей среды в компьютерных сетях 

В компьютерных сетях используется два основных вида передающей сре-

ды: кабельный канал связи  и радиосвязь.  

Кабельный вид связи 

Кабельный вид связи используют преимущественно в локальных, чаще ре-

гиональных сетях. Кабели бывают нескольких видов: витая пара проводов, ко-

аксиальный кабель, оптоволоконный кабель.  

Витая пара состоит из двух изолированных проводов, свитых между собой. 

Например, телефонный кабель. Такой вид соединения недорогой. Недостаток 

витой пары - плохая помехозащищенность и низкая скорость передачи инфор-

Компьютерные вычислительные сети

Глобальная вычислительная 
сеть объединяет абонентов, 
расположенных в различных 
странах, на различных конти-
нентах. Взаимодействие меж-
ду абонентами такой сети мо-
жет осуществляться на базе 
телефонных линий связи, ра-
диосвязи и систем спутнико-
вой связи. Глобальные вычис-
лительные сети позволят ре-
шить проблему объединения 
информационных ресурсов 
всего человечества и органи-
зации доступа к этим ресур-
сам. 

Региональная вычисли-
тельная сеть связывает 
абонентов, расположен-
ных на значительном 
расстоянии друг от дру-
га. Она может включать 
абонентов внутри боль-
шого города, экономи-
ческого региона, от-
дельной страны. Обычно 
расстояние между або-
нентами региональной 
вычислительной сети 
составляет десятки - 
сотни километров

Локальная вычислитель-
ная сеть объединяет або-
нентов, расположенных в 
пределах небольшой тер-
ритории. Обычно такая 
сеть привязана к конкрет-
ному месту. К классу ло-
кальных вычислительных 
сетей относятся сети от-
дельных предприятий, 
фирм, банков, офисов и т. 
д. Протяженность такой 
сети можно ограничить 
пределами 2-2,5 км. 
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мации. Существует неэкранированная витая пара и экранированная витая пара. 

Дополнительный защитный слой в экранированной паре делает кабель помехо-

устойчивым, значительно уменьшает электромагнитное излучение. 

                     

 
Коаксиальный кабель по сравнению с витой 

парой обладает большей прочностью, помехоза-

щищенностью. В центре коаксиального кабеля 

находится медный проводник, окруженный тол-

стым слоем изоляционного материала. Второй 

слой сделан в виде оплетки поверх изоляции.  

Оптоволоконный кабель не подвержен действию 

электромагнитных полей. В оптоволоконном кабеле 

для передачи данных используются световые им-

пульсы. Сердечник такого кабеля изготовлен из стек-

ла или пластика. Сердечник окружен слоем отража-

теля, который направляет световые импульсы вдоль 

кабеля путем отражения от стенок. Оптоволоконный кабель более дорогой по 

сравнению с предыдущими типами.  

Радиосвязь 

Каналы радиосвязи используют различные диапазоны передачи данных. В 

радиосвязи передача информации осуществляется от одного ретранслятора к 

другому. Разновидностью радиосвязи является спутниковая связь, в которой 

передача данных осуществляется через спутник. 
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Конфигурация локальных вычислительных сетей 

Существуют следующие конфигурации ЛВС: шинная, кольцевая, звездо-

образная, древовидная. От конфигурации ЛВС зависит, как размещаются або-

ненты сети и как они соединяются между собой.  

Шинной называется такая конфигурация сети, 

при которой к незамкнутому каналу (шине) с не-

которым интервалом подключаются рабочие стан-

ции. Информация от абонента-источника распро-

страняется по каналу в обе стороны.  

В кольцевой сети информация передается по 

замкнутому каналу (кольцу), в большинстве случаев 

только в одном направлении. Каждый абонент не-

посредственно связан с двумя соседними абонента-

ми, но «прослушивает» передачу любого абонента 

сети.  

Звездообразные сети возникли на основе телефонных 

сетей с АТС. В центре звездообразной сети находится 

центральный коммутатор, либо устройство, которое по-

следовательно опрашивает абонентов и предоставляет им право на обмен ин-

формацией.  

Древовидная конфигурация сети образуется 

путем подсоединения нескольких простых шин к 

одной магистральной при помощи мостов или 

шлюзов.  

 

Системное программное обеспечение вычислительных сетей 

Для эффективной работы сетей используются специальные операционные 

системы. Это сетевые операционные системы, которые устанавливаются на 

специально выделенные компьютеры. Признанными лидерами сетевых ОС яв-

ляются Windows NT, Unix.  
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Обработка информации в сети распределена между двумя объектами: кли-

ент (рабочая станция) и сервер. Клиент может запросить с сервера чтение – за-

пись файла, поиск информации и т.д. Сервер выполняет запрос, поступивший 

от клиента. Подобные системы принято называть системами «клиент – сервер».  

В зависимости от распределения функций между компьютерами в сети 

можно выделить одноранговые сетевые ОС и ОС с выделенным сервером.  

Одноранговые ОС используются в одноранговых сетях, для которых  ха-

рактерно: нет единого центра управления и единого устройства для хранения 

данных, сетевая операционная система  распределена по всем рабочим станци-

ям. Достоинства: низкая стоимость и высокая надежность. Недостатки: слож-

ность управления сетью, сложность обеспечения защиты информации, трудно-

сти обновления программного обеспечения, ограниченность количества рабо-

чих станций.  

В сети с выделенным сервером один компьютер выполняет роль сервера. 

На нем устанавливается сетевая операционная система, к нему подключаются 

все внешние устройства. Взаимодействие между рабочими станциями в сети 

осуществляется через сервер. Количество серверов может быть более одного. 

Достоинства: надежная система защиты информации, высокое быстродействие, 

отсутствие ограничений на число рабочих станций. Недостатки: высокая стои-

мость сервера, меньшая гибкость по сравнению с одноранговой сетью.  

 Любая коммуникационная сеть должна включать следующие основные 

компоненты: передатчик, сообщение, средства передачи, приемник. 

Передатчик – устройство, являющееся источником данных. 

Приемник – устройство, принимающее данные. 

Сообщение – цифровые данные определенного формата, предназначен-

ные для передачи. 

Средства передачи – физическая передающая среда и специальная аппа-

ратура, обеспечивающая передачу сообщений. 

Глобальная сеть INTERNET 
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 Internet представляет собой глобальную компьютерную сеть. Само ее на-

звание означает "между сетей". Это сеть, соединяющая отдельные сети. 

Internet обеспечивает обмен информацией между всеми компьютерами, 

подключенными к ней. Тип компьютера и используемая им операционная сис-

тема значения не имеют. 

Существуют компьютеры, самостоятельно подключенные к internet. Они 

называются хост-компьютерами (host – хозяин). 

Каждый подключенный к сети компьютер имеет свой адрес, по которому 

его можно найти. 

Система адресации в Internet 

 Internet самостоятельно осуществляет передачу данных. К адресам стан-

ций предъявляются специальные требования. Адрес должен иметь формат, по-

зволяющий вести его обработку автоматически, и должен нести некоторую ин-

формацию о своем владельце. 

 С этой целью для каждого компьютера устанавливаются два адреса: циф-

ровой IP -адрес(IP - Internetwork Protocol - межсетевой протокол) и доменный 

адрес.  

 Оба эти адреса могут применяться равноценно. Цифровой адрес удобен 

для обработки на компьютере, а доменный адрес - для восприятия пользовате-

лем. 

 Цифровой адрес имеет длину 32 бита. Для удобства он разделяется на че-

тыре блока по 8 бит, которые можно записать в десятичном виде. Адрес содер-

жит полную информацию, необходимую для идентификации компьютера. 

 Два блока определяют адрес сети, а два другие - адрес компьютера внут-

ри этой сети. Существует определенное правило для установления границы 

между этими адресами. Поэтому IP - адрес включает в себя три компонента: 

адрес сети, адрес подсети, адрес компьютера в подсети.  

 Доменный адрес определяет область, определяющую ряд хост - компью-

теров. В отличие от цифрового адреса он читается в обратном порядке. Вначале 

идет имя компьютера, затем имя сети, в которой он находится.  
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 В системе адресов Internet приняты домены, представленные географиче-

скими регионами. Они имеют имя, состоящее из двух букв.  

Пример Географические домены некоторых стран: Франция - fr; Канада - ca; 

США - us; Россия - ru. 

 Существуют и домены, разделенные по тематическим признакам. Такие 

домены имеют трехбуквенное сокращенное название. 

Пример Учебные заведения - edu. Правительственные учреждения - gov. Ком-

мерческие организации - com. 

Службы Internet  

1. Электронная почта (E-Mail).  

2. Списки рассылки (MailList).  

3. Телеконференции (Usenet).  

4. Всемирная паутина WWW.  

5. Служба передачи файлов (FTP).  

6. Chat (разговор) в реальном времени (IRC).  

7. ICQ.  

Проблемы безопасности информации 

Защита информации – контрольные механизмы, препятствующие незакон-

ному использованию ресурсов.  

Проведение финансовых операций с использованием Интернета или дру-

гих сетей, заказ товаров и услуг, использование кредитных карточек, доступа к 

закрытым информационным ресурсам, передача телефонных разговоров тре-

буют обеспечения соответствующего уровня безопасности. Начиная с 90-х го-

дов, Интернет становится мощным средством обеспечения розничного торгово-

го оборота, в нем циркулируют договорные и финансовые обязательства, необ-

ходимость защиты которых как от просмотра, так и от фальсификации, очевид-

на.  

 Конфиденциальная информация, которая передается по сети Интернет, 

проходит через определенное количество маршрутизаторов и серверов, прежде 

чем достигнуть пункта назначения. Существует возможность перехвата инфор-
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мации, более того, информация может быть изменена и перехвачена адресату в 

измененном виде.  

Проблемы, возникающие с безопасностью передачи информации при ра-

боте в компьютерных сетях, можно разделить на следующие типы:  

опасность заражения компьютерным вирусом;  

перехват информации - целостность информации сохраняется, но ее кон-

фиденциальность нарушена;  

модификация информации - исходное сообщение изменяется либо полно-

стью подменяется другим и отсылается адресату;  

подмена авторства информации. Например, кто-то может послать письмо 

от вашего имени или Web-сервер может притворяться электронным магазином, 

принять заказы, номера кредитных карт, но не высылать никаких товаров.  

Под термином "безопасность" подразумевается совокупность трех различ-

ных характеристик:  

1. Аутентификация - процесс распознания пользователя системы и пред-

ставления ему определенных прав и полномочий;  

2. Целостность - идентичность отправленного и принятого;  

3. Секретность - предотвращение несанкционированного доступа к инфор-

мации.  

Методы защиты информации 

1. Антивирусная защита 

Защиту от вирусов можно разделить на два класса: общие и профилактиче-

ские средства. К общим средствам относятся - создание копий файлов и сис-

темных областей дисков и разграничение доступа - предотвращает использова-

ние компьютера без разрешения. Профилактические средства – наиболее об-

ширный класс, к которому относятся антивирусные программы. Антивирусные 

программы разделяются на мониторы и сканеры. Монитор - находится рези-

дентно (постоянно) в оперативной памяти компьютера и сообщает об обнару-

женном вирусе. Сканер - программа, запускаемая пользователем (когда следует 

проверить дисковые накопители) или автоматически (периодическая проверка 
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дисков). Важно, чтобы антивирусные программы, используемые для проверки, 

были самых последних версий. Широко используемые антивирусные програм-

мы - Drweb, AVP, Norton Antivir и др.  

2. Криптография 

Криптография - шифрование, позволяющая трансформировать данные в 

зашифрованную форму, из которой извлечь исходную информацию можно 

только при помощи ключа. Обеспечивает секретность информации.  

В основе шифрования лежат два основных понятия: алгоритм и ключ. Ал-

горитм -  это способ закодировать исходный текст, в результате чего получает-

ся зашифрованное послание. Зашифрованное послание можно интерпретиро-

вать только с помощью ключа.  

Существуют две основные схемы шифрования: симметричное шифрование 

и несимметричное  шифрование.  

При симметричном шифровании отправитель и получатель владеют одним 

и тем же ключом, с помощью которого они могут зашифровать и расшифровать 

данные. Основной недостаток симметричного процесса заключается в том, что 

прежде чем начать обмен информацией, надо выполнить передачу ключа, а для 

этого опять-таки нужна защищенная связь, то есть проблема повторяется, хотя 

и на другом уровне. Если рассмотреть оплату клиентом товара или услуги с 

помощью кредитной карты, то получается, что торговая фирма должна создать 

по одному ключу для каждого своего клиента и каким-то образом передать им 

эти ключи. Это крайне неудобно.  

Поэтому в настоящее время в Интернете используют несимметричное 

шифрование. В данной схеме для шифрования послания используется один 

ключ (открытый), для расшифровки - другой (закрытый, личный). На самом де-

ле это как бы две "половинки" одного целого ключа, связанные друг с другом.  

Ключи устроены так, что сообщение, зашифрованное одной половинкой, 

можно расшифровать только другой половинкой (не той, которой оно было за-

кодировано). Создав пару ключей, торговая компания широко распространяет 

публичный ключ (открытую половинку) и надежно сохраняет закрытый ключ 
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(свою половинку).  

Как публичный, так и закрытый ключ представляют собой некую кодовую 

последовательность. Публичный ключ компании может быть опубликован на ее 

сервере, откуда каждый желающий может его получить. если клиент хочет сде-

лать фирме заказ, он возьмет ее публичный ключ и с его помощью закодирует 

свое сообщение о заказе и данные о своей кредитной карте. После кодирования 

это сообщение может прочесть только владелец закрытого ключа. Никто из 

участников цепочки, по которой передается информация, не в состоянии это 

сделать. Даже сам отправитель не может прочитать собственное послание, хотя 

ему хорошо известно содержание. Лишь получатель сможет прочесть сообще-

ние, поскольку только у него есть закрытый ключ, дополняющий использован-

ный публичный ключ.  

Если фирме надо будет отправить клиенту квитанцию о том, что заказ 

принят к исполнению, она закодирует ее своим закрытым ключом. Клиент 

сможет прочитать квитанцию, воспользовавшись имеющимся у него публич-

ным ключом данной фирмы. Он может быть уверен, что квитанцию ему отпра-

вила именно эта фирма, и никто другой, поскольку никто иной доступа к за-

крытому ключу фирмы не имеет.  

 Число бит в ключе определяет надежность защиты. Например, 8-битный 

ключ допускает 28=256 комбинаций ключей. Если использовать 128 - битный 

ключ, то необходимо будет перебрать 2128 ключей, что в настоящее время не 

под силу даже самым мощным компьютерам.  

Даже если послание зашифровано, все равно остается возможность моди-

фикации исходного сообщения или подмены этого сообщения другим. Защита 

публичным ключом не является абсолютно надежной. Дело в том, что посколь-

ку каждый желающий может получить и использовать чей-то публичный ключ, 

то он может сколь угодно подробно изучить алгоритм работы механизма шиф-

рования и пытаться установить метод расшифровки сообщения, то есть рекон-

струировать закрытый ключ.  

Во многих странах вопрос применения алгоритмов шифровки данных на-
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ходится в поле законодательного регулирования. В частности, в России к ис-

пользованию в государственных и коммерческих организациях разрешены 

только те программные средства шифрования данных, которые прошли госу-

дарственную сертификацию в административных органах, в частности, в Феде-

ральном агентстве правительственной связи и информации при Президенте 

Российской Федерации.  

3. Электронная подпись 

Мы рассмотрели, как клиент может переслать организации свои конфи-

денциальные данные. Точно также он может общаться и с банком, отдавая ему 

распоряжения о перечислении своих средств на счета других лиц и организа-

ций. Однако здесь возникает проблема: как банк узнает, что распоряжение по-

ступило именно от данного лица, а не от злоумышленника, выдающего себя за 

него? Одним из путей решения этой проблемы является передача получателю 

уникальной записи - электронной подписи.  

Принцип ее создания тот же, что и рассмотренный выше. С помощью спе-

циальной программы (полученной от банка) создаются те же два ключа: закры-

тый и публичный. Публичный ключ передается банку. Если теперь надо отпра-

вить поручение банку на операцию с расчетным счетом, оно кодируется пуб-

личным ключом банка, а своя подпись под ним кодируется собственным закры-

тым ключом. Банк поступает наоборот. Он читает поручение с помощью своего 

закрытого ключа, а подпись - с помощью публичного ключа поручителя. Если 

подпись читаема, банк может быть уверен, что поручение ему отправили имен-

но мы, и никто другой.  

4. Сертификация Web-узлов  

При заказе товаров в Интернете важно убедиться, что сервер, принимаю-

щий заказы и платежи от имени некоей фирмы, действительно представляет эту 

фирму. Подтвердить это может сертификат продавца. В сертификате указано, 

когда он выдан и на какой срок. Прежде чем выполнять платежи через Интер-

нет или оправлять данные о своей кредитной карте кому-либо, следует прове-

рить наличие действующего сертификата у получателя путем обращения в сер-
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тификационный отдел. Это называется сертификацией Web-узла. Например, в 

обозревателе Microsoft Internet Explorer 5.0, доступ к центрам сертификации 

осуществляется командой Сервис  Свойства Обозревателя  Содержание  

Сертификатов  Доверенные Корневые Центры Сертификации.  

5. Аутентификация 

Аутентификация является одним из самых важных компонентов организации 
защити информации в сети.  Прежде чем пользователю будет предоставлено право 
получить тот или иной ресурс, необходимо убедится, что он действительно тот, за 
кого себя выдает.  

При получении запроса на использование ресурса от имени какого-либо 
пользователя сервер, представляющий данный ресурс, передает управление серве-
ру аутентификации. После получения положительного ответа сервера аутентифи-
кации пользователю предоставляется запрашиваемый ресурс.  

Одной из схем аутентификации является использование стандартных паро-
лей. Эта схема является наиболее уязвимой с точки зрения безопасности - пароль 
может быть перехвачен и использован другим лицом. Чаще всего используются 
схемы с применением одноразовых паролей. Даже будучи перехваченным, этот 
пароль будет бесполезен при следующей регистрации, а получить следующий па-
роль из предыдущего является крайне трудной задачей.  

Контрольные вопросы 

1. Дать определение компьютерной сети и ее назначения. 

2. Как классифицируются компьютерные сети по территориальному признаку? 

3. Как называются сети, перекрывающие территорию не более 10 м2? 

4. Как называются сети, расположенные на территории города или области? 

5. Как называются сети, расположенные на территории государства или группы 

государств? 

6. Какие типы передающей среды применяются в компьютерных сетях? 

7. Какую топологию используют компьютерные сети? 

8. Что такое сервер? Виды серверов. 

9. Что такое рабочая станция? Виды рабочих станций? 

10. Перечислите основные показатели сети. 

11. Что такое шина, шлюз? 
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12. Системное программное обеспечение вычислительный сетей. 

13. Система адресации в Internet. 

14. Перечислить известные службы Internet. 

15. Перечислить методы защиты информации в сетях. 

Тест для самоконтроля знаний 

1. Компьютерная сеть – это: 

a) группа установленных рядом вычислительных машин, объединенных с по-

мощью средств сопряжения и выполняющих единый информационно-

вычислительный процесс; 

b) совокупность компьютеров и терминалов, соединенных с помощью каналов 

связи в единую систему, удовлетворяющую требованиям распределенной 

 обработки данных; 

c) совокупность сервера и рабочих станций, соединенных с помощью коакси-

ального или оптоволоконного кабеля; 

2. Информационно-вычислительные системы по их размерам подразделяются на: 

a) локальные, региональные, глобальные, широкомасштабные; 

b) терминальные, административные, смешанные; 

c) цифровые, коммерческие, корпоративные; 

3.  Локальная вычислительная сеть – это: 

a) вычислительная сеть, функционирующая в пределах подразделения или 

подразделений предприятия; 

b) объединение вычислительных сетей на государственном уровне; 

c) общепланетное объединение сетей; 

4. Признак «Топология сети» характеризует: 

a) схему приводных соединений в сети (сервера и рабочих станций); 

b) как работает сеть; 

c) состав технических средств; 

5.  Локальные вычислительные сети по признаку «топология» подразделяются на: 

a) реальные, искусственные; 

b) типа «Звезда», «Шина», «Кольцо»; 

c) проводные, беспроводные; 
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6. Программное обеспечение локальной вычислительной сети включает: 
a) сетевую операционную систему, пакеты прикладных программ, базы 
данных; 

b) пакеты прикладных программ, базы данных; 
c) MS-Dos, MS-Windows, NetWare; 

7. Наиболее распространенной операционной системой для локальной вычис-
лительной сети является: 
a) Unix; 
b) MS-DOS; 
c) Windows; 

8. Сервер – это: 
a) персональный компьютер, подключенный к сети, через который пользо-
ватель получает доступ к ее ресурсам; 

b) компьютер, подключенный к сети и обеспечивающий ее пользователей 
определенными услугами; 

c) два или более абонентов вычислительной сети, соединенных каналом 
связи; 

9. Рабочая станция – это: 
a) персональный компьютер, подключенный к сети и выполняющий моду-
ляцию и демодуляцию информации; 

b) персональный компьютер, подключенный к сети, через который пользо-
ватель получает доступ к ее ресурсам; 

c) устройство, выполняющее функции сопряжения ЭВМ с каналом связи; 
10. Шлюз – это: 

a) устройство, позволяющее организовать обмен данными между двумя се-
тями, использующими один и тот же протокол взаимодействия; 

b) устройство, позволяющее организовать обмен данными между двумя се-
тями, использующими различные протоколы взаимодействия; 

c) устройство, соединяющее сети разного типа, но использующее одну опе-
рационную систему. 
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Тема 13. Алгоритмизация и программирование. Модели решения 

функциональных и вычислительных задач. 

Лекция: 

Алгоритм – точное предписание, определяющее процесс перехода от ис-

ходных данных к результату. 

Свойства алгоритма: 

1. Дискретность – алгоритм должен быть разбит на отдельные действия. 

2. Понятность – точное понятие команды. 

3. Определенность – исполнитель алгоритма не должен сомневаться в следую-

щем шаге. 

4. Результативность – по завершению выполнения алгоритма должен быть по-

лучен результат. 

5. Массовость – алгоритм должен быть написан для решения ряда подобных 

задач. 

Способы представления алгоритма: 

− Словесный; 

− Математическая формула; 

− Табличный; 

− Графический (блок - схема) 

Основные элементы блок – схемы: 

 

 

 

 

 

Основные базовые структуры алгоритма  

1. Линейная структура. 

Разработка программы проводится без проверки условий и повторений. 

2. Разветвляющая структура (ветвление). 

Ветвление - это алгоритмическая структура, в которой проверяется неко-

торое условие и в зависимости от результатов проверки выполняется то или 

Начало / Конец Ввод / Вывод Обработка данных Выбор 
Направление 
действия 
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иное действие. Для программирования проверки условия и выбора действия в 

зависимости от этого условия используются условные операторы. 

Условие в языке программирования может принимать два значения: исти-

на (True) и ложь (False). Условие записывается с помощью операций отноше-

ний и логических операций. 

Существует две формы условного оператора: 

1. Полное ветвление (развилка) 

Синтаксис: 
 
  If условие 
    Then оператор1 
      Else оператор2; 
После оператора1 ";" не ставится. 

Действия: Проверяется условие, если оно истинно, т. е. принимает значе-

ние True, то выполняется оператор1, иначе, если условие ложно, т. е. принима-

ет значение False, то выполняется оператор2.  

2. Неполное ветвление 

Синтаксис: 
 
  If условие 
    Then оператор; 

 Действия: Если условие принимает значение True, то выполняется опе-

ратор, иначе никаких действий не происходит. 

3. Циклическая структура (цикл).  

При решении многих задач некоторая последовательность действий при-

ходится выполнять несколько раз. Такие повторяющиеся действия называются 

циклами. 

 1. Оператор цикла с параметром. 

Данный оператор используется, если надо выполнить некоторую последо-

вательность действий несколько раз, причем число повторений заранее извест-

но. 

оператор2 оператор1 

условие 
Да Нет 

оператор 

условие 
Да Нет 
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Синтаксис: 

For параметр цикла:=мл. знач. to ст. знач. do 

For параметр цикла:=ст.. знач. downto мл. знач. do 

Здесь For, to, do – зарезервированные слова (для, до, делать). 

Если параметр возрастает, то между границами его значений ставится to, 

если убывает, то downto. 

Действия: параметру цикла присваивается начальное значение и выполня-

ется тело цикла, затем параметру цикла присваивается следующее значение и 

вновь выполняется тело цикла и так до тех пор, пока не будет перебраны все 

значения параметра цикла. 

Замечание1. Счетчик цикла увеличивается автоматически на единицу.  

Замечание 2. Если в цикле используется более одного оператора, то необ-

ходимо использовать операторные скобки (составной оператор). 

2. Оператор цикла с постусловием. 

Данный оператор используется в программе, если надо провести некото-

рые повторяющиеся вычисления, однако число повторов заранее не известно и 

определяется самим ходом вычисления. 

Синтаксис:  

 

Repeat тело цикла  

Until условие; 

Здесь Repeat,Until – зарезервированные слова (повторять до тех пор, пока 

не будет выполнено условие). 

Действия: сначала выполняются операторы, потом проверяется условие. 

Если оно ложно, то снова выполняются операторы, и так до тех пор, при про-

верке условие не примет значение True. 

Замечание 1. Тело цикла будет выполняться хотя бы один раз. 

Замечание 2. Если в теле цикла используется несколько операторов, то со-

Нет Да 

оператор1 

оператор2 

условие 
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ставной оператор не нужен. 

Замечание 3. Параметр цикла может быть вещественного типа и задается в 

теле цикла. 

3. Оператор цикла с предусловием. 

Данный оператор, как и оператор Repeat,  используется в программе, если 

надо провести некоторые повторяющиеся вычисления, однако число повторов 

заранее не известно и определяется самим ходом вычисления. 

Синтаксис:  

 

While условие Do оператор; 

 

Здесь While, Do – зарезервированные слова (пока выполняется условие де-

лать). 

Действия: сначала проверяется условие, если оно истинно, то выполняется 

тело цикла. Затем снова проверяется условие и т. д. Если условие ложно, то цикл 

завершается и выполняется оператор, стоящий непосредственно после цикла. 

Замечание 1. Если в теле цикла используется несколько операторов, то необ-

ходим составной оператор. 

Замечание 2. Параметр цикла может быть вещественного типа, задается и 

увеличивается пользователем в теле цикла. 

Программирование  - это процесс создания программы, который может быть 

представлен как последовательность следующих шагов: 

− Определение требований к программе; 

− Разработка или выбор алгоритма решения поставленной задачи; 

− Написание команд; 

− Отладка; 

− Тестирование. 

Язык программирования - формальный язык для описания алгоритма реше-

ния задачи на компьютере.  

условие 

оператор 

Да Не
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Уровни языков программирования 

Языки программирования бывают двух уровней: низкого и высокого уров-

ня.  

Языки программирования низкого уровня близки к машинному коду и 

ориентированы на конкретные команды процессора.  

Языком самого низкого уровня является язык ассемблера, который просто 

представляет каждую команду машинного кода, но не в виде чисел, а с помо-

щью символьных условных обозначений, называемых мнемоникой. Каждой 

модели процессора соответствует свой язык ассемблера.  

С помощью языков низкого уровня создаются очень эффективные и ком-

пактные программы, так как разработчик получает доступ ко всем возможно-

стям процессора. С другой стороны, для этого требуется очень хорошо пони-

мать устройство компьютера (отладка больших приложений  затруднена, а ре-

зультирующая программа не может быть перенесена на компьютер с другим 

типом процессора). Подобные языки обычно применяются для написания не-

больших системных приложений, драйверов устройств, когда важнейшими 

требованиями становятся компактность, быстродействие и возможность прямо-

го доступа к аппаратным ресурсам.  

Языки программирования высокого уровня значительно ближе и понятнее 

человеку, для описания алгоритма используется привычная для него форма. 

Особенности конкретных компьютерных архитектур (аппаратных средств) в 

них не учитываются, поэтому создаваемые тексты программ легко переносимы 

на другие платформы, имеющие программу перевода данного языка в машин-

ный код.  

Интерпретаторы и компиляторы  

С помощью языка программирования создается не готовая программа, а 

только ее текст, описывающий ранее разработанный алгоритм. Чтобы получить 

работающую программу, надо этот текст перевести в машинный код. Для этого 

используются программы-трансляторы, которые бывают двух видов: компиля-

торы и интерпретаторы.  



 162

Программа-компилятор переводит исходный текст программы в машин-

ный код и записывает его на диске в виде отдельного бинарного файла (инфор-

мация в машинном коде). При запуске программы исполняется бинарный файл. 

Почти все системы программирования работают с компилятором.  

Программа–интерпретатор работает совместно с исходным текстом. Каж-

дая команда интерпретируется в машинный код и немедленно исполняется. 

Файл на машинном языке не создается. Программа, написанная в системе про-

граммирования, включающая интерпретатор, работает медленно. Поэтому ин-

терпретаторы не нашли широкого применения.  

В настоящее время с интерпретатором работают в основном языки про-

граммирования для Интернета. Например, с интерпретатором работает Java, 

Perl.  

 Поколения языков программирования  

1-е поколение составляют языки, созданные в начале 50-х ггов, когда пер-

вые компьютеры только появились на свет. Это был первый язык ассемблера, 

созданный по принципу «одна инструкция – одна строка».  

2-е поколение составляют языки программирования конца 50-х – начала 

60-х гг. Тогда появился символический ассемблер, в котором существовало по-

нятие переменой. Он стал полноправным языком программирования.  

3-е поколение языков программирования относится к 60-м гг. В это время 

родились универсальные языки высокого уровня, с помощью которых появи-

лась возможность решать задачи из любых областей. Такие качества языков 

программирования высокого уровня как относительная простота, независи-

мость от конкретного компьютера и возможность использования алгоритмиче-

ских конструкций позволили резко повысить производительность труда про-

граммистов. Подавляющее большинство языков программирования этого поко-

ления успешно применяется и сегодня.  

4-е поколение языков программирования предназначено для реализации 

крупных проектов, повышена их надежность и скорость создания. 4-е поколе-

ние началось в 70-х гг. и продолжается до настоящего времени. Как правило, 
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языки 4-го поколения имеют мощные функции (операторы, команды), для реа-

лизации которых  на языках поколения младшего уровня потребовалось бы ты-

сячи строк.  

5-е поколение языков программирования появилось в середине 90-х гг. К 

ним относятся системы автоматического создания прикладных программ с по-

мощью визуальных средств разработки, без знания программирования. Инст-

рукции вводятся в компьютер в максимально наглядном виде с помощью мето-

дов, наиболее удобных для человека, не знакомого с программированием.  

Обзор языков программирования высокого уровня 

Fortran (Фортран) – это компилируемый язык, созданный в 50-е гг. Этот 

язык появился первым после языка ассемблера, поэтому удобство создания 

программы не так хорошо реализовано, как возможность получения эффектив-

ного машинного кода. В 2000 г. выпущен Фортран F2k.  

Cobol (Кобол) – компилируемый язык, разработанный в начале 60-х гг. для 

применения в экономической области и решения бизнес-задач. Отличается 

большой «многословностью»  его операторы иногда выглядят как обычные 

английские фразы. Очень распространен среди программистов США.  

 Algol (Алгол) – компилируемый язык, созданный в 1960 г. Он был при-

зван заменить Фортран, но из-за более сложной структуры не получил широко-

го распространения.  

Pascal (Паскаль) – создан  в конце 70-х гг. Во многом напоминает Алгол, 

но в нем ужесточены требования к структуре программы, за счет чего структу-

ра стала более наглядной и простой. Паскаль удобен для получения азов про-

граммирования, но также успешно применяется при создании крупных проек-

тов.  

Basic (Бейсик) – создавался в 60-х гг. в качестве учебного языка и очень 

прост в изучении. Для него имеются интерпретаторы и компиляторы.  

C (Си) – создан в лаборатории Bell и первоначально планировался для за-

мены ассемблера. Имеет возможность создавать эффективные и компактные 

программы, в то же время не зависеть от конкретного типа процессора. Си во 
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многом похож на Паскаль и имеет дополнительные средства для прямой рабо-

ты с памятью. В 1980 г. создано объектно–ориентированное расширение языка 

Си – С++(Си++).  

Java (Джава, Ява) – язык, созданный компанией Sun в начале 90-х гг. на 

основе Си++. Главная особенность этого языка – компиляция не в машинный 

код, а в платформенно-независимый байт-код (каждая команда занимает 1 

байт). Этот байт-код выполняется с помощью интерпретатора – визуальной 

Java–машины, версии которой существуют сегодня для любой платформы.   

Благодаря наличию множества Java–машин, программы легко переносятся на 

уровне двоичного байт-кода. Сегодня язык Ява очень популярен. Пока основ-

ной его недостаток – невысокое быстродействие, так как язык Ява интерпрети-

руемый.  

Языки программирования баз данных – язык структурированных запросов 

SQL. Основан на мощной математической теории и позволяет выполнять эф-

фективную работу, манипулируя не отдельными, а группами записей. Для 

управления большими базами данных используются СУБД. Практически в ка-

ждой СУБД, помимо поддержки языка SQL, имеется свой уникальный язык, 

ориентированный на особенности этой СУБД: Microsoft, IBM, Oracle, Software.  

Языки программирования для Интернет отличаются характерными осо-

бенностями: являются интерпретируемыми, интерпретаторы для них распро-

страняются бесплатно, а сами программы в исходных текстах. Такие языки на-

зываются скрипт-языками. Примерами языков программирования для Интернет 

являются НТМL, Perl, Tcl/Tk, VRML.  

Логические языки программирования используются в области создания 

искусственного интеллекта. Наиболее распространены Пролог, Ада.  

Системы программирования 

Для написания программы на языке программирования необходимо иметь 

на компьютере установленную соответствующую систему программирования.  

Системы программирования  хорошо интегрированная система, вклю-

чающая как минимум:  
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− специализированный текстовый редактор (для написания текста програм-

мы);  

− компилятор для перевода текста программы в машинный код (в редких слу-

чаях  интерпретатор);  

− библиотека функций (подключенные модули);  

− редактор связей для связывания модулей (файлов с исходными текстами) и 

стандартных функций, находящихся в библиотеках;  

− исполнимый код - законченную программу с расширением .COM или .EXE, 

которую можно запустить  на любом компьютере, где установлена операци-

онная система, для которой эта программа  создавалась;  

− справочную систему;  

− отладчик, позволяющий анализировать работу программы во время ее вы-

полнения по шагам.  

В последние несколько лет в программировании (особенно в программи-

ровании для операционной системы Windows) наметился так называемый визу-

альный подход. Он облегчает создание графических приложений, в таких сис-

темах имеется множество стандартных элементов управления и контроль за их 

работой. Подобные системы программирования называются средами быстрого 

проектирования RAD-среды.   

Наиболее популярны следующие визуальные среды быстрого проектиро-

вания программ для Windows: Basic: Microsoft Visual Basic, Pascal: Borland Del-

phi, C++: Borland C++ Bulider, Java: Symantec Café.  

 Этапы решения функциональных вычислительных задач  

1. Формулируются  и анализируются требования к проекту. Этот этап самый 
важный, так как неправильная постановка цели проекта заставляет выполнять не-
нужную работу. На данном этапе определяются входные данные (их количество 
должно быть минимально), тип этих данных, результирующие (выходные данные) 
и их приблизительная оценка. На основе требований по разным методикам опре-
деляется примерный объем проекта и его трудоемкость, рассчитываются будущие 
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трудозатраты и определяется его стоимость (если речь идей о программном про-
дукте).  
2. Выбирается методология разработки программы. Используя метод структур-
ного программирования, решаемую основную задачу разбивают на отдельные 
подзадачи, которые могут быть объединены в модули. При использовании RAD-
средств проектируется интерфейс пользователя, определяются объекты управле-
ния программой, события и реакция на эти события. Выбираются события и опре-
деляются подзадачи, которые при этом событии будут решаться. 
3. Алгоритмизация. Разработка алгоритмической структуры каждой подзадачи.  

4. Программирование. Реализация конкретной подзадачи на языке программи-
рования, возможно в виде реакции на событие. 
5. Тестирование и отладка. Когда программа закончена (готова работоспособ-
ная альфа-версия), она тестируется. Тестирование – обнаружение ошибок. Ис-
правляются синтаксические ошибки, ошибки программы. Задавая входные дан-
ные, полученный результат сравнивают с ожидаемым, в случае расхождения 
приступают к отладке. Анализируются, в частности, устойчивость работы про-
граммы при вводе недопустимых или критических значений, при отсутствии 
информации (не указании данных), при неверных действиях. Когда число оши-
бок становиться минимальным, начинается бета-тестирование. К такому тести-
рованию привлекаются максимально возможное число сотрудников, и про-
грамма уже начинает частично функционировать в рабочем режиме. 
6. Исполняемая программа. Для программы необходимо подготовить сопро-
вождение – справочную информацию о разработчике,  назначение и правила 
работы с программой. 
7. Контроль качества. На этапе тестирования и отладки нельзя дать стопро-
центную гарантию качества программы. Чем крупнее проект, тем больше в нем 
ошибок. Предусматривается непрерывный, сквозной контроль качества за про-
граммой: вносятся изменения, конфигурируется новыми решаемыми подзада-
чами – выпускается новая обновленная версия. В ходе функционирования про-
граммы постоянно должны появляться новые версии (раз в 2-3 года) для под-
держания спроса и удовлетворения потребностей на возникающие новые ре-
шаемые задачи в рамках программы.  
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Контрольные вопросы 

1. Понятие алгоритма. 

2. Свойства алгоритма. 

3. Способы представления алгоритма. 

4. Основные алгоритмические структуры. 

5. Язык программирования. Уровни языков программирования. 

6. Интерпретаторы и компиляторы. 

7. Языки программирования высокого уровня. 

8. Системы программирования. 

9. Этапы решения функциональных вычислительных задач. 

Тест самоконтроля знаний 

Вариант №0 

1. Программы-компиляторы служат для: 

a) автоматического перевода программы в машинный код и последующего 

её использования без исходного текста; 

b) анализа структуры очередного оператора языка из текста программы и 

его исполнения перед переходом к следующему оператору языка; 

c) написания текста программы с возможностью определения синтаксиче-

ских ошибок; 

2. Выберите верное высказывание: 

a) алгоритм имеет свойство дискретность, означающее разбиение алгоритма 

на конкретные действия; 

b) алгоритм имеет свойство специфичность, обозначающее, что алгоритм 

составляется для одной задачи; 

c) алгоритм имеет свойство результативность, означающее, что после вы-

полнения алгоритма должен быть получен графический результат. 

3. К языкам программирования высокого уровня относятся: 
a) Pascal, Basic, Cи++, Ассемблер; 
b) Pascal, Basic, Ассемблер, Access; 
c) Basic, Cи++, Pascal, Java. 
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4. Алгоритм – это: 
a) точное предписание, определяющее процесс перехода от исходных данных к 

результату; 
b) требования, предъявляемые к программе; 
c) проведение расчетов и анализ результатов; 

5. Условие – это: 
a) выражение логического типа; 
b) повторяющиеся команды; 
c) все ответы верны; 

6. Язык программирования низкого уровня – это: 
a) не учитывают особенности конкретных компьютерных архитектур и позво-
ляют разрабатывать программы с помощью понятных для пользователя ко-
манд; 

b) языки, операторы которых близки к машинному коду и ориентированы на 
конкретные команды процессора; 

c) представляют собой комплект программ, обеспечивающий возможности ра-
боты на компьютере; 

7. Выберите верное высказывание: 
a) каждый алгоритм решения задачи имеет входные и выходные данные; 
b) каждый алгоритм содержит в себе разветвляющиеся и циклические структу-

ры; 
c) не всякий алгоритм можно представить в виде блок-схемы; 

8. Выберите верное высказывание: 
a) алгоритм имеет свойство дискретность, означающее разбиение алгоритма на 

конкретные действия; 

b) алгоритм имеет свойство специфичность, обозначающее, что алгоритм со-

ставляется для одной задачи; 

c) алгоритм имеет свойство результативность, означающее, что после выпол-

нения алгоритма должен быть получен графический результат; 

9. Выберите верное утверждение  

a) не верна; 

b) полного ветвления; 

c) неполного ветвления; 
оператор 

условие 
-+
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10. Цикл в фрагменте программы будет исполнен: 

a) 1 раз; 

b) 4 раза; 

 c)  5 раз; 

P:=4; 
Repeat  
P:=P*0.1; 
Until P<0.0001; 

11. Условие принадлежности точки фигуре:  

a) (sqr(x)+sqr(y)<4) and (x>=0); 

b) (sqr(x)+sqr(y)<=4) or (y<>0); 

c) (x>0) and (x<2) and (y>-2) and (y>2); 

12. 12. a:=3; t:=1; For i:=1 to 5 do t:=t*a;  

a) блок программы вычисления 5!; 

b) блок программы вычисления a в 5 степени; 

c) блок программы вычисления суммы ряда a+2a+3a+4a+5a. 

Итоговый контроль знаний 

Теоретическая часть 

Вариант №0 

1.  Windows 98 – это: 

a) оболочка операционной системы; 

b) драйвер; 

c) операционная система; 

2.  К какой категории относится программа «Корзина»: 

a) программам утилитам; 

b) системам программирования; 

c) программам драйверам; 

3.  Папка – это: 

a) поименованная область на магнитном диске, где хранятся тексты программ 

и документов; 

b) специальное место на магнитном диске, где хранятся имена файлов, сведе-

ния о размере файлов, о дате создания и времени их обновления, а также ат-

рибуты файлов; 

c) это содержание файла; 
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4.  Имена файлов в windows не должны: 

a) превышать 8 символов; 

b) содержать буквы русского языка ; 

c) превышать 255 символов; 

5.  Что хранится в файлах: 

a) числа; 

b) любая информация; 

c) тексты и изображения; 

6.  Текст, отформатированный специальным образом в редакторе Word, называет-

ся: 

a) абзац; 

b) стиль; 

c) шаблон; 

7.  Шрифт – это: 

a) набор специальных символов русского и английского алфавитов, отобра-

жаемых определенным образом; 

b) набор букв и цифр русского алфавита; 

c) набор букв, цифр, специальных символов, знаков препинания, отображае-

мых определенным образом; 

8.  Укажите пункт, который не принадлежит меню  Word 97: 

a) Файл; 

b) Таблица; 

c) Переход; 

9.  Файл документа  Word 97 имеет расширение: 

a) .txt; 

b) .doc; 

c) .dot; 

10.  На панели форматирования  Word 97 находятся кнопки: 

a) открыть, сохранить, просмотреть; 

b) вырезать, копировать, вставить; 

c) жирный, курсивный, подчеркнутый; 
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11.  Для задания диапазона ячеек в табличном процессоре Excel два требуемых ад-

реса необходимо разделить: 

a) двоеточием; 

b) тире; 

c) многоточием (тремя точками); 

12.  Для создания графика или диаграммы в табличном процессоре Excel или 

необходимо задать: 

a) диапазоны, где находятся требуемые данные; 

b) режим автоматического поиска требуемых данных для построения; 

c) функцию вызова графического модуля; 

13.  В табличном процессоре Excel операции вставки, удаления и перемещения 

строк и столбцов приводит: 

a) к автоматическому изменению индексов строк и столбцов в ячейках; 

b) к автоматическому добавлению, удалению и перемене мест индексов в 

ячейках; 

c) автоматическому добавлению, удалению и  изменению расположения 

символов доллара перед индексами в ячейках; 

14.  Для суммирования содержимого ячеек А1 и В1 необходимо ввести форму-

лу: 

a) аА1+В1; 

b) $A1+$B1; 

c) =A1+B1; 

15.  Формулу =В3$A$1, хранящуюся в ячейке С3, необходимо скопировать в 

ячейку С4. правильная запись формулы, которая будет храниться в ячейке 

С4 после копирования: 

a) =B4*$A$1; 

b) =B4*$A$2; 

c) =B3*$A$1; 
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Практическая часть 

Вариант 0 
1. Создать на диске С: папку Ответ1. В папке Ответ1 создать папку Отчет. 
2. Создать в папке Отчет документ формата MS Word. Напечатать текст: В ка-
честве инструментария можно использовать следующие распространенные 
виды программных продуктов для персонального компьютера: текстовый 
процессор (редактор), настольные издательские системы, электронные таб-
лицы, системы управления базами данных, электронные записные книжки, 
электронные календари, информационные системы функционального назна-
чения (финансовые, бухгалтерские, для маркетинга и пр.), экспертные систе-
мы и т. д. 

3. Сохранить созданный файл под именем Файл1 в папке Отчет. 
4. Скопировать два раза напечатанный текст в этот же документ ниже первого 
абзаца. 

5. Сделать так, чтобы второй и третий абзацы начинались с новой страницы. 
6. Отформатировать текст на первой странице следующим образом : 

Формат абзаца: выравнивание – по ширине, отступ – слева 1 см, справа: 1 
см, первая строка – выступ на 1,5 см, интервал – перед: 5, межстрочный интер-
вал – одинарный. Формат шрифта: шрифт – Arial, начертание – ПК, размер – 12. 
7. Разбить текст на второй странице на шесть колонок. 
8. На третей странице разбить текст на отдельные предложения и оформить их 
в виде маркированного списка. 

9. Вставить номера страниц внизу страницы, выравнивание – справа. 
10. Сохранить измененный файл с именем Файл2 в папке Ответ1. 
11. Открыть программу MS Excel и создать следующую таблицу: 

№ Название Цена Количество Розничная 
цена 

Чистая 
прибыль 

1 Диод Д- 9 0,10р. 2000   
2 Джойстик 50,99р. 15   
3 Мышь 490,00р. 48   
4 Монитор 1290,00р. 48   
5 Клавиатура 899,00р. 48   

 Сумма    р.

 Посчитать розничную цену: розничная цена больше цены на 10 процентов. 
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 Посчитать чистую прибыль: (Розничная цена-Цена)*Количество. 

 Посчитать сумму по столбцу Чистая прибыль. 

12. Построить диаграмму, отражающую розничную цену товаров. Дать заглавие 

диаграмме (цвет шрифта названия диаграммы – синий). На диаграмме указать 

подписи данных. 

13. Переименовать лист в Товары. 

14. Сохранить созданный файл с именем Файл3 в папке Отчет. 

15. Скопировать созданную таблицу в Файл2 ниже текста. 

16. Сохранить файл (текст + таблица) под именем Результат в папке Ответ1. 

2.4. Распределение учебного времени. 

2 семестр 
Лекции Лабораторные работы 

1 2 3 4 

Тема Кол-во 
часов Тема Кол-во 

часов 
Информатика как наука. Инфор-
мация. Современное представление 
информации 

2 
Рабочий стол Windows. Работа с 
окнами 2 

Системы счисления 0,5 Стандартные программы. Работа 
с папками и файлами 2 

Аппаратное обеспечение персо-
нального компьютера. Технические 
средства реализации информацион-
ных процессов 

2 

Программа «Поиск». Программа 
«Проводник» 
 2 

Программное обеспечение персо-
нального компьютера 2 Операционная оболочка Total 

Commander 4 

Компьютерная графика 0,5 Создание текстового документа 2 
Файловая система. Norton-подоб-
ные оболочки 1 Форматирование текстов 2 

Windows: диалог «человек-компью-
тер» 1 Создание таблиц и схем 2 

Word: форматирование различных 
текстов 1 Списки, стили, оглавления 

 2 

Excel: частотный и графический 
анализ данных 1 Язык и статистика: редактирова-

ние формул 2 

PowerPoint: презентация различных 
исследований 1 Знакомство с электронной табли-

цей  2 

Базы данных 2 Создание простейшей таблицы 2 
Локальные и глобальные сети 
ЭВМ. Методы защиты информации 2 Ввод и редактирование данных. 

Формат данных 2 
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Алгоритмизация и программиро-
вание. Модели решения функции-
ональных и вычислительных задач 

2 
Адресация. Вычисления в табли-
цах 
 

4 

Сортировка данных и формати-
рование таблиц 2 

Графический анализ данных 2 
Создание презентаций 10 
Создание таблиц базы данных 2 
Работа с формами 4 

  

Формирование запросов и отче-
тов для отдельных таблиц базы 
данных 

4 

ИТОГО 18  54 

2.5. Вопросы для самостоятельной работы. 

Тема 
Кол-во ча-

сов 
Тенденция развития ЭВМ 3 
Кодирование информации 3 
Поколения и виды ЭВМ. История развития и перспективы 2 
Роль информации в современном обществе 2 
Задачи и роль специалиста в области туризма в информационном обществе 3 
Компьютерные вирусы и способы защиты от них 3 
Информационная культура специалиста в области туризма 2 
Перспективы применения новых информационных технологий в профессио-
нальной деятельности специалиста в области туризма 

3 

Программы-архиваторы: виды, принцип работы, преимущества и недостатки 2 
Программа работы с изображения Adobe Photoshop 3 
Программа работы с изображениями Corel Draw 3 
Сущность и основные задачи информационного поиска 4 
Необходимость защиты информации 4 
Физические методы защиты информации 4 
Программные методы защиты информации 4 
Защита личной информации пользователя в компьютерных системах 2 
Защита конфиденциальной информации в компьютерных системах 4 
Выбор сервера, предоставляющего права бесплатного доступа к работе с элек-
тронной почтой 

4 

Проблемы, современное состояние и тенденции, новые возможности и пер-
спективы информационной цивилизации 

4 

Искусственный интеллект и интеллектуализация компьютерных систем 4 
ИТОГО 63 
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 2.7. Вопросы для подготовки к экзамену. 

1. Студент допускается к экзамену при условии посещения всех лекцион-

ных и лабораторных занятий. 

2. Итоговая оценка по дисциплине рассчитывается по формуле: 0,4x+0,6y, 

где х – средняя оценка, полученная в результате выполнения текущих форм 

контроля, у – результат итогового зачета (экзамена). 

 

1. Информатика как наука. Этапы развития информатики. 

2. Направления в информатике. 

3. Информация, её виды, свойства, измерение. 

4. Системный блок, его внутреннее устройство. 

5. Процесс обработки информации. 

6. Устройства памяти. Типы памяти и их назначение. 

7. Периферийные устройства ЭВМ, их назначения. 

8. Разновидности принтеров и их характеристика. 

9. Программное обеспечение. Классификация ПО. 

10. Прикладное программное обеспечение, основные направления. 

11. Системное ПО. 

12. Программирование. Понятие языков программирования и их классификация. 

Компилятор. Транслятор. Системы программирования. 

13. Основные понятия теории алгоритмов, способы описания алгоритмов. 

14. Структуры алгоритмов (линейная, ветвление, циклическая, подпрограммы). 

15. Основные этапы решения задач на ЭВМ. 

16. База данных. Основные понятия БД. Классификация. 

17. Системы управления базами данных (СУБД). Модели СУБД. Достоинства и 

недостатки. 

18. Компьютерный вирус. Основные виды. Пути проникновения вирусов. 

19. Антивирусные программы. Меры по защите от вирусов. 

20. Компьютерные сети, основные понятия (протокол, сервер, рабочая станция и 

т.д.). 
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21. ЛВС. Возможности и компоненты. 

22. Топологии ЛВС. Сетевые кабели. 

23. История возникновения сети Интернет. Компоненты Интернет. Адресация в 

Интернет.  

24. Службы Интернет: электронная почта, телеконференции, списки рассылки, 

ICQ, WWW. 

25. HTML – документы: понятие, структура, создание. 

26. Защита информации. Методы защиты информации в сети. 

27. Операционная система. Назначение и основные понятия (файл, каталог, ди-

ректория). 

28. Понятие операционных оболочек. Norton – подобные оболочки: работа с па-

нелями информационного окна, управление пакетом с помощью функцио-

нальных клавиш и ниспадающего меню. 

29. Основные концептуальные особенности операционной системы Windows 

95/98/2000. Виды меню, типы окон в Windows. Обмен данными между при-

ложениями. 

30. Сервисное программное обеспечение. Служебные программы Windows. 

31. Windows. Программа проводник. Программа Поиск. 

32. Обзор программных продуктов Microsoft Office. 

33. Виды текстовых редакторов. Текстовый редактор Word, назначение и основ-

ные функции программы. 

34. Word 97. Понятие шрифта, абзаца, страницы. Их параметры, 

форматирование. 

35. Word  97. Стили. Создание оглавлений с использованием стандартных и не-

стандартных стилей. 

36. Word 97. Создание комплексных текстовых документов (создание художест-

венных заголовков WordArt, Microsoft ClipArt, диаграмм Microsoft Organiza-

tion Chart 2.0., формул Microsoft Equation 3.0., работа с таблицами). 

37. Табличные процессоры. Электронная таблица Excell, назначение и основные 

функции программы.  
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38. Excel. Основные понятия (книга, лист, столбец, ячейка, адресация диапазона 

ячеек). Данные, хранимые в ячейках  ЭТ. Форматирование данных. 

39. Excel. Использование формул и функции при расчетах. Примеры. 

40. Excel. Графические возможности (построение диаграмм, форматирование 

диаграмм). 

41. База данных. Модели базы данных. Основные элементы и объекты базы дан-

ных. Типы связей. 

3. Варианты экзаменационных билетов. 

БИЛЕТ № 1 

1. Информатика - это … Основная задача информатики … 

2. Информация – это …Формы передачи информации… 

3. К основному аппаратному обеспечению компьютера относятся … Микропро-

цессор расположен …, выполняет функции: …. Включает в себя …. 

4. Зарисовать схему запоминающих устройств ПК. 

5. Операционная система – это … ОС можно квалифицировать по следующим 

признакам. 

6. Каталог – это …, привести примеры. 

7. Задайте маску файлам: а) созданным в программе Excel; б) текстовым фай-

лам, начинающимся на букву T.  

8. База данных – это … Классификация БД. 
9. Метод защиты информации криптография позволяет…Криптография бывает 

двух видов…Пример использования закрытого и публичного ключа. 

10. В Excel в ячейке С1 записана формула: =A$1+$B2. Переместите формулу в 

ячейки D2, E4. 

11. В ЭТ в клетку В1 занесено выражение:  

ЕСЛИ(А1<10,2,ЕСЛИ(А1<15,3,ЕСЛИ(А1<20,4,5))) 

При каких значениях содержимого клетки значение клетки В1 равно 4? Объяс-

нить. 

12. Дана база данных сотрудников. Найти средний доход сотрудников. В столбец 

«Вывод» для каждого сотрудника вывести с помощью функции ЕСЛИ фразу 

«выше» или «ниже» его доход по сравнению с прожиточным минимумом. 
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Средний доход 
Прожиточный минимум 4200 р.   

ФИО Доход 
Количество человек 

на содержании 
Вывод 

Иванов О.П. 8000 р. 3  
Арбузова П.Г. 18060 р. 4  
Зайцева К.В. 14600 р. 4  
Бубнов П.У. 15310 р. 2  
Ясман В.Р 21420 р. 4  
Седова К.Л. 9400 р. 5  
Донцов П.П. 8500 р. 1  

СРЕДНЕЕ    

БИЛЕТ № 2 

1. Информация – это …. Виды информации: …. Единицы измерения информации. 

2. Классификация ЭВМ. 

3. АЛУ предназначено … Математический сопроцессор необходим для … 

4. Накопители на жестких магнитных дисках. 

5. Операционная оболочка – это … ОО относится к классу программного обес-

печения… 

6. Файл – это …. Имя файла формируется …. Назовите 6 известных вам рас-

ширений и их обозначение. 

7. Задайте маску файлам: а) созданным в программе Word, б) графическим 

файлам, имеющим в имени 5 символов, первый - T.  

8. База данных – это … Структурные элементы БД. 

9. Рабочая станция компьютерной сети служит для …, например …. Рабочие 

станции бывают 3-х видов: … 

10. В Excel в ячейке С3 записана формула: =$A2 - C$2. Переместите формулу в 

ячейки D3, E4. 

11. В ЭТ в клетку В4 занесено выражение: ЕСЛИ(NOT(OR(А4<2,А4>=5)),0,1). 

При каких значениях содержимого клетки А4 значение клетки В4 равно 1? 

Объяснить. 

12. В таблице представлены данные курса USD в декабре месяце. Рассчитать 

среднемесячное значение курса USD. По вычисленной разнице текущего и 
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среднего курса вывести с помощью функции ЕСЛИ фразу «понижение кур-

са»  или «повышение курса». 

Курс валюты 
Дата Курс USD Разность Итог 

01 дек 06 $30,40   
02 дек 06 $30,20   
03 дек 06 $30,12   

…    
31 дек 06 $29,36   
СРЕДНЕЕ    

БИЛЕТ № 3 

1. Информационное общество – это … 

2. Классификация информации по различным признакам. 

3. Внутренние ЗУ представлены … Они предназначены …. 

4. Накопители на гибких магнитных списках. 

5. Операционная система - это ... Наиболее известны операционные системы … 

6. Файловая система – это … 

7. Задайте маску файлам: а) выполняемым программам; б) текстовым файлам, в 

имени которых третий символ R. 

8. Модель данных – это … Иерархическая модель данных. 

9. Метод защиты информации аутентификация позволяет …. Аутентификация 

бывает двух видов …. 

10. В Excel в ячейке С2 записана формула: =$A2 - C$2. Переместите формулу в 

ячейки D3, E4. 

11. Значения клеток А2 и А3 равны соответственно 7 и 12. В клетку В2 занесено 

выражение: ЕСЛИ(AND(А2>1,А2<10),1,0). В клетку В3 занесено выражение: 

ЕСЛИ(OR(А3<=1,А3>8),0,1). Чему равно значение клетки D3? Объяснить. 

12. Известна цена холодильника в 2006 году и ежегодное увеличение цены в % к 

предыдущему году. Рассчитать прогнозную цену до 2010 года и среднюю цену. 
Ежегодное увеличение цена 3,5% 
Года Цена холодильника марки 12.2435.12 
2006 10230 р. 
2007  
2008  
2009  
2010  
Средняя цена  
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БИЛЕТ № 4 

1. Информатика – это… Главная функция информатики заключается … 

2. Информация – это … 

3. Накопители на оптических дисках. 

4. Устройства ввода информации. 

5. Операционная оболочка - это …Наиболее известны операционные оболочки. 

6. Элементами операционной системы являются: … (6 элементов). 

7. Задайте маску файлам: а) созданным в программе Блокнот; б) файлам, 

имеющим в расширении вторую букву X. 

8. При построении баз данных используются три модели…. Реляционная мо-

дель представляет ….  

9. Электронная служба в Интернет позволяет … (3 функции). Адрес электрон-

ного ящика состоит из частей…  

10. В Excel в ячейке B2 записана формула: =A$1 - $B1. Переместите формулу в 

ячейки D3, C4. 

11. В ЭТ в клетку В4 занесено выражение: ЕСЛИ(AND(NOT(А4<2),А4<5),1,0). 

При каких значениях содержимого клетки А4 значение клетки В4 равно 1? 

Объяснить. 

12.  В представленной таблице рассчитать процент работ на «отлично». В поле 

«Вывод» определить «выше среднего» или «ниже среднего» количество от-

личников в группах. 
 Итоги контрольного среза   
Группа Всего сдавало Сдали на «отлично» % работ на «отлично» Вывод 

242 31    
243 24    
244 23    
245 34    
246 27    

Среднее     

БИЛЕТ № 5 

1. Информация – это … Минимальной единицей информации является 

…Свойства информации. 

2. Этапы развития информатики. 
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3. К внешним ЗУ относятся … Их значение для современных компьютеров равно. 

4. При форматировании диск делится на …. Кластер - это …. FAT16, FAT32 

различаются …  

5. Компьютерный вирус – это … Признаки появления вирусов. 

6. Файл – это … «Маски» в именах файлов. Привести примеры. 

7. Задайте маски файлам: а) созданным в программе Paint; б) файлам, имею-

щим в имени вторую букву З. 

8. База данных – это… Сетевая модель данных. 

9. Гипертекстовые документы – это …. Для поиска информации по ключевому 

слову в WWW  используются …., например, … 

10. В Excel в ячейке С2 записана формула: =A$1 - $B1. Переместите формулу в 

ячейки D3, Е4. 

11. В ЭТ в клетку В1 занесено выражение:  

ЕСЛИ(А1<10,2,ЕСЛИ(А1<15,3,ЕСЛИ(А1<20,4,5))) 

При каких значениях содержимого клетки значение клетки В1 равно 4? 

Объяснить. 

12. Дана база данных сотрудников. Найти средний доход сотрудников. В стол-

бец «Вывод» для каждого сотрудника вывести с помощью функции ЕСЛИ 

фразу «выше» или «ниже» его доход по сравнению с прожиточным мини-

мумом. 

Средний доход 
Прожиточный минимум 4200 р.   

ФИО Доход 
Количество человек 

на содержании 
Вывод 

Иванов О.П. 8000 р. 3  
Арбузова П.Г. 18060 р. 4  
Зайцева К.В. 14600 р. 4  
Бубнов П.У. 15310 р. 2  
Ясман В.Р 21420 р. 4  
Седова К.Л. 9400 р. 5  
Донцов П.П. 8500 р. 1  

СРЕДНЕЕ    
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БИЛЕТ № 6 

1. Основные направления информатики. 

2. Информационная система – это …, информационная технология – это … 

3. Устройства вывода информации. 

4. Назначение генератора тактовых импульсов. 

5. Компьютерный вирус – это … Классификация компьютерных вирусов. 

6. Основными элементами операционной системы MsDos являются … 

7. Задайте маски файлам: а) графическим файлам; б) файлам, начинающимся 

на букву W, и имеющим в расширении два символа. 

8. Компьтерная сеть – это … Классификация вычислительных сетей. 

9. Адаптер, шина предназначены …. 

10. В Excel в ячейке B2 записана формула: =B$1 + $C1. Переместите формулу в 

ячейки D3, Е4. 

11. В ЭТ в клетку В4 занесено выражение: ЕСЛИ(NOT(OR(А4<2,А4>=5)),0,1). 

При каких значениях содержимого клетки А4 значение клетки В4 равно 1? 

Объяснить. 

12. В таблице представлены данные курса USD в декабре месяце. Рассчитать 

среднемесячное значение курса USD. По вычисленной разнице текущего и 

среднего курса вывести с помощью функции ЕСЛИ фразу «понижение кур-

са»  или «повышение курса». 

Курс валюты 
Дата Курс USD Разность Итог 

01 дек 06 $30,40   
02 дек 06 $30,20   
03 дек 06 $30,12   

…    
31 дек 06 $29,36   
СРЕДНЕЕ    

БИЛЕТ № 7 

1. Информатика – это … Этапы развития информатики. 

2. Классификация ПК. 
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3. Системная шина – это … Обеспечивает три направления передачи информа-

ции … 

4. Зарисуйте схему классификации программного обеспечения. 

5. Антивирусная программа – это … Виды антивирусных программ. 

6. Драйверы устройств – это …  

7. Задайте маску файлам: а) созданным в программе Word; б) графическим 

файлам, начинающимся на букву T. 

8. База данных – это … Типы связей между данными в реляционной модели 

данных.  

9. Интернет - это …. Интернет имеет следующие службы: ….. 

10. В Excel в ячейке С3 записана формула: =A$1+$B2. Переместите формулу в 

ячейки D2, E4. 

11. Значения клеток А2 и А3 равны соответственно 7 и 12. В клетку В2 занесено 

выражение: ЕСЛИ(AND(А2>1,А2<10),1,0). В клетку В3 занесено выраже-

ние: ЕСЛИ(OR(А3<=1,А3>8),0,1). Чему равно значение клетки D3? Объяс-

нить. 

12. Известна цена холодильника в 2006 году и ежегодное увеличение цены в % 

к предыдущему году. Рассчитать прогнозную цену до 2010 года и среднюю 

цену. 
Ежегодное увеличение цена 3,5% 
Года Цена холодильника марки 12.2435.12 
2006 10230 р. 
2007  
2008  
2009  
2010  
Средняя цена  

БИЛЕТ № 8 

1. Информационная культура – это … 

2. Информация – это … Единицы измерения информации. 

3. Внешние устройства ПК. Сканер – это … Предназначен для … 

4. Разрядность процессора определяется  … Она может быть равна … 

5. Графические редакторы. 
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6. Программа-оболочка – это … Norton-подобные оболочки.  

7. Задайте маску файлам: а) созданным в программе Word, б) графическим 

файлам, имеющим в имени 5 символов, первый - T.  

8. Сервер – это … Виды серверов. 

9. Программы-броузеры - это ….. Известные программы-броузеры …..  

10. В Excel в ячейке С3 записана формула: =$A2 - C$2. Переместите формулу в 

ячейки D3, E4. 

11. В ЭТ в клетку В4 занесено выражение: ЕСЛИ(AND(NOT(А4<2),А4<5),1,0). 

При каких значениях содержимого клетки А4 значение клетки В4 равно 1? 

Объяснить. 

12.  В представленной таблице рассчитать процент работ на «отлично». В поле 

«Вывод» определить «выше среднего» или «ниже среднего» количество от-

личников в группах. 
 Итоги контрольного среза   
Группа Всего сдавало Сдали на «отлично» % работ на «отлично» Вывод 

242 31    
243 24    
244 23    
245 34    
246 27    

Среднее     

БИЛЕТ № 9 

1. Информатика – это … Главная функция информатики. 

2. Понятия «сигнал» и «данные». 

3. Внешние устройства ПК. Манипуляторы. 

4. Производительность компьютера определяется  … Она может быть равна … 

5. Архивный файл – это … Архивация, разархивация. 

6. Окно – это… Элементы окна.  

7. Задайте маску файлам: а) графическим файлам; б) системным файлам, в 

имени которых третий символ R. 

8. К методам защиты информации в сети относятся ….  

9. В вычислительных сетях используются следующие типы передающий среды. 
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10. В Excel в ячейке С2 записана формула: =$A2 - C$2. Переместите формулу в 

ячейки E3, F5. 

11. В ЭТ в клетку В1 занесено выражение:  

ЕСЛИ(А1<10,2,ЕСЛИ(А1<15,3,ЕСЛИ(А1<20,4,5))) 

При каких значениях содержимого клетки значение клетки В1 равно 4? 

Объяснить. 

12. Дана база данных сотрудников. Найти средний доход сотрудников. В стол-

бец «Вывод» для каждого сотрудника вывести с помощью функции ЕСЛИ 

фразу «выше» или «ниже» его доход по сравнению с прожиточным мини-

мумом. 

Средний доход 
Прожиточный минимум 4200 р.   

ФИО Доход 
Количество человек 

на содержании 
Вывод 

Иванов О.П. 8000 р. 3  
Арбузова П.Г. 18060 р. 4  
Зайцева К.В. 14600 р. 4  
Бубнов П.У. 15310 р. 2  
Ясман В.Р 21420 р. 4  
Седова К.Л. 9400 р. 5  
Донцов П.П. 8500 р. 1  

СРЕДНЕЕ    

БИЛЕТ № 10 

1. Информационное общество – это … Оно характеризуется … 

2. Компьютеры по истории создания классифицируются: … 

3. Принтер – это … Виды принтеров. 

4. Тактовая частота процессора определяется  … Она может быть равна … 

5. Архивный файл – это … Цели сжатия файлов. 

6. BIOS служит для …. 

7. Задайте маску файлам: а) созданным в программе Word; б) файлам, имею-

щим в расширении последнюю букву t. 

8. База данных – это …..  Реляционная модель данных.  
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9. Метод защиты информации электронная подпись позволяет …. Публичный 

ключ находится у ….  

10. В Excel в ячейке C3 записана формула: =A$1 - $B1. Переместите формулу в 

ячейки D3, C4. 

11. В ЭТ в клетку В4 занесено выражение: ЕСЛИ(NOT(OR(А4<2,А4>=5)),0,1). 

При каких значениях содержимого клетки А4 значение клетки В4 равно 1? 

Объяснить. 

12. В таблице представлены данные курса USD в декабре месяце. Рассчитать 

среднемесячное значение курса USD. По вычисленной разнице текущего и 

среднего курса вывести с помощью функции ЕСЛИ фразу «понижение кур-

са»  или «повышение курса». 

Курс валюты 
Дата Курс USD Разность Итог 

01 дек 06 $30,40   
02 дек 06 $30,20   
03 дек 06 $30,12   

…    
31 дек 06 $29,36   
СРЕДНЕЕ    
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5. Карта обеспеченности дисциплины кадрами профессорско-

преподавательского состава. 

Наименование дис-
циплин в соответст-
вии с учебным пла-

ном 
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